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前　言

LS-DYNA是全球著名的结构非线性动力计算程序，以显式算法为主也兼有隐式算法，被广泛用于模拟工程领域的各种高度复杂的非线性瞬态结构受力过程。本书以LS-DYNA的关键字为主线，详细介绍了LS-DYNA的理论基础，基于ANSYS传统环境界面以及ANSYS Workbench的前处理方法、求解以及重启动方法，基于LS-PREPOST的前后处理方法等内容，结合一系列典型计算实例介绍了LS-DYNA计算软件在复杂结构模态分析、流固耦合动力分析、结构动态接触与冲击分析、侵彻分析、机构运动及多体动力学分析等方面的具体应用，便于读者对照自学。

本书各章的具体内容安排如下：

第1章　对LS-DYNA计算程序进行了总体介绍，包括LS-DYNA的发展历程和技术特色、LS-DYNA的主要计算能力及工程应用领域以及LS-DYNA的理论基础知识三部分内容。第2章介绍LS-DYNA计算程序的使用入门知识，首先介绍以关键字为核心的LS-DYNA计算程序的运行要素及计算过程，随后以一个简单动力学问题为例阐释了LS-DYNA程序的计算实现过程。第3章详细介绍了LS-DYNA关键字文件的语法、组织结构及常用关键字的使用，涉及节点、单元、部件、材料、状态方程、算法与特性、接触、约束方程与连接、初始条件、边界条件、荷载、求解以及输出设置等具体的关键字。第4章介绍基于ANSYS Mechanical APDL的LS-DYNA前处理方法，内容包括Mechanical APDL界面中的LS-DYNA前处理概述、建立LS-DYNA分析模型、定解条件分析选项的设置与关键字的导出。第5章介绍在ANSYS Workbench环境下LS-DYNA结构分析前处理方法，以Explicit Dynamics（LS-DYNAExport）系统的使用为主线，介绍了Workbench中的相关组件Engineering Data、DM以及Mechanical的具体使用方法和操作要点。第6章介绍基于ANSYSLS-DYNA环境的一般求解以及三类重启动分析的具体操作方法。第7章介绍LS-PREPOST前后处理器的使用方法，包括功能及界面、后处理操作、前处理操作三部分内容。第8章介绍LS-DYNA求解器的隐式分析技术，重点介绍了结构模态分析的实现方法，并结合一个球面网壳结构模态计算例题进行讲解。第9章介绍LS-DYNA的ALE算法以及流固耦合技术，内容包括ALE及流固耦合技术简介、基于ALE的液面晃动分析实例以及钢板落水过程流固耦合分析实例。第10章结合实例介绍LS-DYNA的动态接触及冲击分析方法，包括刚性物块撞击柔性板以及钢管的冲击屈曲分析等计算实例。第11章以一个子弹击穿双层钢板的动力问题分析为例介绍LS-DYNA侵彻分析及重启动分析的实现方法。第12章以一个凸轮机构的动力学分析为例介绍了LS-DYNA的多体动力学分析实现过程。附录部分介绍了LS-DYNA计算单位系统的协调问题、LS-DYNA材料模型关键字、ANSYS前处理器支持的材料模型、ANSYS显式分析命令与LS-DYNA关键字的对应关系、ANSYSLS-DYNA的单元特性等内容。

本书适合于工科相关专业研究生及高年级本科生在学习数值分析、非线性有限元方法等内容时作为参考书使用，也可供相关专业的技术人员学习LS-DYNA动力分析技术时参考阅读。
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第1章　LS-DYNA计算软件概述

LS-DYNA是著名的非线性动力学结构数值计算程序，本章对LS-DYNA计算程序进行了总体介绍，包括LS-DYNA的发展历程和技术特色、LS-DYNA的主要计算能力及工程应用领域以及LS-DYNA的理论基础知识等三部分内容。


1.1　LS-DYNA的发展历程和技术特色

LS-DYNA软件是目前国际上最著名的通用非线性有限元分析软件，可以用于模拟真实世界中的各种复杂问题。LS-DYNA的算法以显式方法为主，代表了现阶段非线性显式算法领域工程研究和应用的最高成就。LS-DYNA分析程序的前身为美国Lawrence Livermore国家实验室J.O.Hallquist博士于1976年主持开发完成的DYNA程序系列，DYNA程序时域积分采用显式的中心差分格式，用于分析爆炸与高速冲击等过程中的大变形动力响应问题，当时开发DYNA程序的主要目的是为武器设计提供分析工具。1986年，部分DYNA源程序在Public Domain（北约局域网）发布，在研究和教育机构中广泛传播，因此DYNA被公认为是显式有限元程序的先导，成为目前所有显式求解程序的基础代码。

Hallquist博士后来创建了LSTC公司（Livermore Software Technology Corporation），推出LS-DYNA系列软件，并陆续发布软件的930版本、940版本、950版本、960版本、970版本。LS-DYNA软件的发展策略也被逐步确定为以显式为主，隐式为辅，通过一个求解核心解决Implicit（隐式）与Explicit（显式）问题。LSTC公司通过不断的研发逐步规范和完善LS-DYNA程序的功能，逐步增加汽车安全性分析、金属板冲压成形分析、流固耦合分析（ALE算法和Eluer算法）、边界元方法及SPH方法、新材料模型、新接触算法、隐式分析等功能，使得LS-DYNA程序系列的应用范围不断得到扩大，并建立起完备的软件质量保证体系。目前LS-DYNA程序的最新版本为971V8版本。

前后处理方面，LS-DYNA在早期PC版本的前处理采用ETA公司的FEMB，同时开发了后处理程序LS-POST。后来LSTC在LS-POST后处理器的基础上发布了LS-PREPOST1.0版，使得该程序具备了一定的前处理功能。目前LS-PREPOST的最新版本为4.0版本。

在LS-DYNA发展历程中，与ANSYS公司的合作是具有里程碑意义的事件之一。1996年，Hallquist教授创建的LSTC公司和ANSYS公司开始进行技术和市场方面的合作，共同推出了ANSYSLS-DYNA软件的第一个版本，当时ANSYS前后处理程序版本为5.5。ANSYSLS-DYNA结合了ANSYS界面的前后处理功能、统一的数据库与LS-DYNA求解器的强大的非线性分析能力。对于熟悉ANSYS前后处理功能的软件用户来说，通过ANSYSLS-DYNA来求解各种高度非线性的瞬态问题无疑是最理想的选择。目前，ANSYS系列软件的最新版本已经发展到16.X，其前处理器支持最新的LS-DYNA971求解器的主要分析功能。

在结构分析领域，LS-DYNA计算程序最显著的技术特色在于处理高度非线性问题以及高速瞬态问题两方面。

所谓高度非线性的问题，是指分析的问题中包含有边界条件随时间的动态改变过程（如部件之间的动态接触和撞击）、大变形（如金属板的起皱变形）、非线性材料行为（如应变率相关塑性行为）等因素。

所谓高速瞬态问题，是指问题中包含持续时间很短的高速瞬态动力学过程，其中的惯性作用至关重要，典型的过程如：水雷或聚能装药的爆炸、各种冲击问题、金属成形过程等，LS-DYNA采用显式的中心差分时间积分算法来计算各时间步的系统动态响应。

此外，在最新版本的LS-DYNA中，LS-DYNA的求解范围不再仅限于结构分析，而是已经被拓展到包含不可压缩流体、可压缩流体以及电磁场的多物理场分析，而且支持共享内存以及分布式内存的并行计算，适用于Unix、Linux以及Windows等各种系统平台。


1.2　LS-DYNA的数值计算能力及应用领域


1.2.1　LS-DYNA的数值计算能力简介

LS-DYNA程序的计算能力十分强大，本节对计算功能、材料本构模型、单元类型、接触算法、硬件系统适应性等进行简要的介绍。

1.LS-DYNA的主要计算功能

在非线性结构分析方面，LS-DYNA是一个显式为主，隐式为辅的非线性结构分析程序。显式时间积分算法是LS-DYNA最主要的算法，包括2D及3D结构显式分析能力，可计算材料非线性、大变形、动态接触、裂纹扩展分析、失效分析等各种复杂的非线性动力学问题及瞬态结构-热耦合问题。此外，LS-DYNA还提供ALE算法（任意Lagrangian-Eulerian）、自适应网格重划分算法、SPH（Smoothed Particle Hydrodynamics）及EFG（Element Free Galerkin）算法，这些算法能够较好地处理各类高度非线性和大变形的问题。LS-DYNA的隐式分析可作为显式分析能力的补充，主要包括模态分析、隐式结构分析、热传导分析等。

LS-DYNA目前可以交替使用隐式求解和显式求解，如：进行薄板冲压成型的回弹计算、结构动力分析之前施加预应力等。与传统的显式求解相比，隐式算法和显式算法的联合应用可明显提高计算效率，从而大大节省了时间和成本。

在多体动力学分析方面，LS-DYNA提供了刚体动力学及FEM-rigid多体动力学耦合分析，可以分析各种机构的运动学以及动力学问题。

在多物理场耦合分析方面，LS-DYNA之前所具有的Eulerian算法、ALE算法可用于流动问题以及流固耦合动力问题的计算。在最近的几个版本中，基于其解决多场耦合问题的目标，LS-DYNA又逐步增加了不可压缩流体动力学分析（Incompressible CFD）、电磁场分析（Electromagnetics）以及基于守恒元解元的可压缩流体及化学反应分析（CESE/Compressible CFDand Chemistry）等求解方法。这些新增算法极大地增强了LS-DYNA的多物理场分析能力，开辟了更为广阔的应用领域。

2.LS-DYNA的材料本构模型

在材料的本构模型方面，LS-DYNA求解器提供了一个非常全面的材料库，可用的材料模型包括：弹性、塑性、热弹塑性、黏弹性、超弹性、弹塑性流体、应变率相关、徐变、损伤、失效、刚体、复合材料、织物、蜂窝、泡沫、混凝土和土壤、高能炸药等200余种材料模型及一系列状态方程模型，这些模型可以很好地模拟各种实际材料的复杂力学行为。除了这些已有的本构模型外，LS-DYNA还提供了用户自定义材料子程序功能，可用于开发新的材料模型。

3.LS-DYNA的单元类型

在单元技术方面，LS-DYNA程序提供的单元类型包括Shell（Membrane）、Solid、Beam、Truss、Spring、Damper、Mass等，如图1-1所示。其中，Shell单元可以是三角形或四边形的壳或薄膜。Solid单元可以是4或10节点四面体、6节点棱柱体或8节点六面体，且包含20余种算法。厚壳（Thick Shell）单元是一种8节点的壳元，各节点仅有线位移，可用于Solid和Shell之间的过渡。Beam单元包括标准梁单元、桁架、离散单元、索单元、焊接单元等10多种算法。Spring（弹簧）和Damper（阻尼器）单元可以是轴向的或旋转的，统称离散单元，可定义包括锁定和分离在内的各种非线性行为。Mass单元可以是集中惯性或集中质量。




图1-1　LS-DYNA单元类型

除了图中这些单元外，还提供了SPH单元、加速度计、传感器、安全带、预紧器、牵开器、滑环单元等具有特殊分析用途的单元类型。

4.LS-DYNA的接触算法

在接触算法方面，LS-DYNA提供超过20种接触算法类型，包括：仅有滑动的流体/结构或气体/结构界面、绑定界面、滑移冲击摩擦界面、单面接触、离散节点冲击表面、节点与表面的绑定、Shell边与Shell表面的绑定、节点与表面焊接、绑定失效界面、单面滑移冲击摩擦接触、Shell自动接触、单表面与梁的任意方向接触、面面侵蚀接触、节点表面侵蚀接触、单面侵蚀接触、面面对称约束方法、节点表面约束方法、刚体之间接触、节点刚性体与刚体的接触、边边接触、压延筋接触。大部分接触类型支持界面间摩擦分析。

基于这些算法，LS-DYNA可以处理如下类型的接触问题：

（1）柔性体接触；

（2）柔性体与刚性体的接触；

（3）刚性体与刚性体的接触；

（4）边与边接触；

（5）侵蚀接触；

（6）绑定界面接触；

（7）压延筋接触。

5.LS-DYNA的硬件系统适应性

LS-DYNA软件具备良好的硬件系统适应性，可以在AMD、CRAY、HP、IBM、SGI、Intel以及SUN等不同硬件供应商提供的硬件平台以及Windows、Linux等操作系统下良好地运行。LS-DYNA支持的硬件和系统情况列于表1-1中。

表1-1　LS-DYNA支持的硬件平台和操作系统





1.2.2　LS-DYNA的应用领域简介

LS-DYNA计算程序因其强大的计算分析能力在众多工程领域都有应用，如：汽车工程、航空航天、土木建筑、国防军工、金属加工、生物工程等。下面对LS-DYNA计算程序的部分工程应用领域及与之相关的具体工程问题进行简单的介绍。

1.汽车工程领域

LS-DYNA软件提供了安全带、滑环、预紧器、卷收器、传感器、加速度计、安全气囊、混合Ⅲ型假人模型等一系列专用分析功能，加上其强大的动态接触分析能力和显式求解能力，因此LS-DYNA程序非常适合被应用于汽车工程设计及研发领域。汽车生产厂商及零部件供应商可以通过LS-DYNA程序的仿真技术对汽车及零部件的设计方案进行评估，以替代费用高昂的原型试验，显著降低研发费用，缩短研发周期。

在汽车工程领域，LS-DYNA程序应用的最重要的方面是可以准确地预测车辆在动态撞击过程中的力学响应以及对乘员的影响，即所谓的耐撞性及乘员安全性分析。

2.金属加工领域

金属加工成形分析是LS-DYNA的主要工程应用领域之一。LS-DYNA程序能够准确地预测成形过程中金属的应力和塑性变形并分析金属是否会失效。LS-DYNA支持网格的自适应重划分技术，如果必要的话，在计算过程中将会重划分以提高精度和节约计算时间。

在金属加工成形领域，LS-DYNA程序应用的具体工程问题主要包括金属冲压、液压成形、锻造、铸造、多阶段过程、金属切削等。

3.航空航天领域

LS-DYNA程序目前被广泛应用于航空航天领域，模拟诸如鸟撞、喷气发动机叶片包容、冲击过程、复合材料结构设计、异物损伤、火箭级间分离等问题。在一个特定的仿真分析中，可组合使用LS-DYNA的各种仿真分析功能以模拟复杂的物理现象或过程。NASA喷气推进实验室的火星探路者探测器着陆仿真模拟就是这样一个典型的模拟分析案例，此模拟分析了太空探测器利用气囊辅助登陆的复杂过程，在模拟中组合使用了LS-DYNA大量的仿真分析功能。

4.国防军工领域

LS-DYNA程序在国防军工领域应用广泛，被用于分析穿甲与防护、穿甲弹的设计、战斗部设计、爆炸冲击波的传播、在空气或水中的爆炸、侵彻模拟等问题。此外，在反恐破坏模拟方面也有应用。

5.电子产品领域

LS-DYNA程序在电子产品领域应用广泛，主要用于各种电子元件性能的辅助分析及模拟产品跌落的仿真测试等问题。基于LS-DYNA，可模拟各种角度的及带包装的产品跌落过程，通常情况下需要按触地情况进行所谓“一点、三棱、六面”的跌落分析。

6.民用工程领域

在民用工程领域中，LS-DYNA应用于桥梁结构抗震分析、建筑结构的抗撞击与抗倒塌分析、工程爆破、结构非线性屈曲分析、支护结构防撞设计、爆炸冲击波破坏玻璃幕墙、岩土工程动力分析等问题。

7.石油工程领域

LS-DYNA在石油工程领域的应用涉及储油罐体的液晃问题分析、钻孔模拟、输油管道设计、爆炸模拟、海洋平台在复杂工作环境下的结构分析等方面。

8.其他应用领域

从目前公开发表的文献资料可知，LS-DYNA工程应用还涉及如下的一系列领域：

（1）机械工程的机构分析与多体动力分析；

（2）装运集装箱设计；

（3）玻璃成形过程分析；

（4）塑料、模具及吹塑成形分析；

（5）爆炸切割等工艺模拟；

（6）各类失效分析（如：焊点失效）；

（7）体育器材（如：高尔夫球杆击球、棒球杆击球、头盔撞击等）；

（8）生物力学（如：心脏瓣膜）；

（9）流体分析与流固耦合分析；

（10）核工业领域。

综上所述，LS-DYNA的应用涉及十分众多的行业及领域。此外，由于LS-DYNA具备高度的灵活性和广泛的适用性，其潜在的应用领域也十分广泛，通过定制开发可以很好地适用于不同的工程领域。


1.3　LS-DYNA的理论基础知识

本节对LS-DYNA算法相关的理论基础知识进行简单的介绍。


1.3.1　LS-DYNA显式时间积分算法

根据动力学问题的有限元方法，离散化的结构动力方程为：




式中，M为结构质量矩阵（在LS-DYNA中采用集中质量矩阵）；C为阻尼矩阵 
 （t）和 
 （t）分别为节点的加速度向量和节点的速度向量；P（t）、F（t）、H（t）分别为荷载向量、内力向量和沙漏阻力向量。沙漏阻力向量的施加方法见下节，内力向量和荷载向量由以下两式计算：




式中，f为体力向量 
 为表面力向量；∂b 2e
 为应力边界条件。

以上各式中的下标e表示各单元相应的量按总体自由度编号进行叠加，不应理解为简单的求和。

对于上述离散化的动力方程，LS-DYNA采用显式的中心差分方法求解，其基本递推格式如下：




式中，t n-1/2
 =（t n
 +t n-1
 ）/2， tn+1/2
 =（t n+1
 +t n
 ）/2，Δt n-1
 =t n
 -t n-1
 ，Δt n
 =t n+1
 -t n
 ； 
 ·（t n
 ） 
 （t n+1/2
 ）和x（t n+1
 ）依次为t n
 时刻的节点加速度向量，t tn+1/2
 刻的节点速度向量，t n+1
 时刻的节点位置坐标向量，其余参数的意义可类推。

采用集中质量矩阵的动力方程组是解耦的，按照中心差分方法计算时无需计算总体矩阵，也无需进行平衡迭代，通过前面时间步的响应结果，可得到后面时间步的响应，因此这种方法是一种显式的方法。显式方法尽管无需迭代，但是这种算法却不是无条件稳定的，为保证数值稳定性，LS-DYNA3D采用变步长积分法，每一时刻的积分步长由当前时刻的稳定性条件控制，积分步长必须小于某个临界值。一般情况下，积分步长取决于网格中最小单元的尺寸。

各种单元类型的临界积分步长可以表述为如下的统一形式，即：




式中，Δt e
 表示单元e的临界时间步长；α为时间步因子，缺省为0.9；l e
 为单元e的特征尺寸；c是纵波的波速。不同单元类型的单元特征尺寸和纵波波速计算公式列于表1-2中。

表1-2　不同类型单元的特征尺度与纵波波速





1.3.2　沙漏及其控制

由于LS-DYNA在单元计算中采用缩减积分，因此会引起所谓沙漏变形，本节介绍沙漏的概念及LS-DYNA的沙漏控制方法。

以3D的8节点SOLID单元为例，单元内任意点的坐标和速度可通过8个节点的坐标和速度按形函数插值得到，各节点在自然坐标系的形函数为：




其中，ξ，η，ζ为单元的自然坐标，各节点的自然坐标值列于表1-3中。

表1-38　节点SOLID单元的各节点自然坐标




单元内任一点的速度可由节点速度进行插值得到，即：




1将形函数代入上式，用向量形式表达为：










以上矢量分别代表不同的变形模式，∑反映单元的刚体平移，Λ 1
 反映单元的拉压变形，Λ 2
 、Λ 3
 反映单元的剪切变形，Γ 1
 、Γ 2
 、Γ 3
 和Γ 4
 为沙漏基矢量（Hourglass Base Vectors）。计算内力向量所需的应力增量 
 由应变率 
 按本构关系计算，而应变率可由单元的速度场对坐标的导数表示，又由于单元速度场是由节点速度按形函数插值得到，因此需计算形函数关于坐标的导数。由于采用单点缩减积分，因此只需计算单元中心处的导数值：




式中，Λ 1k
 ，Λ 2k
 ，Λ 3k
 为向量Λ 1
 ，Λ 2
 ，Λ 3
 的第k个分量。

由上面的导数表达式可以看出，在采用单点高斯积分时，沙漏模态不能够发挥作用，相应的变形能被丢失，因此沙漏模态又被称为零能模态。在动力响应计算中，沙漏模态将不受控制，导致出现计算结果的数值震荡。因此，必须对沙漏变形进行控制。

LS-DYNA3D采用增加沙漏黏性阻力的办法来解决沙漏问题，提供Standard（缺省算法）、Flanagan-Belytschko等黏性阻尼算法。以Standard算法为例，沙漏阻力的计算方法如下。

在各个节点沿x i
 轴方向引入的沙漏阻尼力：




式中，Γ jk
 为沙漏基矢量的分量；h ij
 按下式计算：




系数a k
 由按下式计算：




式中，Q hg
 为用户指定的常数（一般取0.05～0.15）；C为材料的声速（压缩波速度）；ρ为质量密度。


1.3.3　动态接触算法

LS-DYNA采用基于主、从表面的动态接触算法。接触分析中可能发生接触的两个表面被称为主表面和从表面。在主表面上，对于壳单元，由3或4个节点组成一个段，对于体单元由一个面上的3个或4个节点组成一个段，如图1-2和图1-3所示。




图1-2　壳单元的段




图1-3　体单元表面的段

LS-DYNA3D程序的缺省接触算法是对称罚函数法，程序在每一时步分别对从节点和主节点进行穿透检查。以从节点为例，如果当前时间步发生了穿透，则在从节点上施加法向接触力，按下式计算：




式中，Δ i
 为穿透量；k i
 为接触刚度因子，按下式计算：




其中，K i
 、V i
 和A i
 分别是主段S i
 所在单元的体积模量、体积和主段的面积；f是接触刚度罚因子，缺省值为0.10，取f过大可能造成不稳定。

在从节点上施加法向接触力f s
 后，根据作用反作用原理，在主段的接触点上作用一个反方向的力f s
 ，将这个反作用力按形函数等效分配到主段包含的各个主节点上即可。

对于有摩擦的情况，从节点施加法向接触力f s
 后，其最大摩擦力为 
 ，μ为摩擦系数。根据反作用力原理，计算分配到对应主段上各个主节点的摩擦力。

若静摩擦系数为μ s
 、动摩擦系数为μ d
 ，则用指数插值函数来使二者平滑过渡：




式中，V为接触表面之间的相对速度；DC是衰减系数。


第2章　LS-DYNA程序的基本使用入门

本章介绍LS-DYNA计算程序的使用入门知识，首先介绍以关键字为核心的LS-DYNA计算程序的运行要素及计算过程，随后以一个简单动力学问题为例阐释了LS-DYNA程序的计算实现过程。


2.1　LS-DYNA计算程序运行要素及过程

运行LS-DYNA求解器所需的要素包括可执行文件（求解器）、命令、输入文件以及足够的磁盘空间。

LS-DYNA求解器程序仅包含一个单一的可执行程序文件，可执行程序的运行通过系统命令来驱动。LS-DYNA的输入文件是简单的ASCII格式，称为LS-DYNA关键字文件，可以通过各种文本编辑器准备。关键字文件也可以通过图形前处理程序进行前处理操作后导出，很多第三方软件产品可用于形成LS-DYNA输入文件，如：ANSYS、Hyper Mesh、ICEM、FEMB等。LSTC也开发了自己的前后处理器，即LS-PrePost。

执行LS-DYNA求解程序时，可按如下操作步骤进行：

（1）首先创建一个计算目录，要保证此目录所在分区有足够的磁盘空间。

（2）将前处理准备好的关键字文件和LS-DYNA求解器程序（求解器程序的文件名称假定为LS-DYNA.exe）复制到计算目录中。

（3）在Windows系统中启动开始菜单的命令提示符。

（4）切换至LS-DYNA求解器程序所在路径。

（5）在提示符为计算目录下，输入执行LS-DYNA求解程序的操作命令，其格式如下：

LS-DYNAI=infO=otfG=ptfD=dpfF=thfT=tpfA=rrdM=sifS=iffZ=isf1

L=isf2B=rlfW=rootE=eflX=sclC=cpuK=killV=vdaY=c3dBEM=bof

{KEYWORD}{THERMAL}{COUPLE}{INIT}{CASE}{PGPKEY}

MEMORY=nwds NCPU=ncpu PARA=para ENDTIME=time

NCYCLE=ncycle JOBID=jobidD3PROP=d3prop GMINP=gminp

GMOUT=gmout MCHECK=y

在此命令中，LS-DYNA为求解程序的可执行文件名称，其后附加的各种计算参数列于表2-1中。

表2-1　LS-DYNA求解命令的参数解释




续上表




为了避免导致结果的混淆，每次应在不同的路径中运行LS-DYNA程序，或者通过在命令行中包含jobid参数来区别输出文件名称。如果是在同一路径下执行计算，旧的文件应当删除或重命名以便避免混淆，否则可能在二进制结果文件中同时包含了新旧两个计算结果。

在计算过程中，可以使用选择SW系列切换开关对求解过程的状态进行监控。通过在系统命令提示行键入Ctrl+C组合键即可暂时中断LS-DYNA的计算进程，提示用户输入切换开关码。LS-DYNA提供的SW控制选项列于表2-2中。

表2-2　LS-DYNA的SW控制选项




对于重启动分析，执行LS-DYNA计算程序的命令行如下：

LS-DYNAI=infO=otfG=ptfD=dpfR=rtfF=thfT=tpfA=rrdS=iffZ=isf1L=isf2

B=rlfW=rootE=eflX=sclC=cpuK=killQ=optionKEYWORDMEMORY=nwds

其中，rtf参数为LS-DYNA写的重启动文件，文件名缺省为前一次计算时dpf参数所指定的重启动文件d3dump。

重启动文件d3dump是二进制文件，d3dump文件可以有多个，比如：d3dump01、d3dump02等。一般来说，每一个dump文件都相应于一个不同的分析时间步，包含了LS-DYNA由此时间步继续进行分析所需的全部模型数据信息。


2.2　LS-DYNA运行简单实例

本节以一个简单的结构动力学分析实例，介绍LS-DYNA的一般计算过程。

1.问题描述

悬臂矩形截面梁，截面尺寸为0.15m×0.2m，梁长度为2.5m。梁的密度为2500kg/m 3
 ，弹性模量为3.0×10 10
 Pa，泊松比0.2。梁的自由端作用沿着梁高度方向的集中荷载，其数值为10kN，荷载-时间历程为time=0s时刻突然施加，之后保持幅值不变。计算梁的动力响应。

2.关键字文件

为了计算此问题，需要准备LS-DYNA的关键字文件。关键字文件的格式将在下一章详细介绍。

（1）计算模型

悬臂梁沿着轴向方向分为5个梁单元，节点1为固定端节点，节点6为加载的自由端节点。在梁的上方建立100号节点，5个单元在定义时均使用100号节点作为定位节点。

（2）加载

自由端的荷载通过载荷-时间曲线方式定义。

（3）计算设置

计算结束时间取1.0s，计算结果的输出间隔取0.25ms。

此问题的关键字文件beam.k如下。







3.提交LS-DYNA求解并查看结果

将LS-DYNA求解程序（假设为LS-DYNA.exe）和关键字文件beam.k复制到一个目录下，在命令提示行窗口输入：

LS-DYNAI=beam.k↙

程序即开始求解，求解完成后，用LS-PREPOST程序打开计算形成的d3plot文件，通过History功能，选择绘制节点6（自由端）的Y向位移的时间历程曲线，如图2-1所示。




图2-1　梁端Y向位移的时间历程曲线

根据结构动力学，自由端的最大振幅理论解按下式计算：




式中，K d
 为动力放大系数，对于突加荷载K d
 =2；P=-10×10 3
 N；L=2.5m；E=3.0×10 10
 Pa；I= 
 ；代入上式得到最大振幅理论值为34.7mm，与LS-DYNA计算得到的结果是一致的。


第3章　LS-DYNA关键字文件

关键字文件是LS-DYNA求解信息的标准输入格式，LS-DYNA求解的模型信息和分析选项必须通过关键字形式来描述并提交给求解器，因此掌握关键字是正确使用LS-DYNA程序的前提和基础。本章将详细介绍LS-DYNA关键字文件的语法、组织结构及常用关键字。


3.1　LS-DYNA关键字文件的组织结构及基本语法

LS-DYNA为其关键字的输入提供了一个灵活的、有条理的数据组织结构，很容易理解。在LS-DYNA的关键字文件中，通过*ELEMENT关键字系列来定义单元的基本信息，可以是实体单元、梁单元、壳单元、弹簧单元、阻尼器单元、质量单元、安全带单元等，单元关键字会引用到单元所在PART的ID号（通过*PART关键字来定义），在PART的定义中又会引用到*SECTION关键字所定义的单元算法截面信息以及*MAT和*EOS关键字所定义的材料特性及状态方程的。主要关键字之间的变量引用关系如图所示。




图3-1　LS-DYNA关键字的组织结构

在关键字文件中，类似的项目通常组合在同一个关键字中形成数据块。LS-DYNA的关键字都包含若干个数据块，一个数据块以一个关键字开始，后面是与此关键字相关的数据行。下一个相邻的关键字作为上一个数据块的结束，同时也是一个新的数据块的开始。每一个关键字都以星号“*”开始，关键字不区分大小写，但是星号“*”必须位于每一个关键字的第一列并左对齐。第一列为“$”表示这一行为注释行，读入时此行将被自动忽略。

*KEYWORD关键字通常是关键字文件中的第一个关键字。*END关键字则是作为关键字文件的结束，如果没有此关键字时LS-DYNA读入关键字信息到文件结束位置。

LS-DYNA其他关键字的输入与次序无关。关键字数据输入格式可以是自由格式，也可以是固定格式。当采用固定格式输入时，一般是一行8个变量域，每个域占据10个字符位置。采用自由格式输入时，数据之间则用逗号间隔，比如如下的关键字。




输入关键字数据可混合采用固定格式以及自由格式，手工编辑时推荐采用自由格式。采用自由格式时，要注意不超出变量取值的限制范围，比如整型8位变量I8的最大取值为99999999，不能超出此范围。

常用的LS-DYNA关键字及类型列于表3-1中。

表3-1　常用关键字的类型及作用




续上表





3.2　节点及单元关键字

本节介绍描述模型几何信息的节点关键字以及单元关键字。


3.2.1　节点关键字

关键字*NODE用于指定LS-DYNA分析模型中的节点信息，本节介绍与节点关键字相关的选项、输入数据及其他注意事项。

1.节点关键字的一般形式及选项

节点关键字的基本格式如下：

*NODE_{OPTION}

{OPTION}为可选择选项，通常为<BLANK>，也可为MERGE。

MERGE选项通常应用于不相交部件的边界节点，并仅用于那些定义时使用了MERGE选项的节点。使用MERGE选项时，符合上述条件且有相同坐标的节点将被合并。合并过程中，可指定一个合并的坐标容差，这个容差通过关键字*NODE_MERGE_TOLERANCE指定。此外，通过关键字*NODE_MERGE_SET，可通过指定一个不相交部件上边界节点的集合，在此集合中坐标相同（或小于*NODE_MERGE_TOLERANCE指定坐标容差）的节点被合并，这种情况下，*NODE_MERGE关键字选项不再需要。

2.节点关键字的输入数据卡片及变量说明

一般情况下多使用不含MERGE选项的*NODE关键字，其输入数据卡片仅一行，包含的变量如下（逗号隔开，即按自由输入形式，本章后续关键字均采用此形式）：

NID，X，Y，Z，TC，RC

其中各变量的意义解释列于表3-2中。

表3-2　*NODE关键字的变量




表3-2中，平动自由度受约束标识变量TC的取值规则如下：

0：无线位移约束；

1：X方向线位移受到约束；

2：Y方向线位移受到约束；

3：Z方向线位移受到约束；

4：X方向、Y方向线位移受到约束；

5：Y方向、Z方向线位移受到约束；

6：Z方向、X方向线位移受到约束；

7：X方向、Y方向、Z方向线位移受到约束。

与TC相类似，转动自由度受约束标识变量RC的取值规则如下：

0：无转动约束；

1：绕X方向转动受到约束；

2：绕Y方向转动受到约束；

3：绕Z方向转动受到约束；

4：绕X方向、Y方向转动受到约束；

5：绕Y方向、Z方向转动受到约束；

6：绕Z方向、X方向转动受到约束；

7：绕X方向、Y方向、Z方向转动受到约束。

实际上，边界条件定义更常用的关键字是*BOUNDARY_SPC，或者是*CONSTRAINED关键字。

3.节点关键字的其他注意事项

对于那些在模型中不与任何单元相连接的节点，LS-DYNA将会为其分配一个很小的质量和转动惯性值。一般情况下，无质量的节点不会引起问题，但是在极个别情况下，当这些节点与结构相互作用时可能会引起稳定性问题。当存在无质量的节点时，程序会报警告信息。

另外，无质量的节点还在刚体分析中用于定义Joint，与之相关的关键字是*CONSTRAINED_EXTRA_NODES_OPTION和*CONSTRAINED_NODAL_RIGID_BODY。


3.2.2　单元关键字

LS-DYNA的单元类型包括BEAM、SOLID、SHELL、TSHELL、MASS、INERTIA、DISCRETE、SEATBELT、SPH等。*ELEMENT关键字用于定义LS-DYNA计算模型的单元信息。本节介绍各种单元定义关键字相关的选项、输入数据以及其他注意事项。

1.BEAM单元的关键字

（1）BEAM单元关键字的一般形式及选项

BEAM单元关键字的一般形式为：

*ELEMENT_BEAM_{OPTION}_{OPTION}

此关键字后面的两个的{OPTION}为可选项而并非必须。可用的OPTION包括<BLANK>、THICKNESS、SCALAR、SCALR、SECTION、PID、OFFSET、ORIENTATION、WARPAGE以及ELBOW（beta）。下面简单介绍这些选项的作用。

①THICKNESS、SECTION选项

定义梁单元的横截面数据有两种方法。缺省方法是通过*SECTION_BEAM关键字指定；也可以通过在*ELEMENT_BEAM后附加THICKNESS和SECTION选项并在关键字中指定相关数据（其中SECTION选项仅用于合力梁，即*SECTION_BEAM关键字的ELFORM=2的情况）。另外，后一种方法的指定可覆盖前一种方法的指定。

②SCALAR/SCALR选项

关键字附加SCALAR/SCALR选项时仅用于146号材料类型，对应的材料通过关键字*MAT_1DOF_GENERALIZED_SPRING所指定。

③PID选项

关键字附加PID选项仅用于类型9，即spotweld单元，对其他的梁单元类型将忽略此选项。

④ORIENTATION、OFFSET选项

关键字附加ORIENTATION和OFFSET选项用于指定梁的截面定位及偏移，不适用于discretebeam单元。

⑤WARPAGE选项

关键字附加WARPAGE选项用于指定标量节点。

⑥ELBOW选项

关键字附加ELBOW选项用于定义3节点二次插值的梁单元，通常在管道分析中使用，使用该选项后每个节点包含12个自由度（其中6个用于描述截面畸变），每个单元将有36个自由度。

（2）BEAM单元关键字的输入数据及变量说明

*ELEMENT_BEAM关键字及后续一行或多行数据卡片用于定义各种线状的单元，包括3D梁单元、桁架单元、2D轴对称壳单元以及2D平面应变梁单元。单元的具体类型及其算法由*PART关键字的partID以及*SECTION_BEAM关键字的section ID所指定。

*ELEMENT_BEAM关键字的输入数据卡片以及各卡片包含的变量如下。

①卡片1

卡片1为最基本的输入数据，位于*ELEMENT_BEAM关键字的下面第一行，其包含的参数如下：

EID，PID，N1，N2，N3，RT1，RR1，RT2，RR2，LOCAL

卡片1各个变量的意义列于表3-3中。

表3-3　*ELEMENT_BEAM关键字的卡片1参数意义




其中，标识变量RT1及RT2的取值和代表的具体意义如下：

0：没有线位移自由度被释放；

1：X方向线位移自由度被释放；

2：Y方向线位移自由度被释放；

3：Z方向线位移自由度被释放；

4：X和Y方向线位移自由度被释放；

5：Y和Z方向线位移自由度被释放；

6：Z和X方向线位移自由度被释放；

7：X、Y和Z方向线位移自由度被释放。

标识变量RR1及RR2的取值和代表的具体意义如下：

0：没有转动位移自由度被释放；

1：绕X方向转动位移自由度被释放；

2：绕Y方向转动位移自由度被释放；

3：绕Z方向转动位移自由度被释放；

4：绕X和Y方向转动位移自由度被释放；

5：绕Y和Z方向转动位移自由度被释放；

6：绕Z和X方向转动位移自由度被释放；

7：X、Y和Z方向转动位移自由度被释放。

上述RT及RR选项不适用于梁单元类型为9号（即spotweld）的情况。

变量LOCAL为坐标系选项，其取值及代表的意义如下：

1：表示总体坐标系统；

2：局部坐标系统（缺省）。

②Thickness卡片

如果*ELEMENT_BEAM关键字中包含了THICKNESS选项，还需要指定Thickness卡片，其包含的参数如下：

PARM1，PARM2，PARM3，PARM4，PARM5

Thickness卡片各个变量的意义列于表3-4中。

表3-4　Thickness卡片的基本参数




注：PARM5可改写*SECTION_BEAM关键字所输入的缺省值，PARM5=1为不打印，2为打印。

在上述的表格中，出现了梁的轴向r及截面的s方向及t方向，这与截面定位有关，如图3-2所示，定位节点N3位于s、r平面内。




图3-2　LS-DYNA三维梁单元的截面定位示意图

③Section卡片

如果*ELEMENT_BEAM关键字中包含了SECTION选项，还需要指定Section卡片，其包含的参数如下：

STYPE，D1，D2，D3，D4，D5，D6

其中，STYPE为合力梁的截面类型的字符型变量，其取值为SECTION_XX，XX可为01、02，……，22，代表22种截面类型，依次为I-Shape、Channel、L-Shape、T-Shape、Tubularbox、Z-Sape、Trapezoidal、Circular、Tubular、I-Shape2、Solidbox、Cross、H-Shape、T-Shape2、I-Shape3、Channel2、Channel3、T-Shape3、Box-Shape2、Hexagon、Hat-Shape、Hat-Shape2。

D1～D6为以上不同截面类型对应的截面几何参数，部分截面类型的参数意义如图3-7所示。

④Scalar卡片

如果*ELEMENT_BEAM关键字中包含了SCALAR选项或SCALR选项，还需要指定Scalar卡片。采用SCALAR选项时的输入参数如下：

VOL，INER，CID，DOFN1，DOFN2

采用SCALR选项时的输入参数如下：

VOL，INER，CID1，CID2，DOFNS

其中，VOL为单元的体积，INER为单元的质量惯性矩，CID为定位坐标系ID号（如CID=0，则为缺省的总体坐标系），DOFN1及DOFN2分别为节点1和节点2被激活的自由度（取值1～6，其中1，2，3代表x、y、z方向平动，4，5，6代表x、y、z方向转动）。

CID1，CID2为节点1及节点2的定位坐标系ID号。DOFNS为节点1及节点2活动自由度，是2位整数，可在11～66之间变化，比如DOFS=12，表示节点1有x方向平动自由度，节点1有y方向的平动自由度。

⑤Spot Weld Part卡片

如果*ELEMENT_BEAM关键字中包含了PID选项，还需要指定Spot Weld Part卡片，其包含的输入参数如下：

PID1，PID2

PID1及PID2为spotweld单元类型的可选PART编号。

⑥Offset卡片

如果*ELEMENT_BEAM关键字中包含了OFFSET选项，还需要指定Offset卡片，其包含的输入参数如下：

WX1，WY1，WZ1，WX2，WY2，WZ2

上述变量的含义列于表3-5中。

表3-5　Offset卡片参数的意义




在梁板单元或梁单元之间形成组合结构时，梁截面的偏置往往是在建模时必须考虑的因素。应用OFFSET选项时，上述偏置向量是在总体X、Y、Z坐标系中的分量。

⑦Orientation卡片

如果*ELEMENT_BEAM关键字中包含了ORIENTATION选项，还需要指定Orientation卡片，其包含的输入参数如下：

VX，VY，VZ

参数VX，VY，VZ的意义为节点N1的定位向量。这种情况下不需要定位节点N3。

⑧Warpage卡片

如果*ELEMENT_BEAM关键字中包含了WARPAGE选项，还需要指定Warpage卡片，其包含的输入参数如下：

SN1，SN2

参数SN1及SN2分别表示标量节点1及2。

⑨Elbow卡片

如果*ELEMENT_BEAM关键字中包含了ELBOW选项，还需要指定Elbow卡片，其包含的输入参数如下：

MN

参数MN为ELBOW单元的中间节点号。需要注意的是ELBOW单元定义需要4个节点，梁轴向方向3个节点及一个定位节点。

2.SHELL单元的关键字

（1）SHELL单元关键字的一般形式及选项

SHELL单元关键字的一般形式为：

*ELEMENT_SHELL_{OPTION}

此关键字后面的{OPTION}为可选而非必选项。可用选项包括<BLANK>、THICKNESS、BETA或MCID、OFFSET、DOF、COMPOSITE、COMPOSITE_LONG以及SHL4_TO_SHL8。在实际使用中还可采用多个选项叠加的形式，如：THICKNESS_OFFSET。下面简单介绍这些选项的作用。

①THICKNESS选项

此选项用于指定壳的厚度。

②BETA或MCID选项

此选项用于为各向异性材料指定材料角或局部坐标系ID号。

③OFFSET选项

此选项用于移动SHELL单元的参考面，使之相对于节点发生偏移。

④DOF选项

对使用额外自由度的壳单元算法使用此选项。

⑤COMPOSITE或COMPOSITE_LONG选项

COMPOSITE或COMPOSITE_LONG选项用于指定复合材料单元各层参数。

⑥SHL4_TO_SHL8选项

此选项通过增加中间节点方式将3节点三角形SHELL单元和4节点四边形SHELL单元转化为6节点三角形和8节点四边形的二次SHELL单元。新产生的中间节点号由最大节点号基础上向上偏移确定并写入关键字，*SECTION_SHELL中需要指定二次壳单元算法。

（2）SHELL单元关键字的输入数据及变量说明

*ELEMENT_SHELL关键字及后续一行或多行数据卡片用于定义3节点、4节点、6节点以及8节点的3D壳单元、膜单元及2D平面应力单元、平面应变单元及轴对称实体单元。单元的具体类型及其算法由*PART的partID以及*SECTION_SHELL的sectionID所指定。

*ELEMENT_SHELL关键字的输入数据卡片以及各卡片包含的变量如下。

①基本卡片

基本卡片（第1个卡片）为最基本的输入数据，位于*ELEMENT_SHELL关键字的下面第一行，其包含的变量如下：

EID，PID，N1，N2，N3，N4，N5，N6，N7，N8

卡片1各个变量的意义列于表3-6中，单元节点位置示意如图3-3所示。

表3-6　*ELEMENT_SHELL关键字的卡片1参数意义




卡片1中指定的逆时针方向节点次序决定了单元的TOP表面。




图3-3　单元节点位置示意图

②Thickness卡片

如果*ELEMENT_SHELL关键字中包含了THICKNESS选项，还需要指定Thickness卡片，其包含的参数如下：

THIC1，THIC2，THIC3，THIC4，BETA或MCID

Thickness卡片各个变量的意义列于表3-7中。

表3-7　*ELEMENT_SHELL关键字的卡片1参数意义




续上表




③Offset卡片

如果*ELEMENT_SHELL关键字中包含了OFFSET选项，还需要指定Offset卡片，其包含的参数如下：

OFFSET

此参数表示SHELL法线方向上由节点平面到参考面的偏移距离。OFFSET指定的参考面偏移在接触中不考虑，除非*CONTROL_SHELL的CNTCO参数被设置为1。

④Scalar Node卡片

如果*ELEMENT_SHELL关键字中包含了DOF选项，还需要指定Scalar卡片，其包含的参数如下：

，，NS1，NS2，NS3，NS4

其中，NSi为标量节点号，标量节点通过*NODE_SCALAR关键字指定，其NDOF参数设置为2，如厚度受到约束，NDOF设为0。

⑤COMPOSITE卡片

如果*ELEMENT_SHELL关键字中包含了COMPOSITE选项，还需要指定COMPOSITE卡片，其包含的参数如下：

MID1，THICK1，B1，，MID2，THICK2，B2

上述卡片中各参数的意义列于表3-8中。

表3-8　COMPOSITE卡片参数意义




⑥COMPOSITE_LONG卡片

如果*ELEMENT_SHELL关键字中包含了COMPOSITE_LONG选项，还需要指定COMPOSITE_LONG卡片，其包含的参数如下：

MID1，THICK1，B1，，PLYID1

其中，MID1，THICK1，B1意义同上，PLYIDi为第i个积分点的层ID（用于后处理）。

3.TSHELL单元关键字

（1）TSHELL单元关键字的一般形式及选项

TSHELL单元关键字的一般形式为：

*ELEMENT_TSHELL_{OPTION}

此关键字后面斜体的{OPTION}为可选的字段而并非必须选项。可用选项包括BETA、COMPOSITE。下面简单介绍这些选项的作用。

①BETA选项

对正交各向异性和各向异性材料，可定义局部材料角BETA，并与关键字*SECTION_TSHELL或*PART_COMPOSITE_TSHELL中的积分点角度累加。

②COMPOSITE选项

COMPOSITE选项用于定义各个积分点的材料、厚度及方向角。此选项允许任意数量的厚度方向积分点共享同一个PARTID号。

（2）TSHELL单元关键字的输入数据及变量说明

*ELEMENT_TSHELL关键字及后续一行或多行数据卡片用于定义一个8节点的厚壳单元，可以使用全积分或选择缩减积分规则。*ELEMENT_TSHELL关键字的输入数据卡片以及各卡片包含的变量如下。

①卡片1

卡片1为最基本的输入数据，位于*ELEMENT_SHELL关键字的下面第一行，其包含的变量如下：

EID，PID，N1，N2，N3，N4，N5，N6，N7，N8

其中，EID为单元的ID号，PART的ID号，Ni表示节点号，N1～N4用于定义单元下表面，N5～N8用于定义单元上表面，如图3-4所示。




图3-4　TSHELL单元节点位置示意图

②Beta卡片

当关键字中包含BETA选项时，需要定义Beta卡片，其包含的参数如下：

，，，，BETA

BETA为正交异性材料的基准偏移角度。

③Composite卡片

当关键字中包含COMPOSITE选项时需要此卡片，其包含的参数如下：

MID1，THICK1，B1，，MID2，THICK2，B2

MID3，THICK3，B3，，……

其中，MIDi为通过*MAT关键字指定的第i个积分点的材料ID号，THICKi为第i个积分点的厚度，Bi为第i个积分点的材料角。

4.SOLID单元关键字

（1）SOLID单元关键字一般形式及选项

BEAM单元关键字的一般形式为：

*ELEMENT_SOLID_{OPTION}

此关键字后面的{OPTION}为可选项而并非必选项，可用{OPTION}包括<BLANK>、20、ORTHO、DOF、TET4TOTET10、H8TOH20。下面简单介绍这些选项的作用。

①20选项

此选项用于指定高阶单元的其他节点。

②ORTHO选项

此选项用于指定各向异性材料的局部坐标系。

③DOF选项

此选项用于指定多余自由度。

④TET4TOTET10选项

此选项用于转换4节点四面体单元到10节点四面体单元。

⑤H8TOH20选项

此选项用于转换8节点六面体单元到20节点六面体单元。

（2）SOLID单元关键字的输入数据及变量说明

*ELEMENT_SOLID关键字及后续一行或多行数据卡片用于定义3节点、4节点、6节点以及8节点的3D壳单元、膜单元及2D平面应力单元、平面应变单元及轴对称实体单元。

①卡片1

卡片1位于*ELEMENT_SHELL关键字的下面第一行，其包含的变量如下：

EID，PID

其中，EID为单元的ID号，PID为单元所述PART的PartID号（*PART定义）。

②卡片2

卡片2位于*ELEMENT_SHELL关键字的下面第二行，其包含的变量如下：

N1，N2，N3，N4，N5，N6，N7，N8，N9，N10

③卡片3

卡片3位于*ELEMENT_SHELL关键字的下面第三行，其包含的变量如下：

N11，N12，N13，N14，N15，N16，N17，N18，N19，N20

卡片2及卡片3的各变量依次表示组成单元的各节点的ID号。对于四面体单元，节点N4在卡片2中重复5次，如图3-5所示。




图3-5　SOLID单元的节点编号

④Orthotropic卡片1

关键字中包含ORTHO选项时使用此卡片，包含数据参数如下：

A1或BETA，A2，A3

A1、A2、A3分别表示向量a的x、y及z分量。BETA为材料角度。

⑤Orthotropic卡片2

关键字包含ORTHO选项时所需的第2个卡片，其包含的输入参数如下：

D1，D2，D3

D1、D2、D3分别为向量d的x、y及z分量。关于向量a和向量d的定义，请参考关键字手册。

⑥Scalar Node卡片

关键字包含DOF选项时需要此卡片，其包含的参数如下：

，，NS1，NS2，NS3，NS4，NS5，NS6，NS7，NS8

NS1～NS8表示标量节点号。

5.DISCRETE单元关键字

DISCRETE单元包括弹簧、阻尼单元。

（1）DISCRETE单元关键字的一般形式及选项

DISCRETE单元关键字的一般形式为：

*ELEMENT_DISCRETE_{OPTION}

此关键字后面的{OPTION}为可选项而并非必须，可选项包括<BLANK>以及LCO，LCO选项用于使用载荷曲线以初始化偏移。

（2）DISCRETE单元关键字的输入数据及变量说明

*ELEMENT_DISCRETE关键字在两个节点或节点及地面之间定义无质量的离散弹簧阻尼单元。关键字的输入数据卡片以及各卡片包含的变量如下。

①卡片1

卡片1为最基本的输入数据，位于*ELEMENT_DISCRETE关键字的下面第一行，其包含的变量如下：

EID，PID，N1，N2，VID，S，PF，OFFSET

卡片1各个变量的意义列于表3-9中。

表3-9　卡片1参数及意义




在表3-9的变量中，VID为定位选项，其取值及代表的意义为：当VID=0时，弹簧/阻尼单元沿着节点N1到节点N2的轴线方向起作用；当VID≠0时，弹簧/阻尼单元沿着定位向量规定的轴线方向起作用，VID为关键字*DEFINE_SD_ORIENTATION中指定的向量ID。

初始偏移量OFFSET是Time=0时刻的位移或转动。比如，对于平移弹簧，一个正的offset在0时刻会引起拉力。如果在后面的卡片中指定了LCID，则忽略此变量的输入。

②Offset Load Curve卡片

如果在*ELEMENT_DISCRETE关键字中包含LCO选项，还需要指定Offset Load Curve卡片，其包含的变量如下：

LCID，LCIDDR

变量的意义如下：

LCID为载荷曲线ID号，用于将初始的OFFSET定义为一个关于时间的函数，正的偏移量对应拉力。LCIDDR为载荷曲线ID号，用于在动力松弛阶段将OFFSET定义为一个时间的函数。

6.MASS单元关键字

（1）MASS单元关键字的一般形式及选项

MASS单元关键字的一般形式为：

*ELEMENT_MASS_{OPTION}

此关键字后面的{OPTION}为可选项而并非必须，可选项包括<BLANK>及NODE_SET。NODE_SET选项用于定义均匀分布于节点集合上的质量。

（2）MASS单元关键字的输入数据及变量说明

*ELEMENT_MASS关键字用于在节点上定义集中质量单元，或在节点集合上定义均匀分布的质量。当使用NODE_SET选项时，质量被均匀分布到节点集合上。*ELEMENT_MASS关键字的输入数据卡片包含的变量如下：

EID，ID，MASS，PID

其中各参数的意义列于表3-10中。

表3-10　参数及意义




7.INERTIA单元关键字

（1）INERTIA单元关键字的一般形式及选项

INERTIA单元关键字的一般形式为：

*ELEMENT_INERTIA_{OPTION}

此关键字后面的{OPTION}为可选项而并非必须，可选项包括<BLANK>以及OFFSET。该关键字允许集中质量和惯性张量从节点处偏移。节点可以属于变形体或刚性体。

（2）INERTIA单元关键字的输入数据及变量说明

①基本数据卡片

*ELEMENT_INERTIA关键字的输入数据卡片有2个，其变量信息如下：

EID，NID，CSID

IXX，IXY，IXZ，IYY，IYZ，IZZ，MASS

上述卡片的各变量意义列于表3-11中。

表3-11　参数及意义




在表3-11的各变量中，如果定义了CSID，则IXY、IXZ及IYZ设为0。

②Offset卡片

如果在*ELEMENT_INERTIA关键字中包含了OFFSET选项，还需要指定Offset卡片，其包含的变量如下：

X-OFF，Y-OFF，Z-OFF

这些变量分别表示相对于节点的X、Y、Z方向的偏移量。

8.安全带单元及相关其他单元关键字

（1）安全带单元关键字及数据卡片

*ELEMENT_SEATBELT

这一关键字段用于定义一维的安全带单元，这一关键字段包含如下的变量信息：

EID，PID，N1，N2，SBRID，SLEN，N3，N4

各变量依次代表单元的ID编号，单元所在部件的ID编号，各节点的ID号，卷收器单元的ID号（此单元在卷收器内部时需指定），初始的松弛长度。

上述各个参数的意义列于表3-12中。

表3-12　参数及意义




续上表




表3-12中，N3和N4为可选的节点，当定义节点N3及N4后，单元成为SHELL形状的安全带单元。SHELL安全带的厚度通过关键字*SECTION_SHELL定义，而不是通过关键字*SECTION_SEATBELT。采用这种单元形式时，注意网格为矩形的规则网格。

（2）相关其他单元的关键字

与安全带的定义相关的单元还包括加速度计单元、预紧器单元、卷收器单元、传感器单元以及滑环单元，与之相关的关键字及主要参数的意义简单列举如下，全部卡片参数的详细介绍请参考LS-DYNA关键字手册。

①加速度计单元关键字

如下关键字（包含一个数据卡片）用于定义安全带加速度计：

*ELEMENT_SEATBELT_ACCELEROMETRE

SBACID，NID1，NID2，NID3，IGRAV，INTOPT，MASS

②预紧器单元关键字

如下关键字（包含两个数据卡片）用于定义安全带预紧器：

*ELEMENT_SEATBELT_PRETENSIONER

SBPRID，SBPRTY，SBSID1，SBSID2，SBSID3，SBSID4

SBRID，TIME，PTLCID，LMTFRC

③卷收器单元关键字

如下关键字（包含两个数据卡片）用于定义安全带卷收器：

*ELEMENT_SEATBELT_RETRACTOR

SBRID，SBRNID，SBID，SID1，SID2，SID3，SID4

TDEL，PULL，LLCID，ULCID，LFED

④传感器单元关键字

如下关键字（包含两个数据卡片）用于定义安全带传感器：

*ELEMENT_SEATBELT_SENSOR

SBSID，SBSTYP，SBSFL

上述卡片中的参数SBSTYP表示传感器的类型，依不同类型其数据卡片2的输入参数也有所不同。

当SBSTYP=1时，用于定义节点加速度传感器，卡片2的数据参数如下：

NID，DOF，ACC，ATIME

当SBSTYP=2时，用于定义卷收器拔出速率传感器，卡片2的数据参数如下：

SBRID，PULRAT，PULTIM

当SBSTYP=3时，用于定义时间传感器，卡片2的数据参数如下：

TIME

当SBSTYP=4时，用于定义节点间距离传感器，卡片2的数据参数如下：

NID1，NID2，DMX，DMN

⑤滑环单元关键字

以下的关键字（包含两个卡片，卡片2为可选）用于定义安全带滑环：

*ELEMENT_SEATBELT_SLIPRING

SBSRID，SBID1，SBID2，FC，SBRNID，LTIME，FCS，ONID

K，FUNCID，DIRECT，DC，，LCNFFD，LCNFFS

9.SPH单元

SPH单元通过关键字*ELEMENT_SPH定义，此关键字（包含一个输入数据卡片）的一般形式如下：

*ELEMENT_SPH

NID，PID，MASS

该关键字用于定义一个具有集中质量的SPH单元，数据卡片中各参数的意义为：NID表示节点和单元的ID号（对于SPH单元，节点和单元的ID号相同）；PID表示SPH单元所属PART的ID号；MASS用于指定SPH单元的质量，当MASS>0时表示SPH单元的质量数值，当MASS<0时其绝对值表示SPH单元体积，密度由部件的材料关键字定义，这种情况下SPH单元的质量为abs（MASS）×RHO，RHO为定义的材料密度。


3.3　部件、材料及单元选项关键字

本节介绍部件、材料以及单元选项相关的LS-DYNA关键字段，这些关键字都与上节定义单元的关键字有关。


3.3.1　定义部件的关键字

PART（部件）是LS-DYNA中的一个重要概念，本节介绍用于定义部件的关键字*PART及其数据卡片。

1.*PART关键字的一般形式及选项

（1）*PART关键字的一般形式

在LS-DYNA的关键字文件中，通过*PART关键字来定义部件及其相关特性，其基本形式如下：

*PART_{OPTION1}_{OPTION2}_{OPTION3}_{OPTION4}_{OPTION5}

（2）部件关键字的选项

在上述关键字中，{OPTION1}至{OPTION5}为可选项而非必须。{OPTION1}至{OPTION5}可以在*PART关键字中以任意顺序指定。

①{OPTION1}选项

对于{OPTION1}，可用的选项有<BLANK>、INERTIA以及REPOSITION。INERTIA选项允许惯性特性及初始条件直接定义而非基于有限元网格计算得到，此选项仅作用于刚体。REPOSITION选项用于变形部件的重新定位。

②{OPTION2}选项

对于{OPTION2}，可用的选项有<BLANK>和CONTACT。CONTACT选项允许结合自动接触类型使用基于part的接触参数，支持的接触类型号为a3、4、a5、b5、a10、13、a13、15及26，即如下的接触类型关键字：

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE，

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR，

*CONTACT_SINGLE_SURFACE，

*CONTACT_AUTOMATIC_NODES_TO_SURFACE，

*CONTACT_AUTOMATIC_BEAMS_TO_SURFACE，

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE，

*CONTACT_AUTOMATIC_SINGLE_SURFACE，

*CONTACT_AUTOMATIC_SINGLE_SURFACE_MORTAR，

*CONTACT_AIRBAG_SINGLE_SURFACE，

*CONTACT_ERODING_SINGLE_SURFACE，

*CONTACT_AUTOMATIC_GENERAL

③{OPTION3}选项

对于{OPTION3}，可用的选项有<BLANK>和PRINT。PRINT选项作用于刚体，允许用户控制输出数据是否写入ASCII文件MATSUM和RBDOUT。

④{OPTION4}选项

对于{OPTION4}，可用的选项有<BLANK>和ATTACHMENT_NODES。

⑤{OPTION5}选项

对于{OPTION5}，可用的选项有<BLANK>和AVERAGED。AVERAGED选项仅用于包含线状truss单元的部件，这些单元的平均应变和应变率将被计算，平均轴向力将被施加于部件中的所有单元上。

2.关键字*PART的输入数据卡片及其变量

（1）基本卡片

*PART关键字的输入数据的基本卡片有两个，其包含的变量如下：

HEADING

PID，SECID，MID，EOSID，HGID，GRAV，ADPOPT，TMID

基本卡片1各个变量的意义列于表3-13中。

表3-13　*ELEMENT_BEAM关键字的卡片1参数意义




续上表




（2）Inertia卡片

当*PART关键字中包含INERTIA选项时，需要定义Inertia卡片（共3个），其参数列表如下：

XC，YC，ZC，TM，IRCS，NODEID

IXX，IXY，IXZ，IYY，IYZ，IZZ

VTX，VTY，VTZ，VRX，VRY，VRZ

当INERTIA卡片1的IRCS参数取1时，还需定义Inertial Coordinate System卡片，用来定义两个局部向量或一个局部坐标系ID，此卡片包含参数如下：

XL，YL，ZL，XLIP，YLIP，ZLIP，CID

（3）Reposition卡片

当*PART关键字中包含REPOSITION选项时，还需定义Reposition卡片，此卡片包含参数如下：

CMSN，MDEP，MOVOPT

（4）Contact卡片

当*PART关键字中包含CONTACT选项时，需要定义Contact卡片，其包含的参数列表如下：

FS，FD，DC，VC，OPTT，SFT，SSF，CPARM8

（5）Print卡片

当*PART关键字中包含PRINT选项时，需要定义Print卡片，其包含的参数如下：

PRBF

（6）Attachment Nodes卡片

当*PART关键字中包含ATTACHMENT_NODES选项时，需要定义Attachment Nodes卡片，其包含的参数如下：

ANSID

除*PART关键字的基本卡片外，后面几个卡片中各参数的具体意义请参考LS-DYNA关键字手册，本节不再展开介绍。


3.3.2　定义材料数据的关键字

LS-DYNA求解器提供的材料模型十分丰富，大约有300种左右，这些材料模型用于模拟各种复杂的材料力学行为。在LS-DYNA关键字中，*MAT关键字用于定义材料模型及参数；*EOS关键字用于定义材料的热力学状态方程及参数，通常用于计算材料模型的压力。

在LS-DYNA的关键字文件中，*MAT关键字一般有两种不同的形式：一种是以材料模型在LS-DYNA求解器材料库中的类型序号形式表示的关键字，另一种则是文字描述形式的关键字。比如：最常用的线弹性材料模型，其在材料库中的序号为1，因此可采用关键字*MAT_001或者*MAT_ELASTIC来定义。由于采用文字描述形式的材料关键字更容易读懂，因此本节介绍关键字时均采用文字描述形式。LS-DYNA提供的材料模型、对应的关键字（数字序号形式及文字描述形式）以及支持的单元类型详见附录B。此外，本书的附录C介绍了ANSYS前处理器支持的LS-DYNA的材料模型以及相对应的LS-DYNA关键字。

LS-DYNA通过*EOS关键字来定义计算压力所需的状态方程模型，常用的LS-DYNA状态方程包括线性多项式状态方程、高能炸药的状态方程以及GRUNEISEN状态方程等，分别通过关键字*EOS_LINEAR_POLYNOMIAL、*EOS_JWL以及*EOS_GRUNEISEN定义。

下面介绍部分较为常用的材料类型及其关键字。

1.弹性材料模型

（1）各向同性线弹性材料模型

各向同性线弹性材料是最简单的材料模型，这种材料模型的关键字及输入数据卡片的形式如下：

*MAT_ELASTIC

MID，RO，E，PR，DA，DB，K

如果此关键字中包含了FLUID选项，则输入数据增加卡片2（第2行），关键字及输入数据卡片的形式如下：

*MAT_ELASTIC_FLUID或MAT_001_FLUID

MID，RO，E，PR，DA，DB，K

VC，CP

上述数据卡片中各参数的意义列于表3-14中。

表3-14　*MAT_ELASTIC关键字的输入参数




（2）正交各向异性弹性模型

正交各向异性弹性材料模型的关键字及输入数据卡片的形式如下：

*MAT_ORTHOTROPIC_ELASTIC或MAT_002

MIDROEAEBECPRBAPRCAPRCB

GABGBCGCAAOPTGSIGF

XPYPZPA1A2A3MACFIHIS

V1V2V3D1D2D3BETAREF

上述数据卡片中各参数的意义列于表3-15中。

表3-15　*MAT_002关键字的输入参数




注：表中相关向量的定义可参考LS-DYNA关键字手册。

（3）完全各向异性弹性模型

完全各向异性弹性模型的关键字及输入数据卡片的形式如下：







上述数据卡片中Cij为材料的应力应变关系矩阵相关元素。由于此矩阵为对称矩阵，因此在关键字中仅输入上三角部分（包括主对角线上）的元素合计21个。上述卡片中，其余参数的意义与ORTHOTROPIC相同。

2.塑性材料模型

塑性是最为常见的材料非线性力学行为，LS-DYNA提供了丰富的塑性模型，这些模型可以考虑各种硬化行为、与温度相关行为及应变率效应等。部分塑性材料模型的关键字及其特点简介列于表3-16中。

表3-16　LS-DYNA一般塑性模型




下面，对表3-16中部分关键字的使用方法进行简要的介绍。

（1）塑性随动硬化材料模型

各向同性线弹性材料是最简单的材料模型，这种材料模型在LS-DYNA材料模型库中编号为1，关键字及输入数据卡片的形式如下：

*MAT_PLASTIC_KINEMATIC

MIDROEPRSIGYETANBETA

SRCSRPFSVP

上述数据卡片中各参数的意义列于表3-17中。

表3-17　塑性随动模型的参数




续上表




（2）Johnson-Cook塑性材料模型

Johnson-Cook塑性材料模型是一种非线性分析中常用的塑性模型，其关键字及输入数据卡片的形式如下：




上述卡片中包含的参数及其意义列于表3-18中。

表3-18　Johnson-Cook塑性材料参数




续上表




（3）与温度相关的弹塑性材料模型

与温度相关的弹塑性材料模型通过关键字*MAT_ELASTIC_PLASTIC_THERMAL定义，关键字及输入数据卡片的形式如下：




上述数据卡片中各参数的意义列于表3-19中。

表3-19　温度相关弹塑性材料的参数




在表3-19中，与温度相关的数据点最少2个，最多8个。材料温度超出以上输入数据定义的温度范围时分析将会被终止。如果仅希望定义热弹性材料，则不用指定SIGYi以及ETANi的数值。

3.黏弹性及超弹性橡胶材料模型

LS-DYNA提供了一系列黏弹性及超弹性材料模型，这些模型可用于模拟橡胶等材料。这里介绍几种常见的模型。

（1）黏弹性材料模型

LS-DYNA的黏弹性材料通过关键字*MAT_VISCOELASTIC定义，关键字及输入数据卡片的形式如下：

*MAT_VISCOELASTIC

MIDROBULKG0GIBETA

上述卡片中各参数的意义列于表3-20中。

表3-20　黏弹性材料模型参数




（2）BLATZ-KO模型

BLATZ-KO模型用于模拟几乎不可压缩连续橡胶材料，泊松比被固定为0.463。定义BLATZ-KO材料模型的关键字及输入卡片参数如下：

*MAT_BLATZ-KO_RUBBER

MIDROGREF

在上述材料卡片中，MID为材料的ID号；RO为质量密度；G为剪切模量；REF为使用参考几何初始化应力张量的标识开关，等于0.0为关闭，等于1.0为打开（参考几何提供关键字*INITIAL_FOAM_REFERENCE_GEOMETRY定义）。

（3）MOONEY-RIVLIN模型

MOONEY-RIVLIN模型是一种用于模拟橡胶材料的两参数模型，定义MOONEY-RIVLIN模型的关键字及输入卡片参数如下：

*MAT_MOONEY-RIVLIN_RUBBER

MIDROPRABREF

SGLSWSTLCID

上述卡片各参数的意义列于表3-21中。

表3-21　MOONEY-RIVLIN模型参数意义







图3-6　试件示意图

4.高能炸药材料

LS-DYNA提供了高能炸药材料用于爆炸分析，定义此材料的关键字及输入数据卡片如下：

*MAT_HIGH_EXPLOSIVE_BURN

MID，RO，D，PCJ，BETA，K，G，SIGY

上述卡片中各参数的意义列于表3-22中。

表3-22　高能炸药材料输入卡片参数




以上关键字通常与描述爆轰产物压力-体积关系的JWL状态方程联用，定义JWL状态方程的关键字及其输入卡片参数如下：

*EOS_JWL

EOSID，A，B，R1，R2，OMEG，E0，V0

上述参数中，EOSID为状态方程的ID编号；A，B，R1，R2，OMEG为JWL状态方程表达式中的参数A、B、R 1
 、R 2
 、ω；E0为初始能量密度；V0为初始相对体积。JWL状态方程的具体形式请参照LS-DYNA理论手册。

此外，下列关键字及输入卡片用于设置炸药起爆的位置以及起爆时刻：

*INITIAL_DETONATION

PID，X，Y，Z，LT

其中，各参数的意义为：PID是炸药单元的部件号；X、Y、Z依次为起爆点的X坐标、Y坐标及Z坐标；LT为起爆点的点火时间。

5.Null材料模型

LS-DYNA提供Null材料模型（空材料模型）结合状态方程来描述具有流体行为的材料（如：空气、水）。在空材料参数中提供模型的本构关系计算黏性应力，使用状态方程来计算压力。Null材料的关键字及输入卡片数据的形式如下：

*MAT_NULL

MIDROPCMUTERODCERODYMPR

上述卡片中各参数的意义列于表3-23中。

表3-23　*MAT_NULL关键字各参数的意义




Null材料模型可以结合多种状态方程使用，这里简单介绍两种状态方程，即：线性多项式状态方程及Gruneisen状态方程。

（1）多项式状态方程

多项式状态方程的压力表达式如下：




其中 
 ，当μ<0时 
 及 
 项设为0；线性多项式状态方程用于表示γ法则气体状态方程时，应按如下设置：




其中的γ为两种比热C p
 和C v
 之比。

定义多项式状态方程的关键字及输入数据卡片如下：

*EOS_LINEAR_POLYNOMIAL

EOSIDC0C1C2C3C4C5C6

E0V0

以上数据卡片中，EOSID表示状态方程的ID号；C0～C6为多项式状态方程的系数；E0为单位参考体积上的初始内能；V0为初始相对体积。

（2）Gruneisen状态方程

Gruneisen状态方程按下式定义压缩材料的压力：




对于膨胀材料，Gruneisen状态方程按下式定义压力：




在上述Gruneisen状态方程中，C是vs（vp）曲线的截距；S 1
 ，S 2
 和S 3
 是vs（vp）曲线的斜率系数；γ 0
 是Gruneisen常数，a是γ 0
 的一阶体积修正量； 
 。

该状态方程模型需要输入的参数包括C、S 1
 、S 2
 、S 3
 、γ 0
 、A、E 0
 、V 0
 。定义Gruneisen状态方程的关键字及输入数据卡片如下：




上述数据卡片各参数意义如下：

EOSID表示状态方程的ID号；C、Si（i=1，2，3）、GAMA0为状态方程的常数；A为一阶体积修正系数；E0为初始内能；V0为初始相对体积。

6.刚体材料

刚性材料模型用于模拟模型中相对刚度较大的部件，LS-DYNA计算中使用刚体模型可以显著地节省计算时间，定义刚体材料模型的关键字及输入数据卡片如下：




其中，第3个卡片为可选的输出设置选项，在关键字中必须包含这个卡片但可以是空行。刚体材料模型输入参数的意义列于表3-24中。

表3-24　刚体材料数据卡片参数




续上表




对于表3-24中的约束选项及参数CMO、CON1及CON2，下面进行说明。

CMO为质心约束选项，CMO=+1.0表示约束施加于总体坐标方向，CMO=0.0表示无约束，CMO=-1.0表示约束施加于局部坐标方向（SPC约束）。

CON1为第一个约束参数。当CMO=+1.0时CON1参数用于指定总体平动约束，包括如下情况：

（1）EQ.0：无约束。

（2）EQ.1：约束X方向的平动。

（3）EQ.2：约束Y方向的平动。

（4）EQ.3：约束Z方向的平动。

（5）EQ.4：约束X方向和Y方向的平动。

（6）EQ.5：约束Y方向和Z方向的平动。

（7）EQ.6：约束Z方向和X方向的平动。

（8）EQ.7：约束X方向、Y方向以及Z方向的平动。

当CMO=-1.0时，CON1指定局部坐标系的ID号（通过*DEFINE_COORDINATE定义）。

CON2为第二个约束参数。当CMO=+1.0时CON2参数用于指定总体转动约束，包括如下情况：

（1）EQ.0：无约束。

（2）EQ.1：约束绕X方向的转动。

（3）EQ.2：约束绕Y方向的转动。

（4）EQ.3：约束绕Z方向的转动。

（5）EQ.4：约束绕X方向和Y方向的转动。

（6）EQ.5：约束绕Y方向和Z方向的转动。

（7）EQ.6：约束绕Z方向和X方向的转动。

（8）EQ.7：约束绕X方向、Y方向以及Z方向的转动。

当CMO=-1.0时，CON2参数指定局部的SPC约束，其意义如下：

（1）EQ.000000：无约束。

（2）EQ.100000：约束X方向的平动。

（3）EQ.010000：约束Y方向的平动。

（4）EQ.001000：约束Z方向的平动。

（5）EQ.000100：约束绕X方向转动。

（6）EQ.000010：约束绕Y方向转动。

（7）EQ.000001：约束绕Z方向转动。

任意的局部约束组合可以通过在对应列添加1实现。

7.离散单元材料关键字

在LS-DYNA中，弹簧及阻尼器等离散单元（*ELEMENT_DISCRETE）的常数一般通过材料关键字的形式来指定，常见的关键字及其对应的离散单元列于表3-25中。

表3-25　常见离散单元材料关键字




下面简单介绍几种常见离散单元的*MAT关键字。

（1）弹簧

LS-DYNA中弹簧的类型包括线性弹簧、通用非线性弹簧、非线性弹性弹簧、弹塑性弹簧、非弹性弹簧以及MAXWELL弹簧等。下面介绍各种弹簧的*MAT关键字。

①线性弹簧

线性弹簧的材料参数通过如下形式的关键字及输入数据卡片指定：

*MAT_SPRING_ELASTIC

MIDK

在此数据卡片中，MID表示材料类型的ID号，K表示弹簧的刚度系数，对应于不同的弹簧类型可以是“力/位移”或“力矩/转角”的量纲。

②通用非线性弹簧

通用非线性弹簧材料模型提供了一种通用非线性平动或转动的弹簧，并可以任意指定加载卸载行为。作为可选择的选项，可以定义硬化或软化行为。通过这种模型建立的弹簧单元，在所连接的两个节点之间只有一个被连接的自由度。

通用非线性弹簧材料定义的关键字及数据卡片如下：

*MAT_SPRING_GENERAL_NONLINEAR

MIDLCDLLCDUBETATYICYI

通用非线性弹簧的数据卡片中各参数的意义列于表3-26中。

表3-26　通用非线性弹簧参数意义




③非线性弹性弹簧

非线性弹簧模型提供了一种非线性弹性平动和转动弹簧。应变率效应可以通过依赖于速度的缩放因子来考虑。这类弹簧通过两个节点连接，每个节点仅包含一个自由度。材料关键字及输入参数卡片如下：

*MAT_SPRING_NONLINEAR_ELASTIC

MIDLCDLCR

其中，MID表示材料类型的ID号；LCD为用于描述力-位移或力矩-转动关系的曲线，这一曲线必须通过（0，0）且包含正负象限的响应。LCR为可选的荷载曲线，用于描述力（力矩）关于相对速度（相对转速）的比例因子函数关系。

④弹塑性弹簧

弹塑性弹簧用于定义两个节点之间的等向硬化弹塑性的位移/转动弹簧。每个节点仅包含一个自由度。材料关键字及输入参数卡片如下：

*MAT_SPRING_ELASTOPLASTIC

MIDKKTFY

其中，MID表示材料类型的ID号；K为弹性刚度（力/位移或力矩/转动）；KT为切线刚度；FY为屈服点的力或力矩。

⑤非弹性弹簧

非线性弹簧用于定义非弹性的仅拉伸或压缩的平动或旋转弹簧。可使用由用户定义的卸载刚度替代最大加载刚度。材料关键字及输入参数卡片如下：

*MAT_SPRING_INELASTIC

MIDLCFDKUCTF

其中，MID表示材料类型的ID号，LCFD为描述任意力/力矩关于位移/转动关系的曲线，这一曲线必须定义在力-位移第一象限（不管弹簧受拉或受压），KU为卸载刚度（可选），KU和曲线中的最大加载刚度中的较大者被用于卸载。CTF为压缩/拉伸标签，等于-1.0表示仅受拉伸，等于1.0表示仅受压缩。

⑥MAXWELL弹簧

此模型用于指定三参数Maxwell黏弹性平动或转动弹簧。可以定义一个保持恒定力/力矩的截止时间。材料关键字及输入参数卡片如下：

*MAT_SPRING_MAXWELL

MIDK0KIBETATCFCCOPT

其中，MID表示材料类型的ID号，K0为短期刚度，KI为长期刚度，BETA为衰减参数，TC为截止时间，FC为截至时间后的力/力矩值，COPT为时间选项，COPT=0表示增量时间变化，COPT≠0表示连续时间变化。

（2）阻尼器

①线性黏滞阻尼器

此模型用于指定两节点的线性平动或转动阻尼器，仅连接一个自由度。材料关键字及输入参数卡片如下：

*MAT_DAMPER_VISCOUS

MIDDC

其中，MID表示材料类型的ID号，DC为阻尼常数（力/位移速率）或（力矩/转速）。

②非线性黏滞阻尼器

此模型用于指定两节点的黏性平动或转动阻尼器，仅连接一个自由度，可指定任意力-速度关系或力矩-转速关系。材料关键字及输入参数卡片如下：

*MAT_DAMPER_NONLINEAR_VISCOUS

MIDLCDR

其中，MID表示材料类型的ID号，LCDR为定义描述力-速度关系或力矩-转速关系的载荷曲线，这一曲线必须定义负半轴和正半轴的响应并经过原点（0，0）。

8.定义材料失效的关键字

LS-DYNA求解器通过关键字*MAT_ADD_EROSION指定材料失效，此关键字基本输入数据卡片如下：

*MAT_ADD_EROSION

MID，EXCL

PFAIL，SIGP1，SIGVM，EPSP1，EPSSH，SIGTH，IMPULSE，FAILTM

上述卡片中各参数的意义列于表3-27中。

表3-27　*MAT_ADD_EROSION关键字的输入参数




通过下面的关键字，可指定材料5构成的单元在200ms的时刻失效：





3.3.3　定义单元算法及截面的关键字

*SECTION关键字用于指定单元算法、积分规则、节点厚度以及横截面特性等。这些数据通过标识SECID与其他的关键字联系起来，每一种单元的SECID必须是唯一的。

下面介绍各种单元类型的*SECTION关键字。

1.关键字*SECTION_BEAM

关键字*SECTION_BEAM用于定义BEAM单元的算法并为beam、truss、discrete beam及cable等各种细分单元类型定义截面特性数据。下面对其输入数据卡片及参数的具体意义进行介绍。

（1）基本数据卡片

基本数据卡片位于关键字后的第一个数据行，包含参数如下：

SECID，ELFORM，SHRF，QR/IRID，CST，SCOOR，NSM

上述卡片中各参数的意义列于表3-28中。

表3-28　*SECTION_BEAM卡片1的参数解释




其中，ELFORM的具体选项列于表3-29中。

表3-29　Beam单元的ELFORM选项




续上表




注：算法1～6和9的3D梁元可以混合使用，但不能与2D的7、8混用，7和8也不能混用。

（2）附加数据卡片

根据基本数据卡片中单元算法选项ELFORM的不同，还需要分别定义不同的附加数据卡片，一般是在关键字后的第2个卡片（个别的还需要第3个卡片）。各种BEAM单元细分类型所需的附加数据卡片参数说明如下。

①Integrated Beam卡片

当ELFORM=1或11时作为第2个卡片输入，包含参数如下：

TS1TS2TT1TT2NSLOCNTLOC

上述各变量的意义如下：

TS1表示节点1处沿s形心轴方向梁的外围尺寸（CST=0.0，2.0）或外直径（CST=1.0）；TS2表示节点2处沿s形心轴方向梁的外围尺寸（CST=0.0，2.0）或外直径（CST=1.0）；TT1表示节点1处沿t形心轴方向梁的外围尺寸（CST=0.0，2.0）或内直径（CST=1.0）；TT2表示节点2处沿t形心轴方向梁的外围尺寸（CST=0.0，2.0）或内直径（CST=1.0）；NSLOC和NTLOC对类型1的梁单元使用，作用时梁端面节点的定位，取1.0，0.0和-1.0依次表示节点位于s或t轴的正方向、截面中心、负方向。

②Resultant Beam With Shape卡片

当ELFORM=2，3，12且前7个字符拼写成“SECTION”时作为第2个卡片输入，包含参数如下：

STYPED1D2D3D4D5D6

其中STYPE表示截面形状类型，相关类型列于表3-30中。

表3-30　STYPE类型




续上表




对表3-30中的每一种类型，D1～D6参数用于描述几何尺寸（不一定被全部使用），以SECTION_01和SECTION_02类型截面为例，其Di如图3-7所示。




图3-7　工字形和C形截面的参数示意

③Resultant Beam卡片

当ELFORM=2，12，13且前7个字符不拼成“SECTION”时作为第2个卡片输入，包含参数如下：

A ISS ITT J SA IST

以上卡片中各变量的意义依次为：梁的横截面积、s方向的惯性矩、t方向的惯性矩、极惯性矩、剪切面积、惯性积（非对称截面情况）；对于桁架杆单元，仅输入截面积A。

④Resultant Beam卡片

当ELFORM=12且前7个字符不拼成“SECTION”时作为第2个卡片输入，包含参数如下：

YS ZS IYR IZR IRR IW IWR

以上卡片中各参数的意义依次为：剪切中心的s坐标、剪切中心的t坐标（坐标原点位于形心） 
 。

⑤Resultant Beam卡片

当ELFORM=3时作为第2个卡片输入，包含参数如下：

A RAMPT STRESS

以上卡片中各参数依次表示桁架的截面积、动力松弛分析的斜坡上升时间及初始应力。

⑥Integrated Beam卡片

当ELFORM=4或5时采用此卡片，其包含的参数如下：

TS1 TS2 TT1 TT2

⑦Discrete Beam卡片

当ELFORM=6时采用此卡片（材料类型不是146时），其包含的参数如下：

VOL INER CID CA OFFSET RRCON SRCON TRCON

以上卡片中各个变量的意义依次为：离散梁单元的体积、转动惯量、定向坐标系ID、索单元的横截面积、索单元的偏置量、局部坐标系的转动约束。

⑧Discrete Beam卡片

当ELFORM=6且材料类型为146时采用此卡片，其包含的参数如下：

VOL INER CID DOFN1 DOFN2

其他卡片中各变量的意义同前，DOFN1和DOFN2表示节点1和节点2被激活的自由度，用数字1到6表示，1为x方向平动，4为绕x方向转动。

⑨2DShell卡片

当ELFORM=7或8时采用此卡片，其包含的参数为节点n1、n2的厚度：

TS1 TS2

⑩Spot Weld卡片

当ELFORM=9时采用此卡片，其包含的参数如下：

TS1 TS2 TT1 TT2 PRINT

其中，PRINT参数为打印输出选项，缺省为0表示输出相关结果到swforc文件，设为1则不输出结果。


 Integrated Beam卡片

当ELFORM=14时采用此卡片，其包含的参数如下：

PR IOVPR IPRSTR

其中：PR为ELBOW单元内部作用压力，启动刚化的作用。IOVPR为ELBOW单元椭圆畸变自由度的打印标签，缺省为不打印，等于1作为ascii文件elbwov输出。IPRSTR为由于PR引起应力是否加入材料子程序，取0时不加入，取1时在轴向和周向应力中考虑此效应。

2.关键字*SECTION_BEAM_AISC

AISC选项可用于定义美国钢结构学会AISCSteel Construction Manual所指定的标准钢型材截面。此关键字包含两个卡片。

卡片1包含如下数据：

SECID LABEL

其中，SECID为SECTION的ID编号，LABEL为AISC的截面标签。

当ELFORM=1，11时，卡片2包含如下数据：

ELFORM SHRF NSM LFAC NSLOC NTLOC K

当ELFORM=2，12时，卡片2包含如下数据：

ELFORM SHRF NSM LFAC

当ELFORM=3时，卡片2包含如下数据：

ELFORM LFACRAMPTSTRESS

当ELFORM=4，5时，卡片2包含如下数据：

ELFORM SHRF NSM LFAC K

*SECTION_BEAM_AISC卡片各参数的意义这里不再逐个介绍。

3.关键字*SECTION_SHELL

关键字*SECTION_SHELL用于定义Shell单元的厚度及算法等特性，此关键字通常包括如下的2个卡片：

SECID，ELFORM，SHRF，NIP，PROPT，QR/IRID，ICOMP，SETYP

T1，T2，T3，T4，NLOC，MAREA

以上卡片中各参数的意义列于表3-31中。

表3-31　*SECTION_SHELL参数解释




其中，ELFORM为SHELL单元的算法公式，具体的选项列于表3-32中。

表3-32　Beam单元的ELFORM选项




续上表




4.关键字*SECTION_TSHELL

关键字*SECTION_TSHELL用于定义厚壳单元的算法及相关特性，对于非复合材料单元此关键字通常包含1个如下的数据卡片：

SECID ELFORM SHRF NIP PROPT QR ICOMP TSHEAR

以上卡片中各参数的意义列于表3-33中。

表3-33　*SECTION_TSHELL的参数解释




5.关键字*SECTION_SOLID

关键字*SECTION_SOLID用于定义体单元的算法选项，此关键字通常包含1个如下的数据卡片：

SECID ELFORM

其中，SECID为SECTION的ID编号；ELFORM为实体单元的算法公式选项，各种选项列于表3-34中。

表3-34　SOLID单元算法类型




6.关键字*SECTION_DISCRETE

关键字*SECTION_DISCRETE用于定义离散单元（弹簧、阻尼器）的特性和参数，一般此关键字包含两个数据卡片：

SECID DRO KD V0 CLFD

CDLTDL

上述卡片中各参数的意义列于表3-35中。

表3-35　*SECTION_TSHELL的参数解释




续上表





3.4　接触关键字

接触是LS-DYNA动力分析中非常重要的一个方面。在LS-DYNA的关键字文件中，通过*CONTACT关键字来指定接触信息。*CONTACT关键字的一般格式如下：

*CONTACT_OPTION1

其中OPTION1为接触类型选项，可用的接触类型列于表3-36中。

表3-36　*CONTACT的OPTION1类型选项




续上表




续上表




对于大部分的接触类型选项，需要定义以下3个数据卡片：

SSID MSID SSTYP MSTYP SBOXID MBOXID SPR MPR

FS FD DC VC VDC PENCHK BT DT

SFS SFM SST MST SFST SFMT FSF VSF

上述各个卡片中相关参数的具体含义列于表3-37～表3-39中。

表3-37　*CONTACT卡片1的参数解释




表3-37中提到的SET（组），是指一系列对象的集合，在LS-DYNA中通过*SET关键字来定义各种对象（如NODE、ELEMENT、PART等）的分组集合。常用的*SET关键字包括：

*SET_NODE_LIST

*SET_PART_LIST

*SET_SOLID

*SET_BEAM

*SET_SHELL

*SET_SEGMENT

主、从段的选择一般遵循这样的原则，即：对于TIE类型的接触，一般是非对称的处理方式，网格较粗的宜作为主段；当使用单面的滑动面刚体接触时，刚体材料应作为主段；对单面算法，仅定义从段，此面上的每一个节点被检查以保证其不穿透表面。

表3-38　*CONTACT卡片2的参数解释




与表中摩擦系数相关的几个参数之间满足如下的关系：




式中，vrel为相对滑动速度。

表3-39　*CONTACT卡片3的参数解释




除了上述三个卡片，对部分接触类型还需要第4个卡片，相关参数请参照LS-DYNA关键字手册。


3.5　约束方程及连接关键字

除了接触之外，在LS-DYNA中还可指定各种部件连接关系，比如：铰链、运动副、自由度耦合、节点刚性体、壳单元与体单元的连接、铆接、一般焊接、焊点等。这些连接方式可通过*CONSTRAINED关键字来定义。

1.铰约束

关键字*CONSTRAINED_JOINT_OPTION用于定义刚体间的铰链约束，比如：球铰链、万向铰链、柱面铰等。不同的OPTION选项被用于指定不同的约束类型，比如：SPHERICAL、UNIVERSAL、CYLINDRICAL等。

2.节点刚性体

关键字*CONSTRAINED_NODAL_RIGID_BODY_OPTION用于把一系列节点定义为节点刚性体，可以通过节点刚性体来连接两个变形体，使之一起运动。

3.自由度耦合及约束方程

关键字*CONSTRAINED_NODE_SET用于在总体坐标系中对一组节点的平动自由度进行耦合。关键字*CONSTRAINED_LINEAR用于定义一个线性的自由度约束方程。

4.壳与实体的连接

关键字*CONSTRAINED_SHELL_TO_SOLID用于将壳单元和实体单元进行固连，可以把一个壳单元的节点最多固连到9个实体单元的节点上。

5.焊点与铆接

关键字*CONSTRAINED_SPOTWELD_OPTION用于在不重合的两个梁或壳单元节点之间建立刚性的焊点约束，其实质是在两个节点之间定义一个刚性梁的连接。关键字*CONSTRAINED_RIVET用于在不重合的两个体节点之间定义铆接连接约束。

对于两个重合的节点，不能通过关键字*CONSTRAINED_SPOTWELD_OPTION定义点焊接约束，也不能通过关键字*CONSTRAINED_RIVET定义铆接约束。这种情况下，可以通过关键字*CONSTRAINED_NODAL_RIGID_BODY来定义约束关系。

6.通用焊接

关键字*CONSTRAINED_GENERALIZED_WELD_OPTION用于定义各种通用的焊接连接，其中的OPTION选项可以为：

（1）SPOT：多节点焊接约束；

（2）FILLET：节点间的角焊缝；

（3）BUTT：节点间的对接焊缝；

（4）CROSS_FILLET：交叉角焊缝；

（5）COMBINED：上述情形的组合。

7.与刚体的连接

关键字*CONSTRAINED_EXTRA_NODES_OPTION用于将某个节点或一组节点附加到一个刚体上，需要定义的参数包括刚体的PARTID以及节点ID或节点SET的ID。

8.刚体之间的连接

关键字*CONSTRAINED_RIGID_BODIES用于在不同的两个刚体之间建立约束，两个刚体不一定在空间相连，但是约束后主、从刚体将在一起运动。

9.创建边界约束面

关键字*CONSTRAINED_GLOBAL以及*CONSTRAINED_LOCAL用于定义总体和局部坐标系中的边界约束面，可指定约束平面的法线方向。对于自适应网格划分的情况建议采用这类约束条件关键字，因为网格细分后针对原有节点的约束定义会失效。

上述各类约束及连接关键字的输入数据卡片，本节不再逐一介绍，请参考LS-DYNA的关键字手册。


3.6　初始条件、边界条件与荷载关键字

本节介绍定解条件相关的关键字，定解条件包括初始条件、边界条件以及载荷三种动力分析的基本条件。

1.初始速度关键字

在LS-DYNA中，指定初始速度的常用关键字包括如下几种情况：

（1）通过关键字*INITIAL_VELOCITY为关键字*SET_NODE所定义的节点集合指定初始速度。

（2）通过关键字*INITIAL_VELOCITY_NODE向给定的节点定义初始的速度和角速度。

（3）通过关键字*INITIAL_VELOCITY_RIGID_BODY指定刚体质心处的初始平动和转动速度。

2.边界条件关键字

关键字*BOUNDARY用于定义各种边界条件，常见边界条件有如下类型：

（1）固定位移边界

关键字*BOUNDARY_SPC用于向节点或节点SET来施加固定位移边界条件，可固定三向线位移或角位移中的任意多个。自适应划分时采用*CONSTRAINED_GLOBAL代替。

（2）规定运动边界

关键字*BOUNDARY_PRESCRIBED_MOTION_OPTION用于向节点或刚体施加给定的位移、速度、加速度边界条件，OPTION可以是SET，RIGID，RIGID_LOCAL等选项。

（3）无反射边界

关键字* BOUNDARY_NON_REFLECTING_2D及* BOUNDARY_NON_REFLECTING用于向实体单元的表面SEGMENTSET定义无反射边界条件，用户需指定（膨胀波开关）和（剪切波开关）。

（4）循环或重复对称边界

关键字*BOUNDARY_CYCLIC用于定义轴对称的循环对称边界条件，或平行于坐标轴的重复平移对称边界条件。

（5）面内运动或沿线运动

关键字*BOUNDARY_SLIDING_PLANE用来向nodeset定义一个沿着任意方向的平面内运动或沿着任意方向的线运动的边界条件。

3.荷载关键字

关键字*LOAD用于施加显式分析的各类荷载，常见的荷载包括如下类型：

（1）施加于节点的荷载

关键字*LOAD_NODE_OPTION用于向一个节点或节点SET施加动态的节点荷载。OPTION可以为POINT或者SET。

（2）施加于SEGMENT（SET）的荷载

关键字*LOAD_SEGMENT以及*LOAD_SEGMENT_SET用于向一个段或段的SET施加均布的压力荷载。一个段是指一个壳单元的表面或体单元的表面节点。

（3）施加于体的荷载

可施加于体的荷载包括如下几种类型：

关键字*LOAD_BODY_OPTION向结构模型或选定的部件（PARTS选项）施加的体积力。

关键字*LOAD_BODY_GENERALIZED用于向选择的节点SET或PARTSET施加由于加速度或转动角速度引起的体力荷载。

关键字*LOAD_RIGID_BODY用于向一个刚体施加力或力矩，荷载的作用位置在刚体的质心，力矩作用方向绕总体坐标轴。

（4）施加于BEAM的荷载

关键字*LOAD_BEAM_OPTION用于向梁单元（OPTION=ELEMENT）或梁单元SET（OPTION=SET）的表面施加均布力。

（5）施加于SHELL的荷载

关键字*LOAD_SHELL_OPTION用于向壳单元（OPTION=ELEMENT）或壳单元SET（OPTION=SET）施加均布压力。关键字*LOAD_MASK用于向Shell单元部件的部分表面施加分布压力荷载。

（6）爆炸压力荷载

关键字*LOAD_BLAST用于向segment施加爆炸冲击波压力荷载。关键字*LOAD_BRODE用于施加BRODE函数形式的爆炸压力荷载。这两个关键字需要与关键字*LOAD_SEGMENT，*LOAD_SEGMENT_SET或*LOAD_SHELL_OPTION等结合使用。

在定义荷载时，常用到各种载荷曲线、向量以及坐标系等，这些可通过*DEFINE关键字来定义。

关键字*DEFINE_CURVE用于定义载荷曲线。

关键字*DEFINE_VECTOR用于定义分析中需要用到的向量。

关键字*DEFINE_COORDINATE_NODE、*DEFINE_COORDINATE_SYSTEM以及*DEFINE_COORDINATE_VECTOR用于定义局部坐标系统。


3.7　求解以及输出控制关键字

本节介绍与LS-DYNA求解以及输出控制相关的关键字。

1.求解控制选项关键字

关键字*CONTROL_TERMINATION的作用是指定分析结束时间，这一关键字在任何一个分析中都是必要的。其他的*CONTROL关键字也提供了一些可选的分析设置选项，这些关键字及其作用列于表3-40中。

表3-40　部分*CONTROL关键字及其作用




续上表




2.阻尼设置关键字

在LS-DYNA的关键字文件中，通过*DAMPING关键字为系统定义阻尼，包括如下具体类型：

（1）关键字*DAMPING_FREQUENCY_RANGE用于在一定频率范围内指定近似于恒定的阻尼比。

（2）关键字*DAMPING_GLOBAL用于定义质量加权总体阻尼。

（3）关键字*DAMPING_PART_MASS用于定义基于PART的质量加权阻尼。

（4）关键字*DAMPING_PART_STIFFNESS用于定义基于PART的Rayleigh刚度阻尼系数。

（5）关键字*DAMPING_RELATIVE用于定义相对于刚体运动的阻尼。

3.输出控制关键字

*DATABASE关键字用于定义LS-DYNA求解器计算输出相关的选项。

（1）结果文件格式

关键字*DATABASE_FORMAT指定计算输出的结果文件格式，数据卡片参数如下：

IFORMIBINARY

其中，IFORM表示二进制文件的输出格式，选择0为输出LS-DYNA格式，选择1为输出ANSYS格式，选择2为输出LS-DYNA格式以及ANSYS格式。IBINARY为输出文件字长选项，0表示64位格式，1表示32位格式。

（2）ASCII文件输出选项

关键字*DATABASE_OPTION指定ASCII文件输出的类型及时间间隔。OPTION选项表示可供选择输出的ASCII文件类型，常用ASCII文件类型列于表3-41中。此关键字数据卡片中的参数DT为输出的时间间隔，DT=0时无任何输出。

表3-41　ASCII文件选项类型




续上表




（3）二进制文件输出间隔选项

关键字*DATABASE_BINARY_OPTION指定二进制文件的输出间隔。OPTION选项代表一系列不同的二进制文件类型，常用的有D3PLOT、D3THDT、D3DUMP等。对结果文件D3PLOT和D3THDT，指定时间间隔DT；对重启动文件D3DUMP则指定循环次数CYL。


第4章　ANSYS传统界面前处理

本章介绍基于ANSYS传统界面Mechanical APDL的LS-DYNA前处理方法，内容包括ANSYS传统界面中的LS-DYNA前处理概述、建立LS-DYNA分析模型、定解条件分析选项设置以及关键字的导出。


4.1　ANSYS传统界面前处理概述


4.1.1　Mechanical APDL界面及其基本使用

1.Mechanical APDL操作界面

在Windows系统的开始菜单中选择ANSYSMechanical APDL Product Launcher，打开ANSYS传统界面启动器。在Simulation Environment下拉菜单中选择ANSYS，即ANSYS Mechanical APDL传统界面；在License下拉菜单中选择软件许可证为ANSYSLS-DYNA，如图4-1所示。在File Management部分，为分析指定工作路径Working Directory以及工作文件名Jobname，如图4-2所示。按下Product Launcher界面左下角的Run按钮，启动ANSYSMechanical APDL操作界面（即ANSYS传统界面），如图4-3所示。




图4-1　选择软件许可




图4-2　指定工作路径与文件名

Mechanical APDL操作界面的主要组成部分包括：Main Menu（主菜单）、Utility Menu（功能菜单）、Toolbar（工具栏）、Input Window（操作命令输入栏）、Graphic Window（图形显示区域）、操作提示栏（Promptline）以及系统状态栏（Statusbar），此外还有一个独立于界面的输出信息窗口（Output Window）。如果用户希望在一个文件中查看输出信息，而不是打印到屏幕输出窗口，可通过功能菜单Utility Menu>File>Switch Outputto>file…指定要写入输出信息的文件。Mechanical APDL界面各部分的分区情况及其功能列于表4-1中。




图4-3　ANSYS传统前处理环境

表4-1　GUI分区及其功能描述




下面对Mechanical APDL界面的各部分功能和使用要点作简要介绍。

（1）应用程序菜单（Utility Menu）

包含了程序会话过程中的一些可用工具操作，例如文件管理（File）、对象的选择（Select）、数据资料列表（List）、图形绘制（Plot）、绘图控制（Plot Ctrls）、工作平面设置（Workplane）、参变量设置（Parameter）、宏管理（Macro）、菜单控制（Menu Ctrls）以及帮助（Help）。

（2）主菜单（Main Menu）

包含了分析过程中各个环节中用到的主要操作命令的菜单，如建立模型、划分网格、施加约束及荷载、分析求解过程、结果的图形化显示等，这些命令分属于前处理器、求解器、后处理器等不同的程序模块。

（3）工具栏（Toolbar）

工具栏包含了程序执行过程中最为常用的命令和操作的按钮。用户可通过选择功能菜单Utility Menu>Macro>Edit Abbreviations打开Edit Toolbar/Abbreviations对话框，通过*ABBR命令在其中定义命令缩写，以增加工具条中的按钮，如图4-4所示。




图4-4　工具条缩写指定

（4）输入栏窗口（Input Window）

直接输入命令的区域，命令输入过程中程序可自动显示提示信息，用户可以点击窗口右端的 
 按钮，在下拉的命令列表中浏览以前输入的命令历史并选择相关命令重复执行。

（5）图形显示窗口（Graphic Window）

即时显示用户操作结果的图形显示区域。

（6）输出信息窗口（Output Window）

独立于界面的窗口，其中显示程序在运行过程中的各种中间信息和计算结果输出等参数，可以通过观察该窗口显示的内容以了解程序的运行情况和当前工作的进程。

（7）操作提示栏

操作提示栏位于操作界面的左下角，用于向用户提供命令操作方法的提示信息。

（8）系统状态栏

操作提示栏的右边为系统状态参数提示栏，包括当前的材料类型号（mat）、单元类型号（type）、实参数编号（real）、坐标系统（csys）、截面号（secn）。

2.Mechanical APDL的两种操作方法与层次结构

Mechanical APDL环境的操作方法有两种，即：界面交互操作和命令操作。菜单操作就是通过图形用户界面（GUI）的菜单进行交互式的操作；命令操作则是直接输入命令或命令流文件来驱动程序执行的操作方式。由于ANSYSMechanical APDL实质上是一个通过命令所驱动的界面，所有的菜单操作都对应着特定的操作命令，而界面操作的实质也相当于向程序发出命令，因此菜单操作和命令操作两种方式在本质上是等效的。

（1）界面交互操作方式

Mechanical APDL的图形用户界面（GUI）提供了功能强大的菜单选项和人机交互功能，用鼠标点选相应的菜单调用各种对话框即可执行相关的操作命令，从而完成建模和分析的操作过程。

（2）命令批处理操作方式

既然所有的菜单操作都对应着特定的操作命令，那么当然也可以直接通过命令实现各种操作，可以将操作命令按照先后顺序编辑成为一个文件，即命令流文件，通过菜单项Utility Menu>File>Read Input From，即可自动读入并逐条执行文件中的每一条命令。

ANSYSLS-DYNA除了包含基本的ANSYS前、后处理操作命令之外，还内置了一些与LS-DYNA显式分析专用的命令，这些显式分析的命令都是用“ED”开头，即“EXPLICIT DYNAMICS”首字符缩写，表示这些命令与显式动力分析相关。通过ED系列命令可以在ANSYS环境中进行显式分析选项的设置，还可将模型信息在求解之前写入LS-DYNA关键字文件。关于这些命令与LS-DYNA关键字之间的对应关系，请参考本书附录的相关内容。

在ANSYS工作路径下有一个日志文件（后缀名为log），此文件中按照操作的先后次序记录了全部操作对应的命令。由一连串ANSYS命令组成的脚本文件通常被称为命令流文件，命令流中的所有命令组合起来就可以自动地完成一个项目的建模、分析以及后处理的全部操作。用户在启动界面后可通过菜单Utility Menu>File>Read Input From，导入命令流文件，ANSYS将会自动地逐条执行文件中的全部命令。由于ANSYS命令脚本文件执行效率高，适合于参数改变后的快速重复模型生成与分析，因此建议优先采用命令流操作的方式，即编写ANSYS的命令脚本文件（命令流文件），然后在Mechanical APDL环境下导入并自动执行。

在ANSYS命令脚本的编写过程中，必须注意Mechanical APDL程序的层次结构，这是因为ANSYS的程序结构分为两层：起始层（Begin Level）以及处理器层（Processor Level），这种层次结构如图4-5所示。




图4-5　Mechanical APDL的处理器层结构

图中所示的起始层是用户进入和离开ANSYS程序时所处的层，在不同的处理器中间进行切换也必须经由起始层才能实现。这一层仅仅是一个抽象的概念，在其中并不发生任何实质性的操作。处理器层则由一系列实现不同功能的处理器组成，常见的处理器包括实现建模功能的前处理器（PREP7）、求解器（Solver）、通用后处理器（POST1）以及时间历程后处理器（POST26）等。在ANSYSLS-DYNA使用过程中，主要用到的是前处理器以及求解器中的命令，后处理器则较少使用。

由于每个处理器都包含完成相应功能的一系列命令，通常情况下，这些命令不可以在其他处理器中调用。在不同的操作阶段，需要用户进入不同的处理器发出正确的命令，从而完成整个分析项目。界面操作中，用户只需要点相应的菜单即可，对于不在同一处理器中的菜单项，程序能够自动进行处理器切换。但是在编写APDL脚本文件时，编写者必须通过相应的命令进入相应处理器，如：/PREP7命令表示进入前处理器，/SOLU命令表示进入求解器，/POST1命令表示进入通用后处理器，/POST26命令表示进入时间历程后处理器。在完成相关处理器的操作后要写一条FINISH命令以退出此处理器，比如求解完成后，通过FINISH命令退出求解器，再通过发出/POST1命令以进入通用后处理器进行结果的查看和分析。在编写脚本的过程中，用户必须清楚每一条命令是否属于当前所在的处理器，不注意这些问题会导致脚本文件运行发生错误。命令的参数及其所属的处理器信息，用户可以查看ANSYS的命令手册《Command Reference》。

3.ANSYS命令群组记忆法

ANSYS操作命令虽然种类繁多，但是常用的并不很多，建议采用分类熟记命令的方法，即按命令群组的形式，同一命令群组中一般都是具有相同或类似功能的命令，只是作用的针对的对象类型不同。

表4-2和表4-3中给出了ANSYS中命令作用对象X的种类以及名称，以及一些X对象的群组命令系列。

表4-2　ANSYS中对象的类型名称




表4-3　ANSYS中X对象的群组命令




以上面划分网格的命令群组XMESH为例，X=A表示对面进行网格划分的命令AMESH，其使用方式举例说明如下：




ANSYS命令的具体调用方法和参数可参考ANSYS的命令手册《Command Reference》。与LS-DYNA前处理及分析设置相关的ANSYS界面交互操作以及对应的命令，将在本章后续内容中进行系统的介绍。


4.1.2　APDL语言使用简介

基于ANSYS传统操作环境Mechanical APDL进行LS-DYNA前处理，经常采用APDL命令流或宏文件的操作方式，为此本节对APDL语言及其应用作简要的介绍。

1.APDL语言的基本功能及命令流文件

APDL是ANSYSParametric Design Language的缩写，即ANSYS参数化设计语言。作为Mechanical APDL界面的脚本语言，APDL可提供一般性的程序语言功能及相关的特殊功能，比如：标量参数、数组参数、数学运算、内部函数、分支与循环、访问ANSYS数据库、文件读写、创建宏、界面定制开发等。APDL可以调用ANSYS命令或创建宏文件，并用于开发专用分析模块等，还可以访问ANSYS数据库，提取模型或结果数据。APDL还具备简单的界面开发能力，可实现参数的交互式输入、消息机制、界面驱动等功能。在Mechanical APDL环境中，基于APDL语言编写的命令流或宏文件可以实现全参数化的显式动力分析自动建模、加载以及分析选项设置等操作。

ANSYS的命令流文件是按照APDL格式编写的命令批处理文件，由变量参数赋值、变量表达式、APDL编程命令以及ANSYS操作命令组成。一般情况下，一个语句或一条命令占一行。以“!”开头的行为注释行，程序在执行过程中将自动跳过。多个命令可以放到同一行写，其间以“$ ”隔开。在Mechanical APDL的图形界面GUI中，通过菜单项Utility Menu>File>Read Inputfrom或者/INPUT命令即可将编写好的命令流文件读入并逐条执行其中的每一条语句或命令。比如：将一个文件名为FILE.TXT的批处理文本文件读入程序的命令为：

/INPUT，FILE，EXT

由于所有的图形界面交互式操作都将以命令的形式记录到日志文件（Jobname.log）中，因此对于初学者，可以通过查看GUI操作的日志文件（Utility Menu>File >List>log File），了解交互操作与ANSYS操作命令之间的对应关系，并据此改写所需的命令流文件。

2.APDL的标量参数与数组参数

APDL语言提供标量参数和数组参数等一般程序语言功能，ANSYS命令可以调用APDL定义的参数完成参数化的建模和分析选项设置。

（1）标量参数

APDL语言通过*SET命令定义标量参数，*SET命令的形式为：

*SET，Par，Value

上述命令的意义是定义一个标量参数Par，其值为Value。

标量参数的也可以赋值语句来定义，语句的形式为：

Par=Value

赋值语句的作用与*SET命令等价。

比如，定义一个名称为pi的常数，可通过以下两种方式之一：

*SET，pi，3.14159

PI=3.14159

ANSYS不区分参数名称的大小写，如输入的是小写自动转换为大写。

标量参数还可以通过表达式赋值，表达式由参数、数字以及加、减、乘、除、乘方、内部函数等组成，可以是以下的形式：

MM=NN+LL

RI=RO-TCK

Distance=SQRT（（x2-x1）**2+（y2-y1）**2）

PI=ACOS（-1）

Z=LOG10（Y）

在使用APDL的内部函数给标量参数赋值时，要注意三角函数的角度单位，角度单位通过菜单Utility Menu>Parameters>Angular Units或者*AFUN命令进行设置，菜单交互操作的对话框如图4-6所示。




图4-6　角度单位制

（2）数组参数

APDL语言通过*DIM命令定义数组参数，命令格式为：

*DIM，Par，Type，IMAX，JMAX，KMAX，Var1，Var2，Var3

其中，Par是要定义的数组参数名称；Type是数组类型，可以是ARRAY（数值数组）、TABLE（需指定0行0列的数表，可插值）、CHAR（字符型数组）、STRING（字符串数组）；IMAX，JMAX，KMAX是数组各维的维数（数组元素下标的最大值）；Var1，Var2，Var3是对于TABLE类型，与行、列、面对应的变量名。

定义了数组参数之后，通过*SET命令或直接赋值语句为数组的各元素赋值，在直接赋值语句中为按列输入元素。

例如，通过*DIM定义一个3×3的ARRAY型的数组参数MM并赋值，命令如下：

*DIM，MM，ARRAY，3，3

MM（1，1）=11，21，31

MM（1，2）=12，22，32

MM（1，3）=13，23，33

选择菜单Utility Menu>Parameters>Array Parameters>Define/Edit，可查看数组MM的元素，如图4-7所示。




图4-7　数组MM的元素

又比如，通过*DIM定义一个5×1的TABLE数组BFC并赋值：

*DIM，BFC，TABLE，5，1，1

BFC（1，0）=0.0，1.5，3.0，4.0，5.5

BFC（1，1）=0.0，10.5，15.7，17.0，15.6

定义TABLE数组BFC后，通过菜单Utility Menu>Parameters>Array Parameters>Define/Edit可查看此数表，如图4-8所示，Table型数组的特点是有一个第0列。




图4-8　TABLE型数组的定义

Table型数组数据点以外的Table数值可以通过已有的数据点插值得到，通过*SET命令计算BFC第0列为1.0以及5.0时的BFC值并赋予标量参数AA以及BB：

*SET，AA，BFC（1.0）

*SET，BB，BFC（5.0）

选择菜单Utility Menu>Parameters>Scalar Parameters查看标量参数AA及BB的值如图4-9所示。




图4-9　TABLE数组的插值计算

3.APDL语言的循环与分支

循环和分支是APDL语言的的控制语句。

（1）循环

APDL的循环用于重复性的操作，分支用于控制程序执行。

对于大量重复性的操作，可以通过定义循环的方式。APDL采用*DO命令和*ENDDO命令定义一个循环体，一般形式为：

*DO，Par，IVAL，FVAL，INC

...（循环操作的命令，要引用循环变量Par）

*ENDDO

Par为循环变量，IVAL、FVAL、INC为决定循环次数的参量，分别表示循环变量的初值、终值以及增量，增量INC可正可负也可为小数（分数）。如果IVAL比FVAL的值大，且INC为正，则程序会终止循环语句的执行。

循环体中可以嵌入下一级的循环体形成多重循环。

（2）分支

APDL语言的分支控制命令的一般形式如下：

*IF，VAL1，Oper，VAL2，THEN

...（需要执行的命令）

*ELSEIF，VAL1，Oper，VAL2，

...（需要执行的命令）

*ELSEIF，VAL1，Oper，VAL2，

...（需要执行的命令）

*ELSE

...（需要执行的命令）

*ENDIF

其中，Oper为操作符，常见的操作符列于表4-4中。

表4-4　条件语句的操作符




更一般形式的*IF语句可以是由两组操作符连接在一起的形式：

*IF，VAL1，Oper1，VAL2，Base1，VAL3，Oper2，VAL4，Base2

其中，Base1是连接操作符Oper1和Oper2的运算为真的条件，Base1=AND表示两个操作符Oper1和Oper2同时为真；Base1=OR表示两个操作符Oper1和Oper2中间任何一个为真；Base1=XOR表示两个操作符Oper1和Oper2中间有一个为真（不是两个同时为真）。

4.访问ANSYS数据库

APDL语言具有强大的访问和提取ANSYS数据库的能力。

（1）通过命令*GET及*VGET获取数据库信息

①*GET命令的使用

*GET命令用于从ANSYS数据库中提取标量参数，其一般格式为：

*GET，Par，Entity，ENTNUM，Item1，IT1NUM，Item2，IT2NUM

其中，Par为提取的标量参数名称；Entity为提取参数信息的实体项目类型，比如：NODE、ELEM、KP、LINE、VOLU等；ENTNUM为实体编号；Item1，IT1NUM为提取的信息类型及其编号；Item2，IT2NUM是提取的第2组信息类型及其编号。

表4-5给出一些通过*GET命令从数据库中提取标量参数的举例。

表4-5　*GET命令的举例




②*VGET命令的使用

*VGET命令用于从ANSYS数据库中提取数组参数，其一般形式如下：

*VGET，Par R，Entity，ENTNUM，Item1，IT1NUM，Item2，IT2NUM，KLOOP

其中，Par为提取的数组参数名称；Entity为提取参数信息的实体项目类型，比如：NODE、ELEM、KP、LINE、VOLU等；ENTNUM为实体编号；Item1，IT1NUM为提取的信息类型及其编号；Item2，IT2NUM是提取的第2组信息类型及其编号；KLOOP为循环指示位置。

下面举一个例子说明*vget的使用，以下命令流用于提取节点坐标值放入Node_loc数组中，操作完成后得到Node_loc数组如图4-10所示。







图4-10　Node_Loc数组

（2）基于内部函数获取数据库信息

作为*GET命令以及*VGET命令的替代做法，也可以使用内部函数快速获取数据库信息。利用表4-6所列函数可获取各类位置坐标。

表4-6　位置坐标获取函数




续上表




利用表4-7所列的函数可以计算距离、面积、面的法向等一些几何量。

表4-7　计算几何量的内部函数




在通用后处理器中，利用表4-8所列的函数可以获取当前结果Set中的节点自由度解，如：结构分析的位移，热分析的温度等。

表4-8　用于获取自由度解的内部函数




对于字符型变量，利用表4-9所示的操作函数可以进行字符编辑。

表4-9　字符串操作内部函数




（3）对单元或节点信息统计排序

NSORT、ESORT命令用于对当前所选择节点或单元关于某一量（如：应力）的排序和列表。比如下面的命令：




可以选择按升序或降序，也可选择按绝对值还是原始值参加排序。排序后列表显示单元或节点量时，第一列的节点号或单元号是按统计后的排序。对应菜单位置为：

Main Menu>General Postproc>List Results>Sorted Listing>Sort Nodes

Main Menu>General Postproc>List Results>Sorted Listing>Sort Elems

使用命令NUSORT或EUSORT可取消排序，恢复到原来的节点或单元顺序（默认为编号由小到大的顺序），对应菜单位置为：

Main Menu>General Postproc>List Results>Sorted Listing>Unsort Nodes

Main Menu>General Postproc>List Results>Sorted Listing>Unsort Elems

5.创建和使用ANSYS宏

宏是一系列ANSYS命令集合形成的文件，通常宏的扩展名取为mac，如Mac01.mac就是一个名为Mac01的宏文件。在搜索路径中的宏可以通过*USE命令来执行，例如：

*use，Mac01

或直接在命令输入窗口中输入宏的文件名Mac01。

宏的搜索路径包括/ansys_inc/v150/ansys/apdl目录、由环境变量ANSYS_MACROLIB所指定的路径、由$ HOME环境变量指定的路径以及工作路径。宏中可以包含参数，宏还可以嵌套其他的宏。

后缀名为mac的宏文件实际上也可当作ANSYS命令直接调用，即在ANSYS的命令窗口中直接输入宏文件名也可执行宏命令。

宏文件的创建可通过*Create命令、*CFWRITE命令（结合*CFOPEN和*CFCLOS）、/TEE命令等方式创建，但最为直接的方法是通过文本编辑器创建并保存为*.Mac文件。

6.简单的界面定制开发能力

APDL还具有简单的见面定制开发功能。

（1）工具条按钮定制

通过菜单项Utility Menu>Macro> Edit Abbreviations或者Utility Menu>Menu Ctrls>Edit Toolbar，可以将分析中常用的ANSYS菜单项（对应的指令）定制成按钮，添加到工具条中，这样可以提高工作效率。

例如：在建模过程中要频繁地用到重新绘图的命令/REPLOT（对应菜单项为Utility Menu>Plot>Replot），为了在使用过程中快速调用这一功能，只需选择Utility Menu>Macro>Edit Abbreviations菜单，弹出Edit Toolbar/Abbreviations对话框，在其中输入*ABBR，REPLOT，/REPLOT，选择Accept按钮，如图4-11所示，这一功能的快速调用按钮就出现在ANSYS的工具条中，如图4-12所示。




图4-11　输入*ABBR选项




图4-12　增加REPLOT按钮后的工具条

其中，REPLOT为新建的工具条按钮名称，/REPLOT为这一按钮所调用的ANSYS命令。读者可以根据需要，添加各种常用命令的快速调用按钮到工具条中。

（2）*ASK参数提示框

用户可以通过*ASK命令提示参数的输入，当在命令行中输入如下指令时，将弹出关于参数length的提示框，如图4-13所示，其缺省的值为1。

*ask，AA，Density，7800




图4-13　*ASK提示信息框

（3）创建参数输入提示对话框

对于带参数的宏命令，其多个参数还可通过multipro命令创建对话框来提示输入，这里列举一个例子。




通过这些命令可创建如图4-14所示的参数提示框，为参数Ex_1和NUXY_1赋值。




图4-14　参数提示框


4.1.3　LS-DYNA前处理的一般流程

在Mechanical APDL环境中进行LS-DYNA前处理的流程通常包含建立几何模型、定义单元属性、网格划分、建立PART表、定义接触信息、定义定解条件、导出关键字等一系列操作环节，前处理过程的输出结果是LS-DYNA的关键字文件。

下面对前处理各个环节的任务进行简要的介绍。

1.定义单元属性

定义单元类型及其算法选项、几何参数信息、材料模型及材料参数等单元属性。在Mechanical APDL前处理器中，常见的单元属性包括单元类型、实常数以及材料特性。

2.建立几何模型

建立几何模型就是根据实际结构尺寸创建一个外形相同的几何造型。在Mechanical APDL环境中的几何模型都是由关键点、线、面、体等各种图形元素（简称图元）所构成，图元层次由高到低依次为体、面积、线及关键点。

可以通过自底向上（bottom-up Method）或者自顶向下（top-downmethod）两种途径创建几何模型：

（1）自底向上的建模方式

首先定义关键点，再由这些点连成线，由线组成面，由面围合形成体积。即由低级图元向高级图元的建模顺序。

（2）自顶向下的建模方式

直接建立较高层次的图元对象，其对应的较低层的图元对象随之自动产生。这种方式建模将用到布尔运算，即各种类型对象的相互加、减、组合等操作。

3.网格划分

对几何模型进行单元划分，一般包括如下三个步骤：

（1）分配单元属性

所谓分配单元属性，就是将之前定义的各种单元属性（单元类型、实常数、材料属性）赋予要划分网格的几何对象。

（2）网格划分设置

网格划分设置一般包括网格的尺寸控制、划分方法控制以及网格形状的控制。

尺寸控制可以是整体的，也可以是针对局部点、线、面、体对象的；划分方法一般可分为结构化网格及非结构化网格，或者称为映射网格及自由网格；网格形状则包括六面体、四面体、四边形、三角形。

（3）划分网格

在完成前面两步的设置后，执行网格划分形成有限元分析模型。

4.建立PART表

PART是LS-DYNA模型中的重要概念，很多前处理操作都与PART的ID相关联，因此划分网格之后需要通过EDPART命令形成PART表。

5.定义接触信息

接触定义是LS-DYNA的重要环节，此环节的任务是定义各部件之间的接触关系以及接触参数。由于接触定义很多基于节点组元，通常需预先定义相关的组元。

6.定义定解条件

定解条件包括初始条件、边界约束条件以及荷载三大类。在一个动力分析中至少需要指定一种类型的定解条件，否则系统将保持静止。

7.导出关键字

上述前处理操作结束后，通过ANSYSLS-DYNA的EDWRITE命令导出LS-DYNA格式的模型关键字文件。


4.2　建立分析模型

本节介绍在Mechanical APDL前处理器中创建LS-DYNA分析模型的具体方法。


4.2.1　定义单元属性

本节介绍ANSYSLS-DYNA单元属性的定义，包括单元类型、实常数以及材料模型定义，这些操作是在ANSYS的前处理器程序中进行的，定义单元属性之前首先通过命令/PREP7或选择Main Menu>Preprocessor菜单以进入前处理器。

1.定义单元类型及选项

通过ET命令定义单元类型及单元选项，ET命令的形式如下：

ET，ITYPE，Ename，KOP1，KOP2，KOP3，KOP4，KOP5，KOP6，INOPR

其中，ITYPE为单元类型号，Ename为单元名称（160～168），KOP1至KOP6为单元选项。

如果采用交互操作，则选择菜单Main Menu>Preprocessor>Element Type>Add/Edit/Delete，打开Element Types对话框中，选择ADD按钮，打开Libraryof Element Types对话框，如图4-15所示，在右侧的单元列表中选择ANSYSLS-DYNA单元类型，通过Element Types对话框中的Options按钮在打开的单元选项设置对话框中选择单元选项，比如SHELL163单元的KEYOPT选项设置对话框如图4-16所示。




图4-15　单元类型选择




图4-16　SHELL163单元选项

表4-10列出了ANSYSLS-DYNA的9种显式单元类型，每种单元类型都提供多个KEYOPT选项，这些选项与上一章介绍的*SECTION关键字中的选项相对应。

表4-10　显式分析单元




关于各种单元的KEYOPT选项，请参考附录E的相关内容。

2.定义实常数

对部分ANSYSLS-DYNA单元类型，需要定义实常数。常见实常数包括：梁单元的剪切因子以及截面积、惯性矩等几何参数，壳单元的剪切因子和厚度、集中质量、弹簧/阻尼单元参数等。

定义实常数的命令为R命令，其一般格式为：

R，NSET，R1，R2，R3，R4，R5，R6

其中，NSET为实常数的编号，R1，R2，R3，R4，R5，R6为前6个实常数，这些实常数必须按照单元手册中的指定次序输入。

如果使用Mechanical APDL界面交互模式，则选择菜单Main Menu>Preprocessor>Real Constants，选择一种单元类型并为其定义实常数。以SHELL163单元为例，在缺省单元KEYOPT选项下，实常数可在如下对话框中定义，如图4-17所示。




图4-17　SHELL163单元的实常数定义

与此相对应的命令为：

R，1，5/6，5，0.1，0.1，0.1，0.1

在上面的对话框以及R命令中，1表示NSET，即实常数的编号；SHRF为剪切因子，此处定义为5/6；NIP为沿厚度方向的积分点个数，按Gauss积分计算，这里定义为5个；壳单元各节点的厚度T1至T4为0.1。

除了R命令外，如果有多于6个实常数的，可通过RMORE或RMODIF命令定义。

RMORE命令用于指定第7至12个实常数，续写在R命令的下面一行，其格式如下：

RMORE，R7，R8，R9，R10，R11，R12

RMODIF命令用于指定或编辑实常数，其格式如下：

RMODIF，NSET，STLOC，V1，V2，V3，V4，V5，V6

其中，当STLOC=1时V1至V6表示第1至第6个实常数；STLOC=7时V1至V6则表示第7至第12个实常数。

各种单元类型所需的实常数，请参考附录E的相关内容。

3.定义材料模型及材料参数

Mechanical APDL前处理环境中可定义各种常用的LS-DYNA材料模型及参数，ANSYS前处理支持的LS-DYNA材料模型可参照附录。

如果采用交互操作方式，则通过选择菜单项目Main Menu>Preprocessor>Material Props>Material Model，打开如图4-18所示的Define Material Model Behavior对话框，此对话框的右侧显示了可用的材料模型分类目录。在目录中选择材料模型类型时，双击目录可打开下一级子目录，直至找到所需的模型。目录图标为 
 表示该项目下面还有子项目，图标 
 表示已经打开过的具有子项目的项目，图标 
 表示已经是可以直接打开参数设置对话框的材料类型。在目录中选择所需类型并输入相关材料参数，即可完成材料模型的定义。




图4-18　材料模型选择

如果需在一个分析中定义多种材料模型，在定义一种材料模型后，在Define Material Model Behavior对话框中选择的Material>New Model…菜单项，指定材料模型编号即可增加新材料类型，新的材料类型指定后继续按上述步骤选择材料模型并指定材料参数。

与上述界面操作对应的定义材料模型参数的命令包括MP、EDMP、TB和TBDATA以及定义与温度相关特性的MPTEMP、MPDATA等。如果对相关命令不熟悉，可先采用交互操作方式填写材料数据，然后由log文件中提取有关的命令。

在上述材料类型目录中包括线性材料模型、非线性材料模型、与状态方程相关的材料模型、离散单元模型以及刚性体模型等5种大的类型，下面对各种类型材料模型的定义方法及注意要点进行介绍。

（1）线性材料模型

在Define Material Model Behavior的LS-DYNA\Linear\Elastic目录下，分别选择Isotropic、Orthotropic、Anisotropic或Fluid即可定义各向同性、正交各向异性、完全各向异性线弹性材料模型以及弹性流体模型。

各向同性材料模型的材料数据输入对话框如图4-19所示，需要定义密度、弹性模量及泊松比。如果采用命令可按下列方式。







图4-19　各向同性弹性材料

正交各向异性材料数据的输入对话框如图4-20所示，需要定义DENS、EX、EY、EZ、NUXY、NUYZ、NUXZ、GXY、GYZ、GXZ以及坐标系号。材料参数定义的命令也是MP，坐标系号则是通过EDMP，ORTHO命令定义。




图4-20　正交各向异性材料

各向异性线弹性材料参数的定义对话框如图4-21所示，需要定义的参数包括密度、坐标系及弹性系数。




图4-21　各向异性材料

对应命令为MP、EDMP、TB及TBDATA，具体格式如下：

MP，DENS，MAT，VAL

EDMP，ORTHO，MAT，VAL

TB，ANEL

TBDATA，1，C11，C12，C22，C13，C23，C33

TBDATA，7，C14，C24，C34，C44，C15，C25

TBDATA，13，C35，C45，C55，C16，C26，C36

TBDATA，19，C46，C56，C66




图4-22　弹性流体模型

弹性流体模型的参数对话框如图4-22所示，需要定义DENS、EX、NUXY及Bulk Modulus。体积模量可不定义，由EX、NUXY按Bulk Modulus=EX/[3×（1-2×NUXY）]计算；如果定义体积模量，以输入的体积模量为准。

如果采用命令方式，则DENS、EX、NUXY仍通过MP命令定义，Bulk Modulus通过EDMP命令按如下格式定义（其中VAL1是体积模量）：

EDMP，FLUID，MAT，VAL1

（2）非线性材料模型

在Define Material Model Behavior对话框中，非线性材料模型包括非线性弹性、非弹性模型以及泡沫模型三大类。非线性弹性模型包括超弹性、黏弹性；非弹性模型主要是各类塑性模型；泡沫模型中提供了5个泡沫材料模型。

非线性材料模型的参数也同样可通过界面或命令方式定义。比如：塑性分析中最常见的双线性随动塑性模型。在Define Material Model Behavior对话框中选择LS-DYNA\Nonlinear\Inelastic\Kinematic Hardening\Bilinear Kinematic，打开如图4-23所示对话框。




图4-23　Bilinear Kinematic模型

如果采用命令操作方式，则DENS、EX及NUXY通过MP命令定义，屈服应力（Yield Stress）和切线模量（Tangent Modulus）通过TB，BKIN和TBDATA命令定义，格式如下：

TB，BKIN

TBDATA，1，Yield Stress

TBDATA，2，Tangent Modulus

其他非线性模型的定义方式都是相似的，不再逐个介绍。下面介绍LS-DYNA材料定义涉及的应力和应变数据的问题。

在定义部分塑性模型时，常需要指定各种应力-应变关系，这一般是指真实应力与真实应变，已知的工程应力与工程数据需要首先转换为真实应力应变才能用于LS-DYNA材料定义。

如果工程应力和工程应变为σ和ε，真实应力和对数应变为S和E，则它们之间的换算关系如下（进入颈缩阶段后不能用此方式转化）：

S=σ（1+ε）

E=ln（1+ε）

通过上述转化得到的真实应变减去弹性应变（以屈服强度除以弹性模量计算），又可得到部分材料模型定义所需的应力-有效塑性应变关系。

上面提到的各种应力-应变关系首先需要定义数组（*DIM命令），然后用EDCURVE命令（在后面加载部分介绍此命令）定义成数据曲线，在定义相关材料时直接引用曲线ID即可。

（3）状态方程相关模型

在Define Material Model Behavior的LS-DYNA\Equtionof State目录中包含了线性多项式、Gruneisen以及Tabulated三种状态方程，这些状态方程可与部分材料模型结合使用，以计算相关材料的压力，比如线性多项式状态方程与Null模型结合可用于定义水、空气等流体材料模型。在材料模型目录中选择LS-DYNA\Equtionof State\Linear Polynomial\Null，打开如图4-24所示的Null材料属性对话框，即可在其中指定相关的流体模型参数。




图4-24　流体模型的参数

在上述的对话框中，需指定的参数包括密度、弹性模量、泊松比、压力截断值（小于0.0）、动力黏性系数、扩张侵蚀过程的相对体积（取0表示被忽略）、压缩侵蚀的相对体积（取0表示被忽略）、状态方程的系数C0至C6、初始内能（通过初始压力计算）以及初始相对体积。由于参数较多，建议在以上对话框中直接填写，然后在log文件中提取相关命令脚本。

除了Null材料外，线性多项式状态方程还可以用来定义Johnson-Cook塑性模型、Zerilli-Armstrong模型以及Steinberg塑性模型等。Gruneisen以及Tabulated状态方程也可与这几种材料模型结合使用。相关参数的意义请参照前面关键字一章，这里不再详细介绍。

（4）离散单元特性模型

所谓离散单元特性模型，是指通过材料模型的形式指定离散单元的参数。在Define Material Model Behavior的LS-DYNA\Discrete Element Properties目录下包含了弹簧（Spring）、阻尼器（Damper）、索（Cable）三种离散单元类型。在其中选择一种具体的离散单元类型，然后在打开的对话框中指定相关参数即可，这些参数的意义请参照前面一章材料模型关键字部分。有些单元类型（如：非线性弹簧的力-位移关系）可能会涉及数据曲线定义，方法与后面一节介绍的载荷曲线的定义方法相同。

（5）刚性体模型

在Define Material Model Behavior的材料模型目录中选择LS-DYNA\Rigid Material，即可打开刚体材料模型参数设置Rigid Properties对话框，如图4-25所示。刚体材料模型所需参数包括密度、弹性模量、泊松比以及平动、转动的约束类型。




图4-25　刚性材料模型

通过上述对话框定义刚体材料后，在log文件中可以看到密度、弹性模量、泊松比这些参数是通过MP命令定义的，与上述约束情况设置对应的命令则是EDMP，RIGID，其形式如下：

EDMP，RIGID，MAT，VAL1，VAL2

其中，VAL1和VAL2分别表示刚体的平动和转动约束选项（相对于整体笛卡尔坐标系），具体选项及对应约束情况列于表4-11及表4-12中。

表4-11　VAL1及刚体平动约束情况




表4-12　VAL2及刚体转动约束情况




续上表





4.2.2　直接法建模与间接法建模

本节所指的建模是在上面定义了单元属性之后创建分析的有限元模型。基于Mechanical APDL创建LS-DYNA分析模型，可以采用两种不同的建模方法：直接法和间接法。

直接法即通过逐个定义节点和单元的方式建立有限元模型，仅适用于单元数目较少的简单结构。间接法则是首先建立由各种几何图形元素组成的实体模型，再对其进行网格划分以形成有限单元模型，间接法适用于各种大型结构或几何外型复杂的结构。

1.直接法建模

在定义了单元类型及上述各种单元属性之后，就可以用这些单元类型来创建结构分析模型了。前已述及，建模方法有直接法以及间接法。如采用直接法建模，直接创建节点，然后通过节点创建单元。

创建节点的命令为N，其一般格式如下：

N，NODE，X，Y，Z

命令参数说明：

NODE为节点号，X、Y、Z为节点的坐标。

创建节点时，要注意坐标系的问题，因为在不同的坐标系下需要输入的节点坐标不同。比如：直角坐标系中输入坐标（X，Y，Z），而柱坐标系则输入（R，THETA，Z）。ANSYS Mechanical APDL中常见的几个坐标系列于表4-13中。其中工作平面是一个建模的辅助平面，缺省情况下与总体坐标XOY重合，可以根据需要平移和旋转。此外，用户还可以根据需要通过LOCAL命令来指定局部坐标系并将设为当前活动坐标系。用户可以通过CSYS命令来选择当前坐标系，这一设置在界面正下方的状态栏中会显示出来。

表4-13　Mechanical APDL中的几个常用坐标系




对于一个分析中有多种单元类型或单元属性的情况，在创建单元之前必须首先向程序声明接下来所要创建的单元属性。表4-14列出了直接建模中用于声明单元属性的命令及其参数说明及所起的作用。

表4-14　声明单元属性的相关命令




声明了单元属性后，通过节点直接创建单元。创建单元的命令为E，其命令的一般格式如下：

E，I，J，K，L，M，N，O，P

命令参数说明：I，J，K，L，M，N，O，P为单元的各个节点号，必须预先定义好，节点编号要按单元手册中单元示意图中的节点编号顺序。

在创建节点和单元过程中，还可以配合使用NGEN命令、EGEN命令进行节点和单元的快速复制，以提高建模效率。可以使用NUMMRG命令合并重合的节点，使用NUMCMP命令压缩节点和单元编号。

以上就是直接法建立有限元模型的基本过程和操作注意事项。

2.间接法建模之一：创建几何模型

所谓间接法，就是首先形成几何模型，再对几何对象进行单元属性和单元划分参数指定，最后通过网格划分的方法形成有限元分析模型。间接法建模首先需要在前处理器PREP7中创建几何模型。

在Mechanical APDL中，几何模型的对象包括关键点（Keypoint）、线（Line）、面（Area）、体（Volume）等几个层次，通常上一层次的几何对象包含下面各层次的对象。创建几何模型时，可以自下而上，也可自上而下。采用自下而上方式时，先创建低层次的图形对象，再通过低层次图形对象创建高层次图形对象，比如：首先创建关键点，再通过一系列关键点创建多义线。采用自上而下方式时，直接创建高层次的图形对象，而其包含的低层次的对象被自动创建，比如：创建一个圆柱体，则其底面、顶面、侧面等各面自动被创建。在自上而下建模时，经常用到各种布尔操作，在几何图形对象之间进行诸如加、减、交、分割、粘接、搭接等各种操作，进而形成复杂的几何造型。

在Mechanical APDL环境中的几何建模功能集中在Main Menu>Preprocessor>Modeling>菜单下的一系列子菜单中，介绍这些建模操作及其命令的教程已经很多，此处不再展开介绍。

3.间接法建模之二：形成网格

在几何模型创建完成后，需要进行单元属性和网格划分参数的指定，之后按照这些设定进行网格划分形成有限元模型。

在Mechanical APDL环境中，这些网格划分相关的操作均可以通过选择菜单Main Menu>Preprocessor> Meshing> Mesh Tool，在弹出的“Mesh Tool”工具面板中实现。Mesh Tool工具面板有五个功能分区，用分隔线分开，自上而下依次为：

（1）设置单元属性

设置单元属性在Mesh Tool面板的Element Attributes区域中进行，如图4-26所示。在此区域中可以对点、线、面、体等几何对象设置网格属性，在下拉列表选择对象类型，点SET按钮，弹出对象选择对话框，输入几何对象号（如：1号点、3号面等）或在模型中用鼠标拾取相应的对象，在弹出的对象单元属性对话框中指定各种前面已经定义的单元属性即可。与这一步相应的命令为XATT（X=K、L、A、V），可以为各种对象指定单元属性。

（2）智能网格划分控制区域

智能网格控制区域位于Element Attributes区域下方。如选择“Smart Size”复选框，可激活智能网格划分方法。该方法能够自动考虑模型细节及曲率变化，智能划分四面体或三角形网格，可通过滑块选择智能划分的尺寸粗细级别1～10，10表示单元最细。设置智能网格划分尺寸控制级别的命令为SMRTSIZE。

（3）网格尺寸控制区域

网格尺寸控制区域即Mesh Tool中的Size Controls区域，位于智能网格划分区域下方，如图4-27所示。在此区域内可以对总体网格进行网格尺寸控制，也可对线、面、体、关键点周围进行单元尺寸或划分等分数指定。注意这些指定的优先顺序为：线>关键点>总体。

控制单元尺寸的命令为ESIZE（总体）、XESIZE（X=K、L、A、V，表示对各种对象进行单元尺寸控制）。




图4-26　Mesh Tool单元属性及智能网格划分区域




图4-27　网格尺寸控制区域

（4）网格划分操作区域

网格划分操作区域位于Mesh Tool面板网格尺寸控制区域下方，如图4-28所示。

在此区域内可以指定网格划分的对象和方法并进行网格划分。比如选择对Volume（体）进行划分，在Shape中选择单元形状为Tet（四面体）或Hex（六面体），然后选择划分方法为Free（自由网格）、Mapped（映射网格）或Sweep（扫略网格）。其中映射网格和扫略网格需要被划分的几何体满足一定条件。然后点Mesh按钮，在弹出的拾取框中输入对象编号或用鼠标拾取对象即可进行网格划分。这些操作对应的命令为MSHAPE命令（控制单元形状）、MSHKEY命令（控制mesh方法）以及XMESH命令（X=K、L、A、V，表示对各种对象进行网格划分）。如果对划分的网格不满意，还可以通过此区域的Clear按钮，清除有关对象上已经存在的网格以便进行重新划分。

（5）网格的细化区域

网格细化区域位于网格操作区域下方，如图4-29所示。在此区域内，可以对选择单元、各种几何对象（关键点、线、面）上或其附近的已有网格进行细化。




图4-28　网格划分操作区域




图4-29　网格细化区域

（6）形成网格的其他方式

除了上面的一般操作之外，还有一些形成有限元网格的操作方法，比如前面的实体建模中已经介绍过的拖拉、旋转操作，由面拖拉形成体时，如果面已经进行了网格划分，则拖拉成体的同时将面网格拖拉形成体网格。

在拖拉之前，选择菜单项目Main Menu>Preprocessor>Modeling>Operate>Extrude>Elem Ext Opts，弹出“Element Extrusion Options”对话框，如图4-30所示，在其中指定要拖拉形成的体单元的属性、沿拖拉方向的网格等分数，以及是否在拖拉后保留面。与之相关的命令为EXTOPT以及TYPE、MAT、REAL、ESYS等指定单元属性的命令。通过菜单项目Main Menu>Preprocessor>Modeling>Operate>Extrude>Areas>Along Normal，可实现沿法向拉伸面，对应命令为VOFFSET。还可以选择沿着指定路径拉伸或绕轴旋转形成体网格等。

无论基于何种方式形成网格后，即完成间接法结构建模工作。


4.2.3　接触以及连接关系的指定

本节先介绍PART、PART集合以及组元的定义，然后介绍接触以及连接关系的指定。

1.定义PART

PART是LS-DYNA的一个重要概念。在LS-DYNA的分析模型中，一个PART一般是模型中的某一个特定部分，每个PART都被赋予了一个PARTID，这个编号可被相关的关键字引用。在ANSYSLS-DYNA前处理过程中，可以用EDPART命令建立部件、更新或列出部件列表，以在一些后续命令中直接引用部件的PARTID号。在ANSYSLS-DYNA中，一个PART一般是指具有相同的单元属性（即：单元类型号，实常数和材料号）的单元组成的集合。材料类型、单元类型及单元属性相同的单元集合可以被定义为1个单独的PART，也可以分别定义为多个不同的PART。ANSYSLS-DYNA在递交LS-DYNA求解器计算之前，会将PART的相关信息写入分析的关键字文件Jobname.k中。




图4-30　拖拉形成单元的设置

EDPART命令调用的一般格式如下：

EDPART，Option，PARTID，Cname

Option选项可以是CREATE（创建）、UPDATE（更新）、ADD（添加）、DELE（删除）、LIST（列出）等。选择CREATE表示创建PART表；选择UPDATE表示更新PART表；如果选择ADD，还需要指定要添加的部件号PARTID以及这一部件包含的单元组元Cname（组元是指一组对象的集合，下面将介绍）；DELE选项用于删除通过ADD选项添加的PART，也需要指定要删除的PARTID；LIST选项则用于列出PART表。在形成PART后，通过菜单Utility Menu>Plot>Parts，可以绘制分颜色显示的Part图。

对EDPART命令的CREATE选项，在使用过程中要特别谨慎。比如通过EDPART，LIST列出如下形式的部件表（PART表）：




上述PART表的各列依次为各PART的ID号、材料类型号、单元类型号、实常数号以及PART使用状态标识号（0表示是一个无用的PART）。如果在PART表第一次形成后，组成PART1的单元被全部删除，则PART表将显示PART1是一个无用的PART（USED=0）。这种情况下，如果执行“EDPART，UPDATE”命令将不会影响此PART表的状态，因为这样不会改变表中PART的顺序；但是执行“EDPART，CREATE”命令时，程序将创建一个仅包含5个PART的新的部件表（即所有的有用PART列表），PART2成为PART1，其余的依次类推。这将使得基于PART定义的荷载、接触特性等失效。因此，在建模过程中不要重复使用“EDPART，CREATE”命令，可多次使用“EDPART，UPDATE”，在需要PARTID的命令中注意正确引用。

PART集则是由一系列的部件（PART）组成的部件集合，部件集合有一个ID号，部件集合号也可被一些显式分析命令所引用，比如定义包含有多个部件的实体之间的接触时，PART集是很有用的。

使用EDASMP命令可以定义、列表和删除PART集合，其调用格式为：

EDASMP，Option，ASMID，PART1，PART2，……，PART16

其中，Option域可以为ADD/LIST/DELETE等选项，即建立、显示和删除部件集合。ASMID表示部件集合的ID号。当选择ADD时，最多可以定义由16个PART所组成一个新的PART集合。

例如，下列命令表示定义一个由PART1、PART3和PART5组成的PART集合，其ID号为10：

EDASMP，ADD，10，1，3，5

2.组元

组元（Component），是Mechanical APDL中一个很重要的概念，很多命令都会引用到组元。所谓组元，是同一种对象的集合，如节点组成的集合、单元组成的集合等。在ANSYSLS-DYNA中，有很多显式分析命令都会引用到预先定义的组元。比如：向模型的一部分节点施加荷载时，首先选择所有需加载的节点，将其定义为一个节点组元，然后将荷载施加到这一组元上；在接触分析中定义节点与表面的接触时，也通常需要将接触节点集合定义为组元。

在ANSYSLS-DYNA中定义组元的命令如下：

CM，Cname，Entity

其中，Cname是要定义的组元名称，Entity为组元类型选项，如ELEM表示单元组元，NODE表示节点组元等。

比如，可通过如下命令，将当前选中的所有节点定义为一个名为INTERFACE的节点组元：

CM，INTERFACE，NODE　　　　　!创建一个名为INTERFACE的节点组元

如果采用界面交互模式，则通过选择菜单Utility Menu>Select>Comp/Assembly>Create Component，打开“Create Componeng”对话框，在Cname中填写组元名称，在Entity下拉列表中选择组元包含的对象类型，点OK按钮完成组元的创建，如图4-31所示。

3.接触定义

在ANSYSLS-DYNA程序中，接触类型主要包含三大类，即：Single Surface（单面接触）、Nodesto Surface（节点到表面接触）以及Surfaceto Surf（表面到表面接触）。三大类型又各自包含一些亚类，相关的接触类型汇总于表4-15中。




图4-31　创建节点组元INTERFACE

表4-15　接触类型汇总




关于表中的各种接触类型的选择原则及适用范围，这里作简单的说明。

Single Surface接触类型包括的接触亚类有AG、ASSC、ASS2D、SS、ESS、SE。对于Single Surface接触类型，预先不清楚接触的具体部位，LS-DYNA程序在计算中自动判定模型中发生接触的位置。Single Surface接触类型适用于同一物体表面的自接触或不同物体之间的表面接触。Single Surface接触类型的定义无需区分接触面以及目标面，定义Single Surface接触的表面实际上与模型的所有外表面都可能发生接触。这种类型的接触比较适合于自接触问题以及无法预知接触具体部位的问题。对SHELL单元的表面，尽量使用自动单面接触ASSC，定义简单且计算效率较高。

Nodesto Surface接触类型包括的亚类有NTS、ANTS、RNTR、TDNS、TNTS、ENTS、FNTS、DRAW。Nodesto Surface接触类型在计算中会探测接触节点是否穿透了接触的表面。Nodesto Surface接触类型适合于两个物体表面之间的接触，因此要注意区分接触面以及目标面，一般原则为：凹面或平面、网格较粗的面通常作为目标面，而凸面、网格较细的面作为接触面。此外，压延筋接触（DRAW亚类）的筋总是作为接触面。

Surfaceto Surf接触类型包括的亚类有STS、OSTS、ASTS、ROTR、TDSS、TSES、TSTS、ESTS、FSTS、FOSS。Surfaceto Surf接触类型在计算中会探测接触两侧的物体是否会穿透对方的表面。Surfaceto Surf接触类型适合于不同物体之间的发生的较大面积及相对较大滑移的接触。

在Mechanical APDL界面中，按照如下的操作步骤定义接触：

（1）选择接触类型

选择菜单Main Menu>Preprocessor>LS-DYNAOptions>Contact>Define Contact，打开Contact Parameter Definition接触定义对话框，如图4-32所示。在Contact Parameter Definition对话框中首先选择合适的接触类型和亚类。




图4-32　定义接触类型和参数对话框

（2）定义接触参数

在Contact Parameter Definition对话框中定义与接触相关的参数，如：接触面之间的摩擦系数、阻尼系数、接触的激活与失效的时刻等，详见后面命令参数的说明。接触参数定义完成后按下OK按钮，对于Single Surface接触类型可直接完成接触定义。

（3）定义接触面及目标面

对Nodesto Surface以及Surfaceto Surf接触类型，按下上面的OK按钮，会继续打开Contact Options对话框，如图4-33所示，在其中选择Contact以及Target节点组元或PART ID，按下OK按钮完成接触的定义。

节点组元需要在定义接触操作之前预先定义好。




图4-33　指定接触/目标组元或PART

实际操作中更多采用命令方式定义接触。与上述界面交互方式定义接触相对应的命令为EDCGEN命令，其一般调用格式如下：

EDCGEN，Option，Cont，Targ，FS，FD，DC，VC，VDC，V1，V2，V3，V4，BTIME，DTIME，BOXID1，BOXID2

其中：

Option参数用于指定接触的类型选项，即亚类的名称，如AG。

Cont参数用于指定接触面，可填写相应的节点组元名称或PART（PART集）的ID号；对于AG、SE、ASSC、ESS以及SS等类型不需要输入Cont。对于ASS2D类型，Cont必须定义为part集。对于ENTS类型，Cont必须定义为节点组元。对于ESS和ESTS类型，Cont必须定义为Part或PART集。

Targ参数用于指定目标面，可填写相应的节点组元名称或PART（PART集）的ID号；对于AG、SE、ASSC、ESS、SS以及ASS2D等接触类型不需要输入Cont。

FS、FD、DC参数依次为静摩擦系数、动摩擦系数、指数衰减系数，缺省值均为0。

VC、VDC为黏滞摩擦系数和黏滞阻尼系数占临界阻尼的百分比，缺省值为0。

V1、V2、V3、V4为附加参数，不同接触亚类会有不同的意义，可参考ANSYS的命令手册。

BTIME、DTIME为接触的激活时刻与强制失效时刻。

4.节点约束方程

在ANSYSLS-DYNA中，通过EDCNSTR命令可指定节点约束方程，用于向刚体附加节点、模拟节点刚性体、SHELL与SOLID的连接以及铆接。

EDCNSTR命令的调用格式为如下：

EDCNSTR，Option，Ctype，Comp1，Comp2，VAL1

其中各参数的意义为：

Option选项可以是ADD（定义）、DELE（删除）或LIST（列表）；Ctype为定义约束的类型选项，Ctype=ENS表示向刚体上附加节点，Ctype=NRB表示用于定义节点刚性体，Ctype=STS用于定义SHELL与SOLID之间的固连，Ctype=RIVET表示定义无质量的铆接连接。

不同的Ctype所对应的具体命令形式不同，下面作简单的解释。

（1）Ctype=ENS的命令形式

EDCNSTR，Option，ENS，Comp1，Comp2

其中，Comp1为存在的刚体Part号，Comp2为要向刚体添加的节点组元名称。

（2）Ctype=NRB的命令形式

EDCNSTR，Option，NRB，Comp1，，VAL1

其中，Comp1为要定义为节点刚性体的节点组元名称，VAL1为输出数据所用的坐标系ID（通过EDLCS命令预先定义）。节点刚性体没有PART号，仅与节点组元有关，可用于模拟多个柔性体之间的刚性连接。

（3）Ctype=STS的命令形式

EDCNSTR，Option，STS，Comp1，Comp2

其中，Comp1为SHELL单元的节点号，Comp2为要与SHELL单元连接的SOLID单元的节点组元名称（最多9个节点）。

（4）Ctype=RIVET的命令形式

EDCNSTR，Option，RIVET，Comp1，Comp2

其中，Comp1为铆接连接的第一个节点的节点号，Comp2为铆接连接的第二个节点的节点号，且与第一个节点不能重合。铆接连接的两节点间的距离将在分析过程中保持不变，RIVET约束不能定义失效。

EDCNSTR命令的GUI路径为：

如果在Mechanical APDL界面中，可通过以下的菜单之一定义节点约束连接。

Main Menu>Preprocessor>LS-DYNA Options>Constraints>Apply>Additional Nodal

Main Menu>Solution>Constraints>Apply>Additional Nodal

选择上述菜单会打开如图4-34所示对话框，在其中选择Constraint Type，点OK按钮，对不同的约束类型，会打开不同的对话框，如图4-35（a）、（b）、（c）、（d）所示，在其中指定了相关信息后按OK按钮，即可完成节点约束方程连接方式的指定。




图4-34　定义节点约束




图　4-35




图4-35　不同节点约束类型的参数对话框

5.定义焊接连接

焊接是一种常见的结构连接方式。ANSYSLS-DYNA可以通过两个节点来定义一个无质量焊点，也可通过一组节点定义一般焊接。

（1）无质量焊点

如果在Mechanical APDL界面中进行交互式操作，定义无质量焊点时，选择菜单Main Menu>Preprocessor>LS-DYNAOptions>Spotweld>Massless Spotwld，弹出对象拾取框，选择一个节点，点Apply按钮，选择另一个节点，按OK按钮，打开如图4-36所示对话框，在其中指定相关参数，按OK按钮即可完成焊点的定义。




图4-36　定义无质量焊点

（2）一般焊接

定义一般焊接时，选择菜单Main Menu>Preprocessor>LS-DYNA Options>Spotweld>Genrlizd Spotwld，打开如图4-37所示对话框，在其中指定相关参数（下面命令参数中介绍），按OK按钮，即可完成一般焊接的定义。




图4-37　定义一般焊接

上述定义无质量焊点及一般焊接对话框显示，与指定焊接相对应的命令为EDWELD命令，此命令的调用格式为：

EDWELD，Option，NWELD，N1，N2，SN，SS，EXPN，EXPS，EPSF，TFAIL，NSW，CID

其中，Option为操作选项，可以是ADD（定义），DELE（删除），LIST（列表）；NWELD为焊点或一般焊接的编号；对于焊点，N1和N2为焊点所连接的两个节点号，对于一般焊接，N1为要定义焊接的节点组元名称，N2不用填；SN、SS、EXPN及EXPS仅用于焊点，SN和SS分别为点焊的法向失效应力和切向失效应力；EXPN和EXPS为点焊的失效准则中法向和切向力的指数；EPSF、TFAIL、NSW及CID仅用于一般焊接连接，EPSF为一般焊接发生延性破坏的有效塑性应变；TFAIL为一般焊接连接的失效时间，缺省为1.0E20；NSW为一般焊接所包含的焊点数；CID域为输出数据使用的坐标系（通过EDLCS命令预先定义）。


4.3　定解条件、计算选项设置与关键字导出

本节介绍定解条件、分析选项的指定以及LS-DYNA关键字的导出。


4.3.1　定解条件

本节所指的定解条件包括初始条件、边界约束条件以及载荷三种类型。

1.初始条件

在LS-DYNA动力学分析中需要定义系统的初始条件，模型各部分缺省的初始速度均为零。在ANSYSLS-DYNA中可通过以下菜单之一进行初始条件的设定。

Main Menu>Preprocessor>LS-DYNA Options>Initial Velocity>On Nodes>w/Axial Rotate

Main Menu>Preprocessor>LS-DYNA Options>Initial Velocity>On Nodes>w/Nodal Rotate

Main Menu>Solution>Initial Velocity>On Nodes>w/Axial Rotate

Main Menu>Solution>Initial Velocity>On Nodes>w/Nodal Rotate

与上述菜单交互操作相对应的命令为EDVEL和EDPVEL，分别用于对节点组元或PART（集）定义初始平动速度及角速度。

（1）EDVEL命令

EDVEL命令用于对节点或节点组元施加初速度，其调用格式为：

EDVEL，Option，Cname，VX，VY，VZ，OMEGAX，OMEGAY，OMEGAZ，XC，YC，ZC，ANGX，ANGY，ANGZ

其中，Option选项可为VGEN、VELO、LIST（列表显示）、DELE（删除定义的初速度）。VGEN选项表示将采用平动初速度（用VX，VY，VZ表示）叠加绕某转轴（通过其上一点XC，YC，ZC及其方向角ANGX，ANGY，ANGZ定义）的初始转动（角速度为OMEGAX）的方式来定义初始速度。VELO选项则是采用平动初速度（用VX，VY，VZ表示）叠加节点初始转动（节点角速度为OMEGAX，OMEGAY，OMEGAZ）的方式来定义节点初始速度。这两个选项只能使用一个。Cname为要施加初始速度的节点组元名称或者节点号。

（2）EDPVEL命令

EDPVEL命令用于对PART或PART集合定义初速度，其调用格式为：

EDPVEL，Option，PID，VX，VY，VZ，OMEGAX，OMEGAY，OMEGAZ，XC，YC，ZC，ANGX，ANGY，ANGZ

其中，PID为要施加初始速度的PART或PART集的ID号，其余各选项的意义与EDVEL命令的相应选项相似。

2.边界条件

在ANSYSLS-DYNA中，可以通过如下命令为分析模型指定边界条件。

（1）固定边界条件

在ANSYSLS-DYNA中，通过D命令或EDNROT命令用于施加固定位移边界条件。

D命令用于施加总体坐标方向的固定约束，其基本格式为：

D，NODE，Lab，VALUE，VALUE2，NEND，NINC，Lab2，Lab3，Lab4，Lab5，Lab6

其中，NODE表示被约束的节点，Lab为受约束的自由度，VALUE必须为0.0。D命令菜单路径为Main Menu>Preprocessor>LS-DYNA Options>Constraints>Apply>On Nodes或Main Menu>Solution>Constraints>Apply>On Nodes。

EDNROT命令用于在旋转的节点坐标系中施加非总体坐标方向的固定约束，其基本格式为：

EDNROT，Option，CID，Cname，DOF1，DOF2，DOF3，DOF4，DOF5，DOF6

其中，Option可为ADD、DELE或LIST，CID表示之前通过EDLCS命令定义的局部坐标系的ID号，Cname为施加边界条件的节点组元，DOFi（i=1～6）为局部坐标系CID中的自由度，可为UX、UY、UZ、ROTX、ROTY、ROTZ，如果DOF1=ALL则约束全部自由度。

EDNROT命令的菜单路径为Main Menu>Preprocessor>LS-DYNA Options>Constraints> Apply>Rotated Nodal。

（2）平移或循环对称边界条件

在ANSYSLS-DYNA中，通过EDBOUND命令施加平移或循环对称边界，此命令的格式为：

EDBOUND，Option，Lab，Cname，XC，YC，ZC，Cname2，COPT

其中，Option可为ADD（施加）、DELE（删除）或LIST（列表）；Lab可为SLIDE（滑移对称）或CYCL（循环对称）；Cname为边界节点组元；原点指向点（XC，YC，ZC）的向量用来定义滑移对称面法向或循环对称转轴。Cname2为要定义循环对称边界的第二个边界节点组元，仅在CYCL选项时才使用；COPT为滑移对称边界条件的参数，0表示节点在法向平面内运动，1表示节点仅在向量方向移动，此参数仅在SLIDE选项时才使用。

EDBOUND命令的菜单路径为Main Menu>Solution>Constraints>Apply>Symm Bndry Plane。

（3）无反射边界条件

在ANSYSLS-DYNA中，通过EDNB命令向SOLID164及SOLID168单元表面的节点组元施加无反射边界条件。EDNB命令的基本格式为：

EDNB，Option，Cname，AD，AS

其中，Option选项可为ADD（定义）、DELE（删除）、LIST（列表显示）；Cname表示要施加边界条件的节点组元；AD和AS分别为膨胀波及剪切波开关。

命令的菜单路径为EDNBMain Menu>Solution>Constraints>Apply>Non-Refl Bndry。

3.施加显式荷载

（1）可施加的显式荷载类型

ANSYSLS-DYNA的荷载通过EDLOAD命令施加，可施加的荷载类型列于表4-16中，这里要注意非零位移是通过荷载的方式施加的。

表4-16　可施加的荷载类型




关于表中各种荷载，这里作如下的补充说明：

以上各种荷载类型均需通过荷载-时间曲线来定义，然后施加到模型的特定部分。施加到节点组元上时，节点组元必须预先定义。施加到单元组元上时，必须加到正确的面上，通过SHELL163和SOLID164单元的面号来指定。非零自由度需要作为动力荷载施加。

（2）载荷曲线及加载坐标系

上节介绍的各类荷载具有一个共同的特点，即：都是随着时间变化的。为此，在加载前必须定义时间和载荷数组或者由两者组成载荷时间历程曲线。在ANSYSLS-DYNA中，通过EDCURVE命令定义包括载荷曲线在内的各类数据曲线，其调用格式为：

EDCURVE，Option，LCID，Par1，Par2

其中，Option选项可以为ADD（定义曲线）、DELE（删除曲线）、LIST（列表曲线）、PLOT（绘制曲线）；LCID为曲线编号；Par1和Par2为通过*DIM命令预先定义并赋值的自变量数组和因变量数组。当Par1和Par2的长度不同时，取较短的长度。

关于如何定义载荷曲线，这里举一个例子。

*DIM，TIME，ARRAY，5，1

*DIM，F1，ARRAY，5，1

TIME（1，1）=0.0，0.025，0.05，0.075，0.1

F1（1，1）=0.0，100，75，125，0.0

EDCURVE，ADD，1，TIME，F1

EDCURVE，PLOT，1

执行以上命令，得到如图4-38所示的荷载时间历程曲线。




图4-38　载荷时间历程曲线

EDLCS命令用于定义加载的坐标系，其一般格式为：

EDLCS，ADD，CID，X1，Y1，Z1，X2，Y2，Z2，X3，Y3，Z3

其中，CID为加载坐标系的ID；X1，Y1，Z1为加载坐标系的X轴上一点的坐标；X2，Y2，Z2为加载坐标系XY平面上的一点；X3，Y3，Z3为加载坐标系的原点在总体直角坐标系下的坐标。

（3）施加显式荷载

在ANSYSLS-DYNA中，荷载施加通过EDLOAD命令实现，其调用格式为：

EDLOAD，Option，Lab，KEY，Cname，Par1，Par2，PHASE，LCID，SCALE，BTIME，DTIME

其中，Option选项可以为ADD（施加荷载）、DELE（删除荷载）以及LIST（列表显示荷载）；Lab为荷载类型标识（见表4-16所列）；KEY选项对于Lab=PRESS时为面荷载作用的单元的面号，对其他荷载类型，则表示加载坐标局部坐标系（EDLCS命令所指定的CID），如果未指定局部坐标系，则荷载被施加到总体笛卡尔坐标系方向；Cname为加载的组元名称或刚体PART的ID；Par1，Par2为时间以及荷载数组名；PHASE为标识变量，取0，1，2分别表示在瞬态分析中使用、在应力初始化或动态松弛中使用以及两种情况下使用；LCID表示载荷曲线号（如指定LCID，则无需指定Par1和Par2）；SCALE为载荷缩放系数；BTIME，DTIME表示载荷的激活时刻与失效时刻。

如果采用界面交互操作方式，则与EDLOAD加载命令对应的菜单项目如下：

Main Menu>Preprocessor>LS-DYNAOptions>Loading Options> Specify Loads

Main Menu>Solution>Loading Options>Specify Loads

施加了显式分析载荷之后，可以通过EDFPLOT命令显示或隐藏荷载标志。EDFPLOT，ON表示显示载荷标志；EDFPLOT，OFF表示隐藏载荷标志。界面交互操作的菜单项目为：

Main Menu>Preprocessor>LS-DYNAOptions>Loading Options>Show Forces


4.3.2　计算选项设置

ANSYSLS-DYNA中计算选项设置包括时间步控制、求解选项设置和输出选项设置三个方面，相关命令列于表4-17中。

表4-17　分析设置相关的命令




下面对部分上述命令的选项进行简要的介绍，同时列出界面交互操作中对应的菜单或对话框。

1.时间步控制相关的命令

（1）TIME命令

TIME命令用于指定显式动力分析的结束时间，其参数列表如下：

TIME，TIME

界面交互操作对应的菜单路径为Main Menu>Solution>Time Controls>Solution Time。

（2）EDCTS命令

EDCTS命令用于指定质量缩放，其基本格式如下：

EDCTS，DTMS，TSSFAC

其中：DTMS为采用质量缩放的时间步长，如果DTMS为正，则所有的单元采用同样的时间步长，所有单元都进行质量缩放。如果DTMS为负，则仅对计算时间步长小于DTMS的单元进行质量缩放。TSSFAC为时间步的比例因子，一般去0.9，对高能炸药取0.67。

界面交互操作对应菜单项目为Main Menu>Solution>Time Controls>Time Step Ctrls。

（3）EDCSC命令

EDCSC命令用于在显式分析中打开子循环开关。界面交互操作对应的菜单路径为Main Menu>Solution>Time Controls> Subcycling。

2.求解选项设置相关的命令

（1）EDENERGY命令

EDENERGY命令用于控制。

在GUI中，通过菜单路径Main Menu>Solution>Analysis Options>Energy Options，弹出如图4-39所示对话框，设置分析过程的能量控制参数。




图4-39　能量控制选项

（2）EDBVIS命令

EDBVIS命令用于指定体积黏性参数，其格式为：

EDBVIS，QVCO，LVCO

QVCO和LVCO为二次黏性系数和线性黏性系数，缺省为1.5和0.06。

EDBVIS命令对应的菜单项目为：

Main Menu>Solution>Analysis Options>Bulk Viscosity

（3）EDHGLS命令

EDHGLS命令用于指定沙漏系数，其格式为：

EDHGLS，HGCO

HGCO为沙漏系数，缺省为0.1，大于0.5可能导致不稳定。

EDHGLS命令对应的菜单项目为：

Main Menu>Preprocessor>Loads>Load Step Opts>Other>Change Mat Props>Hourglass Ctrls>Global

Main Menu>Preprocessor>Material Props>Hourglass Ctrls>Global

Main Menu>Solution>Analysis Options>Hourglass Ctrls>Global

Main Menu>Solution>Load Step Opts>Other>Change Mat Props>Hourglass Ctrls>Global

（4）EDADAPT命令和EDCADAPT命令

自适应单元划分技术仅可用于薄壳单元（在ANSYSLS-DYNA中为SHELL163单元），通过EDADAPT命令来指定采用自适应网格剖分的壳单元部件（part），其格式为：

EDADAPT，PART，Key

其中，PART为部件号；Key=OFF为不适用自适应网格，Key=ON表示采用自适应网格。对所有PART缺省为OFF。

界面交互操作所对应的菜单项目为Main Menu>Solution>Analysis Options>Adaptive Meshing>Applyto Part。

通过EDCADAPT命令对采用自适应网格划分的部件指定网格划分选项，此命令的一般格式为：

EDCADAPT，FREQ，TOL，OPT，MAXLVL，BTIME，DTIME，LCID，ADPSIZE，ADPASS，IREFLG，ADPENE，ADPTH，MAXEL

其中，FREQ为在计算中考虑自适应网格划分的时间间隔，如0.1s；TOL为相邻单元倾斜角度的限值，超过了此值将进行网格的细分；OPT为算法选项，1表示倾斜角度基于初始构型，2表示基于前一次细分网格的构型；MAXLVL为细分级别，如2级细分可以将某一个单元分成4个单元；BTIME为计算中开始自适应网格的时间；DTIME为计算中结束自适应网格的时间；LCID为自适应时间间隔关于时间的数据曲线；ADPSIZE为相对于单元边长的最小细分尺寸；ADPASS为算法选项，0表示双通道自适应划分，1表示单通道自适应划分；IREFLG为统一细分级别，比如1、2、3分别表示所有的单元都被细分为4个、16个、64个单元；ADPENE为壳单元到达（此参数为正数）或穿透（为负数）加工表面时细化网格；ADPTH为壳单元厚度下限，厚度低于此数值开始自适应划分；MAXEL为最大单元上限，如果单元数超过此值就会停止计算。

EDCADAPT命令所对应的菜单项目为：

Main Menu>Solution>Analysis Options>Adaptive Meshing>Global Settings

（5）EDGCALE命令和EDALE命令

EDGCALE命令和EDALE命令用于指定总体ALE选项，其格式为：

EDGCALE，NADV，METH

NADV为输运步之间的循环次数；METH为输运算法选项，缺省为0，即采用Donorcell+Half Index Shift算法（一阶精度），设为1则采用Van Leer+Half Index Shift算法（二阶精度），对应的菜单项目为：

Main Menu>Solution>Analysis Options>ALEOptions>Define

EDALE命令用于设置ALE网格平滑选项，其格式为：

EDALE，Option，--，AFAC，BFAC，--，DFAC，EFAC，START，END

其中，Option缺省为ADD（定义选项）；AFAC为简单平均平滑权重因子（缺省为0）；BFAC为体积加权平滑权重因子（缺省为0）；DFAC为等势平滑权重因子（缺省为0）；EFAC为平衡平滑权重因子（缺省为0）；START和END为ALE平滑计算开始时间（缺省为0）和结束时间（缺省为1e20）。

要激活ALE算法，必须定义EDGCALE命令的NADV以及EDALE中至少一种平滑因子。

EDALE命令对应的菜单项目为：Main Menu>Solution>Analysis Options>ALE Options>Define

（6）EDTERM命令

EDTERM命令用于设置多条计算终止条件，其格式为：

EDTERM，Option，Lab，NUM，STOP，MAXC，MINC

其中，Option选项缺省为ADD（定义分析终止条件）；Lab选项可为NODE（节点）或者PART（刚体部件）；NUM选项为节点号（如果Lab域=NODE）或PARTID（如果Lab域=PART）；STOP选项为计算终止准则，可以为1（总体x方向），2（总体y方向），3（总体z方向），4（如果Lab=NODE，则指定点与其他表面发生接触时分析停止；如Lab=PART，则是刚性体位移到达某一特定位置时分析停止）；MAXC，MINC域表示选定节点坐标、选定的刚性体部件位移的最大以及最小值，其缺省值分别为±1.0e21。

EDTERM命令所对应的菜单项目为：

Main Menu>Solution>Analysis Options>Criteriato Stop

（7）EDCPU命令

EDCPU命令用于指定CPU时限CPUTIME，当计算达到限制时间将终止计算，其格式为：

EDCPU，CPUTIME

对应菜单项目为Main Menu>Solution>Time Controls>Analysis Options>CPULimit。

3.输出选项设置相关的命令

在求解之前，需要对计算结果文件的输出进行必要的设置：

（1）EDOPT命令

EDOPT命令用于指定计算文件输出的类型选项，其格式为：

EDOPT，Option，--，Value

其中，Option选项缺省为ADD（定义文件选项）。Value可选择ANSYS、LSDYNA或BOTH，选择ANSYS选项将计算输出ANSYS后处理的结果文件Jobname.RST和Jobname.HIS，可用ANSYS的后处理器POST1及POST26查看结果；选择LSDYNA选项将计算输出LS-DYNA格式的后处理结果文件D3PLOT和D3THDT，通过LS-PREPOST进行后处理；选择BOTH时，会同时输出ANSYS和LSDYNA格式结果文件。

界面交互操作对应的菜单路径为Main Menu>Solution>Output Controls>Output File Types。

（2）EDHIST命令

EDHIST命令用于指定时间历程文件包含的单元或节点的组元，其格式为：

EDHIST，Comp

Comp为用于时间历程输出结果的组元名称。

界面交互操作对应菜单路径为Main Menu>Solution>Output Controls>Select Component。

（3）EDRST命令

EDRST命令用于定义输出结果文件（D3PLOT文件）的频率或时间间隔，其格式为：

EDRST，NSTEP，DT

其中，NSTEP表示输出（NSTEP+2）步，DT表示输出的时间间隔。如果已经指定了NSTEP，则DT可以不填，缺省值为结果文件包含100个时步的计算结果。

（4）EDHTIME命令

EDHTIME命令用于定义D3THDT文件的输出的频率或时间间隔，其格式为：

EDHTIME，NSTEP，DT

NSTEP表示总共输出的步数，DT表示输出的时间间隔。如指定了NSTEP，则DT将被忽略，缺省值为时间历程文件包含1000个时步的计算结果。

（5）EDDUMP命令

EDDUMP命令用于定义重启动文件的输出间隔，其格式为：

EDDUMP，NUM，DT

NUM表示记录的重启动文件个数，DT表示输出的时间间隔。如指定了NUM，则DT将被忽略。

上述三条命令在GUI界面操作中对应着同一个对话框，如图4-40所示，此对话框可通过如下的菜单项来调用：

Main Menu>Solution>Output Controls>File Output Freq>Numberof Steps

Main Menu>Solution>Output Controls>File Output Freq>Time Step Size




图4-40　输出文件设置

（6）EDOUT命令

EDOUT命令用于指定输出的ASCII文件类型，常见ASCII文件类型中的信息列于表4-18中。

表4-18　ASCII输出文件及其内容




输出NODOUT和ELOUT文件时，需要先通过EDHIST命令定义节点或单元组元。如果需要输出所有上述ASCII文件，可用EDOUT，ALL命令。所有的ASCII文件，输出频率由EDHTIME命令所指定的输出步数或时间间隔所决定。

界面交互操作对应的菜单路径为：Main Menu>Solution>Output Controls>ASCII Output，在“ASCIIOutput”对话框中选择需要输出的ASCII文件类型，如图4-41所示。




图4-41　输出ASCII文件选项

（7）EDINT命令

EDINT命令用于指定SHELL和BEAM单元结果输出积分点个数，其格式为：

EDINT，SHELLIP，BEAMIP

其中，SHELLIP为SHELL输出的积分点个数，缺省为3个（top、middle、bottom），如果SHELLIP>3，则前SHELLIP层的结果将输出；BEAMIP为梁单元积分点输出个数，缺省为4个。界面交互操作对应的菜单路径为Main Menu>Solution>Output Controls>Integ Pt Storage。


4.3.3　关键字文件的导出

模型前处理、定义条件和分析设置等操作完成后，通过执行EDWRITE命令创建LS-DYNA求解器的输入文件，即LS-DYNA关键字文件。

EDWRITE命令的格式如下：

EDWRITE，Option，Fname，Ext

其中，Option为写入LS-DYNA关键字文件的结果文件类型选项，选择ANSYS选项表示要求输出ANSYS类型结果文件Jobname.rst和Jobname.his；选择LSDYNA选项表示要求输出LS-DYNA类型结果文件d3plot；选择BOTH选项表示同时输出ANSYS和LS-DYNA格式的文件。一般建议选择LS-DYNA类型，这样计算完成后可以通过LS-PREPOST后处理器进行结果的分析。Fname为输出的关键字文件名称。Ext为输出的关键字文件扩展名，对于一般分析为k，对于小型重启动分析为r。

EDWRITE命令所对应的菜单项目为：

Main Menu>Solution>Write Jobname.k

在ANSYSLS-DYNA中，可通过EDWRITE命令形成关键字文件而先不执行求解，再根据需要修改关键字文件，然后递交LS-DYNA计算程序求解。


第5章　ANSYSWorkbench前处理

本章介绍在ANSYSWorkbench环境下LS-DYNA显式结构分析前处理的实现过程，以Explicit Dynamics（LS-DYNA Export）系统的使用为主线，介绍Workbench中的相关组件Engineering Data、DM以及Mechanical的具体使用方法和操作要点。


5.1　Workbench环境与LS-DYNA前处理系统概述

ANSYSWorkbench是ANSYS开发的协同仿真平台，此平台集成有各种与多学科仿真分析任务相关的工程数据库、建模工具、网格工具、求解器以及后处理器等程序组件，同时提供参数管理和设计优化功能。Workbench还能够实现与CAD系统的参数共享及双向参数传递。启动Workbench后，其基本的界面布局如图5-1所示，此界面中最为重要的是左侧的Toolbox（工具箱）及右侧的Project Schematic（项目图解）这两个部分。




图5-1　Workbench的界面布局

Workbench界面左侧的Toolbox中列出了可以添加至项目图解（Project Schematic）区域中的所有系统，这些系统包括Analysis Systems（分析系统）、Component Systems（组件系统）、Custom Systems（用户系统）等类型。分析系统是Workbench预先定义的一系列标准化的分析系统，如：基于ANSYS的Static Structural静力分析系统、Modal模态分析系统，基于Fluent的Fluid Flow（Fluent）通用流体力学分析系统等，分析系统通常包含了完整的分析流程；组件系统则是一系列Workbench所集成的为完成特定分析任务的组件，这些组件可以单独使用，也可以组合成用户定义的系统。Workbench工具箱的组件系统中包含的Explicit Dynamics（LS-DYNAExport）系统，就是集成于Workbench环境中的LS-DYNA前处理组件系统，如图5-2所示。




图5-2　工具箱中的Explicit Dynamics（LS-DYNAExport）系统

在使用Explicit Dynamics（LS-DYNA Export）组件系统时，首先将其添加到项目图解（Project Schematic）区域，添加的方法可以是选择此系统然后双击鼠标左键，或选择此系统，按下鼠标左键拖放至项目图解区域的特定位置中，如图5-3所示。




图5-3　将Explicit Dynamics（LS-DYNAExport）系统拖放至项目图解

添加到项目图解中的Explicit Dynamics（LS-DYNAExport）组件系统如图5-4所示，此系统包含A1至A5等5个单元格。除A1单元格之外，Explicit Dynamics（LS-DYNAExport）组件系统的每一个单元格都与对应的组件程序相关联。A1为标题栏，显示此系统的名称；A2为Engineering Data单元格，对应Engineering Data组件，用于定义材料模型及参数；A3为Geometry单元格，对应几何建模组件（通常为ANSYSDesign Modeler），用于创建几何模型；A4为Model单元格，对应Mechanical前处理组件，用于创建分析模型（接触定义及网格划分等）；A5为Setup单元格，用于定义初始条件、荷载约束以及分析参数设置，这些操作也是在Mechanical组件中进行的。此外，组件系统最下方的名字区高亮度显示缺省的组件系统名称Explicit Dynamics（LS-DYNAExport），用户可以通过自定义修改显示的系统名称。




图5-4　项目图解中的Explicit Dynamics（LS-DYNAExport）系统

在任何一个Explicit Dynamics（LS-DYNAExport）组件系统中，数据都是从上面的单元格传递至下面的单元格，ANSYSWorkbench在每个单元格右方给出了一个可视化的单元格状态图标，便于用户快速做出判断。单元格的常见状态图标列于表5-1中。

表5-1　Workbench单元格的状态图标及其含义




Explicit Dynamics（LS-DYNAExport）组件系统的作用是为LS-DYNA求解进行前处理，完成建模并导出LS-DYNA输入文件（关键字文件）。通过Explicit Dynamics（LS-DYNA Export）组件系统进行前处理时，可以充分利用Workbench环境各组件操作直观的优势，显著提高效率，通过此系统形成的关键字文件与ANSYS传统界面前处理后通过EDWRITE写出的关键字具有完全相同的格式。Explicit Dynamics（LS-DYNAExport）组件系统目前支持的关键字如下：

（1）基本关键字

*KEYWORD

*TITLE

*END

（2）材料关键字

*MAT_ELASTIC

*MAT_HYPERELASTIC_RUBBER

*MAT_JOHNSON_COOK

*MAT_OGDEN_RUBBER

*MAT_ORTHOTROPIC_ELASTIC

*MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY

*MAT_PLASTIC_KINEMATIC

*MAT_RIGID

*EOS_GRUNEISEN

*EOS_LINEAR_POLYNOMIAL

（3）模型信息关键字

*NODE

*ELEMENT_BEAM

*ELEMENT_SHELL

*ELEMENT_SHELL_THICKNESS_OFFSET

*ELEMENT_SOLID

*SECTION_BEAM

*SECTION_SHELL

*SECTION_SOLID

*PART

（4）接触关键字

*CONTACT_AUTOMATIC_GENERAL

*CONTACT_AUTOMATIC_NODES_TO_SURFACE

*CONTACT_AUTOMATIC_SINGLE_SURFACE

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK

*CONTACT_ONEWAY_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK

*CONTACT_TIED_NODES_TO_SURFACE_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_OFFSET

（5）边界条件与约束关键字

*BOUNDARY_NON_REFLECTING

*BOUNDARY_PRESCRIBED_MOTION_NODE_ID

*BOUNDARY_PRESCRIBED_MOTION_RIGID_ID

*BOUNDARY_PRESCRIBED_MOTION_SET_ID

*BOUNDARY_SPC_SET

*CONSTRAINED_RIGID_BODIES

*CONSTRAINED_SPOTWELD

（6）初始条件及载荷关键字

*INITIAL_VELOCITY_GENERATION

*INITIAL_VELOCITY_RIGID_BODY

*LOAD_BODY_X

*LOAD_BODY_Y

*LOAD_BODY_Z

*LOAD_NODE_POINT

*LOAD_NODE_SET

*LOAD_RIGID_BODY

*LOAD_SEGMENT

（7）分析选项关键字

*CONTROL_ACCURACY

*CONTROL_BULK_VISCOSITY

*CONTROL_CONTACT

*CONTROL_ENERGY

*CONTROL_HOURGLASS

*CONTROL_SHELL

*CONTROL_SOLID

*CONTROL_TERMINATION

*CONTROL_TIMESTEP

*DAMPING_GLOBAL

*DATABASE_BINARY_D3PLOT

*DATABASE_BINARY_RUNRSF

*DATABASE_ELOUT

*DATABASE_FORMAT

*DATABASE_GLSTAT

*DATABASE_MATSUM

*DATABASE_NODOUT

*HOURGLASS

*INTEGRATION_BEAM

（8）辅助关键字

*DEFINE_COORDINATE_SYSTEM

*DEFINE_CURVE

*DEFINE_VECTOR

*SET_NODE_LIST

*SET_PART_LIST

*SET_SEGMENT

对于上面未列出的关键字，可以在写成的关键字文件中可进行手工添加，也可以通过在Mechanical组件中使用Commandsobjects分支（或被称为Keyword Snippet分支）的方式添加。


5.2　Engineering Data组件的使用

Engineering Data组件的作用是定义材料数据，双击系统中的A2单元格，即可进入到Engineering Data界面，Engineering Data材料数据界面由上方的菜单栏、工具栏以及如下的五个功能区组成，如图5-5所示。




图5-5　Engineering Data界面

在工具栏中有两个很重要的功能按钮，一个是漏斗形状的过滤按钮 
 ，按下这个按钮可以过滤掉与当前系统不相干的材料模型类型；另一个则是书本形状的材料库按钮 
 ，按下这个按钮表示通过由软件带有的材料库中选择材料模型类型，而不是由用户来定义材料类型。

Engineering Data的五个功能区分别为：


 Toolbox区域

位于界面的左侧，提供了Workbench支持的材料本构模型及参数类型，如：物性参数类型、线弹性材料、塑性材料等。


 Engineering Data Outline区域

此区域列出了当前分析系统中已经定义的材料名称，也可以在此区域最下方的“Click heretoaddanew material”区域创建新的材料名称。


 OutlineProperties区域

此区域显示Engineering Data Outline区域中所选择的材料模型的各种参数，如：密度、各种材料模型的参数等。


 Properties表格区域

此区域通过表格显示Engineering Data Outline区域选择的材料在Outline Properties区域所选择的材料特性数据。


 Properties图示区域

此区域通过曲线图形显示Engineering Data Outline区域选择的材料在Outline Properties区域所选择的材料特性数据。

在使用Engineering Data界面定义LS-DYNA显式动力学分析的材料时，一般采用用户定义材料模型并指定材料参数的方式，具体的操作步骤如下：

（1）定义材料名称

确认没有按下材料库按钮 
 ，在Outlineof Schematic A2：Engineering Data的“Click heretoaddanew material”提示区域定义新的材料名称并按回车确认。

（2）在Toolbox区域选择所需的材料数据类型，用鼠标左键拖至上述Outline区域用户新定义的材料名称上，这时在Propertiesof Outline区域就会出现添加的材料特性。这时需注意的是，有些材料模型需要首先定义一些物性参数，比如一些高温塑性模型需要比热参数，所有的显式分析材料模型都需要密度等。假如这些参数没有包含在材料的Properties中，用户直接添加材料类型时，Engineering Data也会自动添加相关的材料物性参数到材料类型中。比如：用户直接选择添加Toolbox>Plasticity下的Johnson Cook Strength材料模型到一个材料类型时，其Density和Specific Heat参数都被自动添加，如图5-6所示。




图5-6　添加Johnson Cook塑性材料模型

（3）在Propertiesof Outline区域中按照单位制的提示输入正确的材料参数完成材料定义，随后在Table以及Chart区域即通过表格或图形方式显示这些定义的材料Properties数据。完成材料的设置后，关闭Engineering Data界面，返回Workbench。

对于Explicit Dynamics（LS-DYNA Export）前处理系统的材料定义，下面作一些补充

说明。




对于前一节中提到的*MAT_RIGID关键字，不能在Engineering Data中指定，但是在后续Mechanical中当几何体被定义为Rigid时会自动输出。

状态方程关键字*EOS也无法在Engineering Data中指定，只能在Mechanical组件中通过Command Object的方式添加关键字片段以导出到k文件中。

对于线体（line bodies），可用的材料类型只有Isotropic Linear Elastic、Bilinear Kinematic Hardening Plasticity以及Rigidbodies。其他LS-DYNA求解器所支持的梁单元材料类型可以通过在Mechanical组件中添加关键字片段的方式实现。


5.3　建立几何模型


5.3.1　Design Modeler操作界面简介

几何模型可以通过任意的3D软件所创建并导入到Workbench中，也可采用Workbench中集成的几何建模工具ANSYSDesign Modeler（以下简称DM）进行几何建模和模型编辑。本节向读者介绍DM的几何建模方法。

在Workbench的项目图解中，选择Explicit Dynamics（LS-DYNA Export）系统的A3：Geometry单元格，右键菜单选择New Design Modeler Geometry，即启动DM，其界面如图5-7所示。

DM的界面由菜单栏、工具栏、Tree Outline/Sketching Toolboxes、Details View、Graphics（图形显示区域）以及下方的状态提示栏等部分所组成。

1.菜单栏

DM菜单栏包括File、Create、Concept、Tools、Unists、View以及Help等项目，其中：File菜单用于基本的文件操作；Create菜单用于创建3D对象特征（如：拉伸、旋转、蒙皮、倒圆、倒角、阵列）以及对象操作；Concept菜单用于线体以及面体的创建；Tools菜单包含了高级建模工具、模型修复工具、用户选项设置等工具；Units菜单用于指定建模的长度单位（如：Meter、Centimeter、Millimeter、Foot、Inch等）和角度单位（角度Degree或弧度Radian），如图5-8所示；View菜单用于修改显示设置；Help菜单用于获取帮助文件。




图5-7　Design Modeler界面




图5-8　建模长度和角度单位

需要注意的一点是，菜单操作实现的建模功能有很大的一部分可以通过工具栏快捷按钮实现。

2.工具栏

DM的工具栏众多，本节仅介绍三个最为常用的辅助工具栏，即：对象选择工具栏、图形控制工具栏以及图形显示工具栏。与建模操作相关的工具栏将在后面建模方法部分介绍。

（1）选择工具栏

对象选择工具栏如图5-9所示，选择工具栏按钮的基本功能列于表5-2中。




图5-9　选择工具栏

表5-2　选择工具栏基本功能




在DM操作过程中进行对象选择时有两种选择模式，即：Single Select点选模式和Box Select框选模式。框选时可以采用从左往右或从右往左拖动鼠标两种方式，第一种拖动方式只会选中全部位于选框中的特征，而后一种拖动方式则会选中全部或部分位于选框中的特征。在对象选择的操作中，使用对象类型过滤按钮以选择到正确的对象类型（点、边、面、体）。点选时如需多选，则按住Ctrl，然后用鼠标左键依次添加。要选择被其他对象挡住的对象时，可使用图像区域的左下角的选择方块功能，如图5-10所示，方块颜色对应于同色的对象，选择了颜色方块，就相当于选择到与之同色的对象。




图5-10　选择方块

（2）图形控制工具栏

DM中的图形控制工具栏如图5-11所示，图形控制工具栏中各按钮的基本功能列于表5-3中。




图5-11　图形控制工具栏

表5-3　图形控制工具栏功能简介




旋转工具主要用于模型的旋转操作，当鼠标位于图形显示窗口中的不同位置时，显示出的旋转图标会有所区别，如图5-12所示。




图5-12　旋转图标

当鼠标位于窗口中心附近 
 图标表示模型可以自由旋转；鼠标位于窗口拐角附近时 
 图标表示模型会绕垂直于屏幕的轴旋转；鼠标位于窗口左右两侧附近时 
 图标表示模型会绕竖直方向旋转；鼠标位于窗口上下两侧附近时 
 图标表示模型会绕水平方向旋转。

此外，在旋转、平移及缩放模式下，左键单击模型某处可设置模型的当前浏览或旋转中心（红点标记），单击空白区域则会将模型浏览或旋转中心置于当前模型的质心处，如图5-13所示。




图5-13　模型当前旋转中心

（3）图形显示控制工具栏

DM中的图形显示控制工具栏如图5-14所示，图形显示工具栏关于面颜色显示（Face Coloring）控制按钮的基本功能简介列于表5-4中。




图5-14　图形显示工具栏

表5-4　Face Coloring控制按钮功能简介




关于边颜色显示（Edge Coloring）的控制按钮基本功能简介列于表5-5中。

表5-5　Edge Coloring控制按钮功能简介




在DM中，面面之间有5种边连接类型，分别为Free、Single、Double、Triple、Multiple，其中Free代表这个边不属于任何面，Single意味着这个边仅属于一个面，其他类型以此类推。为了便于区分不同的边连接类型，在DM中以不同的颜色来表示，其对应关系见表5-6。

表5-6　边连接类型与颜色




此外，每种连接类型还有三个显示控制选项，分别为Hide（不显示）、Show（正常显示）和Thick（加粗显示），如图5-15所示为Show Double，即显示所有属于两个面的边。




图5-15　边显示控制选项


 按钮用于显示边的方向。利用该工具可以显示模型边的方向，方向箭头出现在边中点位置，箭头的大小与边的长度成正比，如图5-16所示。 
 按钮用于显示顶点。激活该工具可以高亮显示出模型中的所有点，可用于确保边的完整性，检查模型边是否被意外分割成多段，如图5-17所示。




图5-16　显示边方向




图5-17　显示顶点

3.建模树及草图工具箱

在DM中，3D建模操作大部分通过草绘和3D特征结合的方式实现，这类操作通过界面左侧的Tree Outline/Sketching Toolboxes面板、Details View面板并结合Generate按钮完成，建模操作结果在Graphics（图形显示区域）中显示。

默认情况下DM中激活的是建模模式，此时显示出模型的建模历史树（Tree Outline）。结构树给出了模型的整个建模历史，用户可以从中获取建模信息，并利用右键快捷菜单对模型进行修改或其他操作（比如插入新特征、抑制或删除模型等），如图5-18所示。




图5-18　结构树及右键快捷菜单

要注意一点，在DM中，当建模历史树的某个对象名称分支前面出现一个黄色的闪电标志时，需要通过按下工具栏上的Generate按钮 
 以更新相应的特征分支。实际上，DM中大部分的操作都需要通过按下这一按钮才能完成。

单击结构树面板下方的Sketching/Modeling标签，可由建模模式切换至草图模式进行草图绘制，草图工具箱（Sketching Toolboxes）中一共包含5个子工具箱，如图5-19所示，其名称及基本功能的描述列于表5-7中。




图5-19　草图工具箱

表5-7　草绘工具箱及其功能




草绘都是存在于某一个特定平面上的，要创建草绘，首先要指定新草绘所在的平面。缺省的平面有三个，即XYPlane、ZXPlane、YZPlane，可以根据需要通过工具栏上的新建平面按钮 
 新建平面，新建平面可以是基于已有平面或已有对象，相关的属性在DetailsView中设置，相关方法请参考DM用户手册。通过新建平面按钮旁边的已有平面列表，可以选择当前平面。选择了平面后，切换至 
 sketch模式即可创建草图。一个平面上可以有多个草图，通过工具栏上的新建草图按钮，可以在平面上创建新草图。在新建草图按钮旁边的列表中，可以选择当前平面上的草图。在sketch模式下，可以绘制各种2D形状，并进行尺寸标注。

4.Details栏

Details栏中列出了当前选择模型树特征或草图的具体信息和设置选项，用户可在此处输入所选特征或草图的数据完成建模操作或对已有几何进行编辑修改。此外，参数化建模也是通过在此区域选择变量并提升参数来实现的。

5.状态栏

状态栏位于DM操作界面的最下方，其中显示了几何建模的状态或建模操作提示信息，有助于用户正确地完成建模操作，如：界面左下角显示了操作提示信息，界面的右下角则显示了选择对象的类型、数量、特征（如：长度、面积等）、单位制以及坐标（草绘模式下）。


5.3.2　在DM中创建几何模型

在DM中可以创建几何体类型包括线体、面体、实体三种，这些几何体可以在后续导入显式前处理组件中。本节首先介绍DM建模的一些基本概念，随后介绍在DM中创建各种几何体的操作方法和要点。

1.DM的若干基本概念

在DM中包括三种不同类型的体，即：线体、面体、实体。

线体即Line Body，这类体仅包含边，没有面和实体，可定义有截面信息，如图5-20（a）所示；面体即Surface Body，这类体由表面所组成，不包含实体，需定义厚度信息，如图5-20（b）所示；实体即Solid Body，这类体由表面和实体所组成，如图5-20（c）所示。




图5-20　体的类型

DM中的体均以两种状态之一存在，即：激活状态（Active）或冻结状态（Frozen）。激活体会和其他的体在有接触或交叠的部分自动合并，而冻结的体则会保持独立。引入冻结体的作用在于：一方面有助于网格划分，对多个拓扑简单的几何体进行划分比对一个大型的复杂的模型进行划分更加高效；另一方面也便于实施与求解相关的设置，比如施加边界条件、指定不同体的物料属性等。如图5-21所示，在大圆柱体表面拉伸形成小圆柱体，如果采用缺省设置时会添加材料，于是生成的小圆柱体与大圆柱体合并成一体；如果选择生成冻结的体，则生成的小圆柱体将不与大圆柱体合并，共有两个实体，如图5-22所示。




图5-21　Add Material生成激活体




图5-22　Add Frozen生成冻结体

要注意，在DM中的体仅当处于冻结状态才能进行切片操作（Create>Slice菜单）。要冻结模型，选择Tools>Freeze菜单，然后点工具栏上的Generate按钮。要解冻模型，则选择Tools>Unfreeze菜单，然后点Generate按钮。

区别于上面的激活和冻结状态，DM中的几何体可以是可视的（Visible）、隐藏的（Hidden）以及被抑制的（Suppressed）。当一个体被抑制后，它将不能被传递至后续前处理组件中用于分析，也不能被导出为其他格式的文件。

默认情况下，DM会将每一个体自动放入一个部件（Part）中，也就是所谓的单体部件。部件之间的网格划分是分别进行的，在体的交界面上网格不连续。用户也可以在图形窗口中选中需要共享拓扑的体，然后利用右键快捷菜单中或Tool菜单下的“Form New Part”来创建多体部件，即一个部件中包含多个体。当需要修改多体部件中体的组成时，可以在结构树中单击Part，利用其右键菜单中的“Explode Part”解除多体部件，然后根据需要重新生成新的多体部件。需要注意的是，本节中的Part与LS-DYNA关键字中的PART是完全不同且无关的概念，本节的部件仅仅是几何体层次的一种组合。

下面以一个简单的例子来介绍单体部件与多体部件之间的区别。

情况一：1Part，1Body，一个部件中包含一个体，网格划分对象是一个实体，不存在体与体的交界面问题，如图5-23所示。




图5-23　1Part，1Body网格划分

情况二：3Parts，3Bodies，三个部件三个体，每个部件单独划分网格，相邻体交界面处不作处理，各体之间网格不连续，如图5-24所示。




图5-24　3Parts，3Bodies网格划分

情况三：1Part，3Bodies，一个部件3个体，部件内体之间在交界面上网格连续，如图5-25所示。




图5-25　1Part，3Bodies网格划分

在网格划分时，相邻体之间会根据“Shared Topology Method”（共享拓扑）的设定方式来处理交界面网格。当DM中的多个体构成多体部件时，体与体之间会发生共享拓扑行为，一般情况下，各个体在相互接触的区域会形成连续的网格，无需在导入Mechanical前处理组件后再通过建立接触对来构建各体之间的关联。图5-26（a）中的两个面体分属于两个部件，网格分别划分，交界线上网格不连续，在Mechanical组件中需要通过创建接触对来建立两个面体之间的关联；而图5-26（b）中的两个面体则同属于一个部件，在交界线上发生了共享拓扑行为，划分网格后交界线上共享节点，无需创建接触。

多体部件形成后，在DM中并不会立即共享拓扑，只有模型被导出DM或添加“Share Topology”工具条后部件内各体之间才会发生共享拓扑行为。常见的共享拓方法（Shared Topology Method）有以下几种：

（1）Edge Joints

Edge Joints能够将DM检测到的成对边合并到一起。它可以在创建Surfaces From Edges和Lines From Edges特征时自动生成，也可以通过Joint特征生成。




图5-26　共享拓扑

（2）Automatic

Automatic法利用通用布尔操作技术使多体部件内各体之间共享拓扑，当模型导出DM时各体之间的所有公用区域都会被共享处理。

（3）Imprints

严格地说，Imprints法并没有使得部件内各体之间共享拓扑，而只是生成了印记面，经常被用于需要精确定义接触区域的情形。

（4）None

None法没有实质上的共享拓扑，也没有印记面生成，仅仅起到了归类的作用。利用该法可以重新组织模型结构，比如可以将需要相同网格划分方法的所有体形成多体部件，以便于在Mechanical中施加网格划分控制。

共享拓扑方法会随着部件内体的类型以及分析类型而有所不同，部件类型与可用的共享拓扑方法列于表5-8中。

表5-8　部件类型与共享拓扑方法




多体部件的共享拓扑方法可以在多体部件的Details中进行更改，如图5-27所示，由于此多体部件全由面体所组成，因此可以看到其共享拓扑方法有Edge Joints、Automatic、Imprints、None四种。

2.DM实体建模的方法

DM的3D实体建模有两种方式，一种方式是快速创建基本几何体素，另一种方式是基于草绘和3D特征。基于草绘的建模方法更为常用。

基于3D基本体素建模时，通过Create>Primitives菜单创建各种3D基本体素，如：球体、方块、平行六面体、圆柱体、圆锥体、棱柱体、金字塔、圆环体、矩形环体等9种基本形状，如图5-28所示和图5-29所示。




图5-27　多体部件Details




图5-28　Primitives菜单




图5-29　各种基本几何体素示意

上述几何体素在创建时通常需要在Details中定义相关的点和方向，设置完成后选择按下工具栏中的Generate按钮 
 实现体的创建。

基于sketch（草绘）和3D特征建模时，首先绘制二维的sketch，然后基于草绘添加3D特征，在Details中设置相关选项和参数，设置完成后选择按下工具栏中的Generate按钮 
 实现体的创建。下面介绍几种常用的3D特征。

（1）Extrude拉伸

Extrude是将草图或几何特征进行拉伸生成体的过程。在Extrude Details中，用户需要指定拉伸的基准几何（Geometry）、模型处理方式（Operation）、拉伸向量（Direction Vector）、拉伸方向（Direction）、拉伸类型（Extend Type）、输入拉伸距离（Extrude Depth）、是否作为薄壁件/面体（As Thin/Surface?）、是否合并拓扑（Merge Topology）等，如图5-30所示。

下面将就其中部分选项进行介绍。

Operation

Addmaterial：创建新材料，如果与模型中激活的体接触或交叠，则会合并为一体；

Add Frozen：创建冻结体，不会与已有体合并；

Cut Material：从激活体上切除材料；

Imprint Faces：在激活体表面上形成印记面；

Slice Material：将冻结体分给成多块，如对激活体分割，则激活体会自动冻结。

采用不同Operation设置时的拉伸特征效果如图5-31所示。




图5-30　Extrude Details




图5-31　不同Operation设置的拉伸特征

Direction

DM中拉伸方向类型有以下几种：

Normal：垂直于拉伸平面；

Reverse：与Normal方向相反；

Both—Symmetry：两个方向同时对称拉伸，有相同的拉伸深度；

Both—Symmetry：两个方向同时拉伸，每个方向可单独定义拉伸特性。

Extend Type

DM中的延伸类型有以下几种，不同延伸类型的拉伸效果如图5-32所示：

Fixed：按指定的拉伸深度延伸一定距离；

Through All：拉伸特征会通过整个模型；

To Next：延伸至遇到的第一个表面；

To Faces：延伸至由一个或多个面形成的边界；

To Surface：延伸至一个表面（考虑表面延伸）。




图5-32　拉伸特征的不同延伸类型

As Thin/Surface?

在DM中，通过修改拉伸特征中As Thin/Surface?的设置可以生成薄壁实体结构或面体，如图5-33所示。




图5-33　As Thin/Surface?的拉伸效果

Merge Topology?

在DM中，该选项会影响特征生成时的拓扑处理方式。选择Yes时，程序会自动优化特征拓扑，选择No时，不对特征拓扑作任何处理，如图5-34所示。




图5-34　Merge Topology?的拉伸效果

（2）Revolove旋转

Revolove是将草图或几何特征沿着旋转轴进行旋转生成体的过程。在Revolove Details中，用户需要指定旋转的几何（Geometry）、模型处理方式（Operation）、旋转轴（Axis）、拉伸方向（Direction）、旋转角度（FD1，Angle）、是否作为薄壁件/面体（As Thin/Surface?）、是否合并拓扑（Merge Topology?）等，如图5-35所示。




图5-35　Revolove Details

在下面的旋转特征实例中，旋转几何为面体上的圆孔边线，旋转轴为面体某一矩形边，旋转角度为90°，如图5-36所示。




图5-36　基于面体边线生成新的旋转特征

（3）Sweep扫略

Sweep是将草图或几何特征作为轮廓，然后沿着路径扫略生成体的过程。在Sweep Details中，用户需要指定扫略的轮廓（Profile）、扫略路径（Path）、模型处理方式（Operation）、对齐（Alignment）、定义缩放比例（FD4，Scale）、螺旋定义（Twist Specification）、是否作为薄壁件/面体（As Thin/Surface?）、是否合并拓扑（Merge Topology?）等，如图5-37所示。




图5-37　Sweep Details

下面将就其中部分选项进行介绍：

Alignment

默认情况下，Alignment选项为Path Tangent，扫略时程序会重新定义轮廓的朝向以保持其与路径一致；当Alignment选项改为Global Axes后，扫略执行过程中不会考虑路径的形状，轮廓朝向始终不变，如图5-38所示。

FD4，Scale

若扫略时需要对轮廓进行缩放，可以通过修改FD4，Scale值（默认取值1，表示不缩放）实现。当其值大于1时，扫略轮廓逐渐变大；当其值小于1时，扫略轮廓逐渐变小，如图5-39所示。




图5-38　Sweep Alignment




图5-39　Sweep Scale

Twist Specification

默认情况下，该选项为No Twist，当该选项为Turns或Pitch时，用户可通过输入圈数或间距来定义螺旋扫略。在下面实例中，扫略轮廓为圆环，扫略路径为曲线，定义旋转参数为6，生成的实体如图5-40所示。

（4）Skin/Loft蒙皮/放样

Skin/Loft是将不同平面上一系列的轮廓进行拟合生成三维实体的过程。在Skin/Loft工具的Details中，用户需指定轮廓旋转方法（Profile Selection Method）、轮廓（Profiles）、模型处理方式（Operation）、是否作为薄壁件/面体（As Thin/Surface?）、是否合并拓扑（Merge Topology?）等，如图5-41所示。




图5-40　螺旋扫略实例




图5-41　Skin/Loft Details

需要注意的是，在进行蒙皮/放样时，用户至少需要选择两个草图轮廓，且各轮廓要求具有相同数量的边。在下面的实例中，蒙皮/放样轮廓为3个六边形，剩余线为蒙皮/放样的导航线，如图5-42所示。




图5-42　蒙皮/放样实例

（5）Thin/Surface抽壳

利用Thin/Surface特征可将实体转化成薄壁实体或面体。在Thin/Surface Details中，用户需要指定几何特征选择方式（Selection Type）、选择的几何（Geometry）、抽取方向（Direction）、抽取厚度（FD1，Thickness）等，如图5-43所示。




图5-43　Thin/Surface Details

下面将就其中部分选项进行介绍：

Selection Type

Selection Type中包含三种方法，分别为：

Facesto Remove：去除实体上被选中的面；

Facesto Keep：保留实体上被选中的面，剩余面被去除；

Bodies Only：针对选中的体实行Thin/Surface操作，不会去除任何面。

对一个六棱柱体进行Thin/Surface操作，采用不同Selection Type抽取的实体如图5-44所示。其中采用Bodies Only方式的实体内部被抽空，成为一个薄壁空心实体。




图5-44　不同Selection Type的Thin/Surface

Direction

Direction属性定义了Thin/Surface操作生成实体/面时的偏移方向，包括Inward、Outward和Mid-plane三种方式。图5-45给出了采用Mid-plane方式抽取的薄壁实体，从中可以看出所选面边线两边的实体厚度一致，但这并不意味着它等同于中面抽取，关于中面抽取的内容将在后续章节中介绍。

FD1，Thickness

当FD1，Thickness大于0时，其值表示Thin/Surface操作后生成的薄壁实体的厚度；当其值为0时，表示最后生成的是面体，如图5-46所示。




图5-45　Mid-plane方式




图5-46　Thin/Surface生成面体

（6）Fixed Radius Blend




该工具用于创建固定半径的倒圆角，倒圆角的对象可以是3D边或面，如图5-47所示。




图5-47　创建Fixed Radius Blend




该工具用于创建具有变化半径的倒圆角，倒圆角对象为3D边，此外还需要输入边线两端的圆角半径，圆角过渡方式有Smooth和Liner两种，如图5-48所示。




图5-48　创建Variable Radius Blend

（8）Vertex Blend

该工具用于在实体、面体或线体的点处创建倒圆角，选中点后再指定倒圆角半径即可，如图5-49所示。

（9）Chamfer

该工具用于创建倒直角，倒直角对象为3D边或面，此外还有Left-Right、Left-Angle、Right-Angle三种方法用于倒直角，如图5-50所示。

（10）Pattern阵列

该工具允许用户创建以下三种类型的面或体的阵列：

线性阵列（Linear）：指定阵列方向、偏移距离及拷贝数量；




图5-49　创建Vertex Blend




图5-50　创建Chamfer

环形阵列（Circular）：指定阵列轴、角度及拷贝数量；

矩形阵列（Rectangular）：指定两个阵列方向、各个方向的偏移距离及拷贝数量。

阵列的一些典型应用实例如图5-51所示。




图5-51　各种阵列类型

（11）Body Operation体操作

该工具提供了11个选项用于对体的操作，这些选项包括：Mirror（镜像）、Move（移动）、Delete（删除）、Scale（缩放）、Simplify（简化）、Sew（缝合）、Cut Material（切除材料）、Imprint Faces（印记面）、Slice Material（切分材料）、Translate（平移）及Rotate（旋转）。

Mirror

选择一个平面作为镜像面，利用该工具即可创建所选体的镜像体，镜像过程中可以控制是否保留原体。需要注意的是，如果被所选体是激活体，且与镜像后的体有接触或交叠，两者会自动合并成一体。图5-52所示的镜像实例中就发生了体合并行为。




图5-52　Mirror

Move

利用该工具可以通过平面（By Plane）、点（By Vertices）及方向（By Direction）三种方式将体移动到合适的位置。

这里仅介绍By Plane方式。利用该方式进行体移动时，需要选中待移动的体、源面、目标面，单击Generate后DM就会将所选体从源面移动至目标面，该方式非常适用于导入或探测进入DM的体的定向，如图5-53所示。




图5-53　Move By Plane

Delete

该工具用于模型中体的删除操作。

Scale

该工具用于对模型进行缩放，缩放时需要指定缩放中心及缩放比例，其中缩放中心有World Origin（世界原点）、Body Centroids（体的重心）及Point（自定义点）三个选项。

Simplify

该工具有几何简化和拓扑简化两个功能。利用几何简化可以尽可能简化模型的面和曲线以生成适于分析的几何，该功能默认是开启的；利用拓扑简化可以尽可能地去除模型上多余的面、边和点，其默认也是开启的。

Sew

利用该工具可以将所选面体在其公共边（一定容差范围内）上缝合在一起，需要注意的是如果在其Details中将Create Solids设置为Yes，缝合后DM会将封闭的面体转换成实体。

Cut Material

利用该工具可以从模型激活体中切除所选体，所选体为切割工具，如图5-54所示。




图5-54　通过Cut Material生成模具

Imprint Faces

利用该工具可以在模型激活体上生成所选体的印记面，如图5-55所示。




图5-55　通过Imprint Faces生成印记面

Slice Material

该工具将所选体作为切片工具并对其他体进行切片操作，如图5-56所示。




图5-56　对长方体进行Slice Material

Translate

利用该工具可将所选体沿着指定方向进行平移。

Rotate

利用该工具可将所选体绕着指定轴旋转一定的角度。

（12）Boolean布尔运算

利用Boolean操作可以对体进行Unite（相加）、Subtract（相减）、Intersect（相交）以及Imprint Faces（印记面）操作，这些体可以是实体、面体或线体（仅能加操作）。不同的Boolean操作类型如图5-57所示。




图5-57　Boolean的各种操作

（13）Slice切片

利用Slice可以对体进行切割，从而构建出可划分高质量网格的体或对线体指定不同的截面属性。Slice操作完成后激活体会自动变成冻结体。通过Create>Slice菜单可向建模历史树添加Slice对象。在Slice对象的Details中可以看到有如下五个Type选项。

Sliceby Plane：模型被选中的平面分割；

Slice Off Faces：选中的面被分割出来，并由这些面生成新的体；

Sliceby Surface：模型被选中的表面分割；

SliceOff Edges：选中的边会被分割出来，并由这些边生成新的线体；

Sliceby Edge Loop：模型被由选中边形成的闭合回路分割。

（14）Face Delete

利用该工具可以删除模型中不需要的凸台、孔、倒角等特征，如图5-58所示。

在Face Delete Details中提供了如下的集中模型修复设置选项：

①Automatic：首选尝试Natural Healing修复方式，如果失败再采用Patch Healing修复方式；

②Natural Healing：自然延伸周围几何至遗留“伤口”被覆盖；

③Patch Healing：通过所选面周围的边生成一个面用于覆盖“伤口”区域；

④No Healing：用于面体修复的专用设置，直接从面体中删除所选面不进行任何修复。




图5-58　Face Delete倒圆角、凸台及凹槽

（15）Edge Delete

利用该工具可以删除模型中不需要的边。它经常被用于去除面体上的倒角、开孔等，也可以用于处理实体和面体上的印记边，如图5-59所示。




图5-59　Edge Delete

3.DM概念建模的方法

DM提供的概念建模工具可以用于线体及面体的创建、3D曲线的创建、分割边及定义横截面等，这些工具集中在Concept菜单中，下面将逐个对其进行简单的介绍。

（1）创建线体

Concept菜单中有Lines From Points、Lines From Sketches和Lines From Edges三种方法用于线体的创建。

① Lines From Points

由点生成线体，这些点可以是2D草图点、3D模型点或点特征生成的点。

② Lines From Sketches

由草图生成线体，该方法可以基于草图或表面平面生成线体。

③Lines From Edges

由边生成线体，该方法可基于已有2D或3D模型的边界创建线体。

（2）Split Edges

利用分割边工具可以将边（包括线体边）分割成多段，可选的分割方法有以下四种：

Fractional：比例分割；

Splitby Delta：通过沿着边上给定的Delta确定每个分割点间的距离；

Splitby N：按段数分割；

Splitby Coordinate：通过坐标值分割。

（3）创建3DCurve

3D曲线工具允许用户基于已存在的点或坐标创建线体，这些点可以是任意2D草图点，3D模型点或Point工具生成的点，坐标则可以从文本文件中读取。

坐标文件必须符合一定的格式才能被DM读取并正确识别，它由5部分内容组成，每部分通过空格或Tab键分隔开来，各部分基本内容如下：

a.Groupnumber（整数）

b.Pointnumber（整数）

c.Xcoordinate

d.Ycoordinate

e.Zcoordinate

下面给出一个封闭曲线（末行Pointnumber为0）的文件实例：

Group1（closedcurve）

11100.0101200.202115.1515

12-12.3456.8765-.9876

1311.123412.432113.5678
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（4）创建面体

Concept菜单中有Surfaces From Edges、Surfaces From Sketches和Surfaces From Faces三种方法用于线体的创建。

①Surfaces From Edges

由边生成面体。该方法可以利用已存在的体的边线（包括线体的边）作为边界生成面体，且边线必须组成一个非相交的封闭环，如图5-60所示。




图5-60　Surfaces From Edges

②Surfaces From Sketches

从草图创建面体。该方法利用草图（单个或多个）作为边界创建面体，草图必须闭合且不相交。

③Surfaces From Faces

从表面创建面体。该方法可以利用已存在实体或面体的面生成新的面体，如图5-61所示。

（5）横截面

横截面作为一种属性可被赋予线体，并在导入Mechanical组件后成为梁的截面属性。DM提供了一系列横截面类型，用户可以通过Concept>Cross Section定义截面类型及相关尺寸，可选择的截面类型如图5-62所示。选择了特定的截面类型后，即进入截面编辑环境，用户可以输入各种预定义的截面尺寸定义梁的截面，如图5-63所示为一工字型截面的参数及截面坐标系示意图。




图5-61　Surfaces From Faces




图5-62　可选择的截面类型




图5-63　截面编辑界面

各种预先定义的截面类型如图5-64所示。

如选择“User Integrated”截面类型，则用户需要直接在Details View中输入梁的截面参数；如选择“User Defined”截面类型，则需要切换至sketch视图下，直接通过创建草图的方式形成截面，这类截面的几何特性参数直接由程序自动计算得出。

当线体被赋予横截面后，用户需要定义横截面的方向，也就是定义Y的朝向。DM中有两种方式可以对横截面进行对齐操作，分别为：




图5-64　各种预定义横截面类型

（1）选择现有几何体（点、线、面等）作为对齐参照对象；

（2）通过矢量输入的方式定义对齐方向。


5.3.3　导入外部几何模型并进行编辑

除了直接基于DM创建几何模型外，还可以导入外部的几何模型并对其进行编辑。对于已经存在的其他格式的CAD模型，仅需将其导入至DM，然后进行编辑、简化、修复即可用于建模。本节介绍外部模型导入的方法和DM高级几何编辑功能的使用。

1.导入外部模型

（1）关联激活的CAD几何

利用File>Attachto Active CADGeometry操作，DM程序会探测当前已打开CAD系统中的文件（已保存）并将其导入至DM中。进行关联时有以下属性设置：

①Source Property

DM可以自动探测计算机中的当前激活CAD系统，用户可以通过修改Details中的Source Property项来选择可被探测的CAD程序。比如存在多种CAD程序时，该设置尤为重要。

②Model Units Property

当其他CAD模型没有单位时，DM会提供一个Model Unitsproperty项供用户设定导入几何模型的单位，默认情况下该设置与DM单位一致。

③ Parameter Key Property

Details中的Parameter Key Property项用于供用户设置几何模型参数的关联关键字，默认关键字为“DS”，意味着只有名称中包含“DS”的参数才能被关联至DM；如果该选项无输入，则表示所有参数都能被关联至DM。此外，建议赋予每个CAD参数唯一的名称，且不以数字作为参数名的开头字符。

④Material Property

通过设置Material Property可以控制几何模型的材料属性的导入与否。目前支持材料属性传递的程序有Autodesk Inventor、Creo Parameter和NX等。

⑤Refresh Property

当几何被探测关联至DM中后，允许用户在其他CAD系统中继续对几何模型进行编辑。将Refresh Property设置为Yes后，即可通过刷新操作实现CAD系统与DM中几何的双向更新。

⑥Base Plane Property

该项用于进行Attachto Active CADGeometry操作时指定用于几何模型定位的基准面。

⑦Operation Property

该项用于控制关联几何模型至DM后是否进行合并。

⑧Body Filtering Property

该项用于控制可导入至DM中几何体的类型，用户需要在项目图解窗口中进行设置，默认情况下允许导入实体和面体，不允许导入线体。进行Attachto Active CADGeometry操作时，仅支持Creo Parametric、Solid Edge和Solid Works中的线体的导入，NX面体厚度的导入。

（2）导入外部几何文件

File>Import External Geometry File专用于外部几何模型的导入，比如ACIS（.sab和.sat），Blade Gen（.bgd），GAMBIT（.dbs），Monte Carlo N-Particle（.mcnp），CATIA V5（.CADPart和.CATProduct），IGES（.igs或.iges），Parasolid（.x_t和.xmt_txt；.x_b和.xmt_bin），Spaceclaim（.scdoc），STEP（.step和.stp）等。该操作可在DM建模的任意时刻进行，支持材料导入的CAD系统有Autodesk Inventor、Creo Parameter和NX。

与关联几何文件的属性设置类似，导入外部几何文件时也有相关的属性设置，此处仅就Body Filtering Property进行介绍。

进行外部文件导入时，除了Solid Bodies、Surface Bodies和Line Bodies三个主过滤器外，还包括混合体的导入过滤器，即Mixed Import Resolution。该过滤器主要用于控制多体部件（包含多种自由度）中体的导入，其设置包括None，Solid，Surface，Line，Solidand Surface，Surfaceand Line等六项。取默认设置None时，意味着多体部件（包含多种自由度）中的任何体都不会被传递至Mechanical中，其他设置以此类推。需要注意的是，该选项的优先级低于主过滤器。

2.DM几何高级编辑功能的使用方法

在几何编辑方面，除了前面介绍的Body Operation（体操作）系列功能外，DM的Tool菜单中还提供了一些高级特征工具，利用这些工具用户可以完成模型操作、修改及修复等操作。下面将对其中部分高级特征工具进行简要介绍。

（1）Merge

该工具用于合并边或面，对于网格划分准备工作时的模型简化非常有用。图5-65即为边合并及面合并的实例。




图5-65　Merge

通过菜单Tools>Merge，可以对模型中的线段和面进行合并，以简化模型的几何特征。Merge操作的选项如图5-66所示，可选择操作对象为Edges或Faces。




图5-66　Merge操作选项

（2）Mid-Surface

对于壁很薄的实体模型，可以利用该工具抽取中面，后续可用板壳单元进行分析。图5-67所示结构通过中面抽取操作后生成了中面模型。




图5-67　中面抽取

通过菜单Tools>Mid-Surface可在建模历史树中添加抽取中面对象，其属性设置如图5-68所示。进行中面抽取时，用户可以手工选择面对，也可以在指定厚度范围后由程序自动选择。对于两个薄板垂直或斜交的情况，在抽取中面后，底板的中面和立板根部之间会形成一个缝隙，此缝隙的宽度为底板厚度的一半。通过菜单Tools>Surface Extension在模型中插入表面延伸，可实现延伸填补缝隙，保证几何连续。




图5-68　Mid-Surface选项

（3）Enclosure

利用该工具可以在体附近创建包围体生成外流场，包围体的形状可以是Box、Sphere，Cylinder或其他用户自定义形状。包围体实例如图5-69所示。




图5-69　包围体

（4）Fill

利用该工具可以创建体内的填充体作为内流场。抽取内流场的方法有以下两种：

By Cavity：通过孔洞填充，该法要求选中所有被“浸湿”的表面；

By Caps：覆盖填充，该法要求创建入口及出口封闭表面体并选中实体。

在图5-70的Fill实例中，（a）By Cavity中需要选择内部4个侧面及1个底面，（b）By Caps中则需要创建换热管的入口表面和出口表面，然后选择换热管实体。

（5）Surface Extension

该工具主要用于表面体的延伸操作。进行面延伸时，用户可以选择手动方式，也可以指定间隙值后由程序自动搜索符合条件的延伸区域并进行延伸。此外，DM还提供了以下几种延伸长度（方式）供用户使用：




图5-70　Fill的使用

Fixed：面体会按照给定距离进行延伸；

To Faces：面体会延伸至面的边界；

To Surface：面体会延伸至一个面；

To Next：面体会延伸至第一个遇到的面；

Automatic：延伸所选面体上的边至面的边界面。

一些面延伸实例，如图5-71所示。




图5-71　Surface Extension

（6）Surface Patch

该工具用于填充面体上的孔洞或间隙。

通过菜单Tools> Surface Patch，可在模型中插入表面修复选项，用于填充面体上的小孔等缺陷，其在Details View中的设置属性如图5-72所示，可以选择自然修复以及片修复两种修复方法。

（7）Surface Flip

该工具用于倒置面体的法向。

（8）Projection




图5-72　Surface Patch选项

该工具可将点投影至边或面、边投影至面或体上。DM中提供了4种投影类型，分别为：

EdgesOn Body Type：边投影至面体或实体；

EdgesOn Face Type：边投影至面；

PointsOn Face Type：点投影至面；

PointsOn Edge Type：点投影至3D边。

（9）Joint

通过菜单Tools>Joint，用于在模型中加入Edge结合选项，此选项用于对不同表面体的相邻边进行连接。可以通过View>Edge Joints查看模型边的结合情况，蓝色表示Edge已经与其他相邻的Edge实现连接，红色则表示Edge的连接存在拓扑方面的错误。

DM几何建模结束后，关闭DM界面，返回Workbench的Project Schematic界面下，这时发现DM所对应的Geometry单元格状态变为绿色的√，表示几何组件已经更新完成。


5.4　建立分析模型

在Workbench环境中，建立LS-DYNA显式分析模型是在Mechanical组件中进行的。为此，本节首先介绍Mechanical组件的界面和基本使用，然后介绍创建LS-DYNA显式动力学计算模型的方法。

在Workbench的Project Schematic页面，双击Explicit Dynamics（LS-DYNAExport）组件系统的“Model”单元格，即可启动Mechanical组件的操作界面。Mechanical的操作界面如图5-73所示。Mechanical的界面由菜单栏、工具栏、Outline面板、Details View面板、图形显示区以及Graph/Animation/Messages、Tabular Data等功能区域组成，界面的最下方还有一个操作提示栏及状态信息栏。

Mechanical界面操作的核心在于Outline区域的“Project”树，其基本操作逻辑为：在“Project”树中选择或插入不同的分支，在“Details View”区域设置各分支的属性，操作过程中可根据需要在Tabular Data中定义相关的表格参数，Graph区域会以曲线形式显示表格或结果数据，执行相关操作后在图形显示区域显示操作结果。由此可见，只要完成了“Project”树的各分支的完整和正确的定义，就完成了Mechanical组件中相关的全部前处理操作。

Mechanical项目树中的各分支左下角都有一个状态图标，这些状态图标有助于用户判断各分支的定义情况和存在的问题等，比如一个绿色的√表示此分支已经定义完成，一个?表示此分支缺少参数等。常见状态图标列于表5-9中。




图5-73　Mechanical前处理组件操作界面

表5-9　Mechanical分支左侧状态图标及其意义




在Mechanical操作过程中，很多场合需要借助于对象选择操作，在对象选择过程中经常用到选择类型过滤按钮、点选框选模式切换按钮等，以精确选择对象。在点选模式下按住CTRL键，依次用鼠标左键点选，可选择多个对象。在图形显示区域的颜色选择方块，用于选择当前视图方向被挡住的对象。这些操作风格都与DM是一致的。图形控制工具栏、Edge Coloring图形显示控制工具栏的功能也与DM的一致，这里不再重复介绍。此外，用户可以选择统一类型的对象（如：选择一系列的面或选择一系列的节点）并加入到命名选择集合Named Selection中，具体方法是在Model分支右键菜单中选择Insert>Named Selection，如图5-74所示，在项目树中加入Named Selection分支，然后通过几何对象选择或逻辑选择方式完成Named Selection分支的Details参数定义，这些Named Selection在后续的加载等分支中可以被引用。




图5-74　在项目树中加入Named Selection

在Mechanical的“Project”树中，涉及分析模型前处理的分支主要是Geometry、Connections、Mesh三个分支，下面对这几个分支及其具体的操作进行介绍。

1.Geometry分支

打开“Project”树的Geometry分支，Mechanical组件中导入的所有的几何体都在Geometry分支下以一个分支的形式列出。选择每一个几何体分支，在Details View中可以为其指定显示颜色、透明度、刚柔特性、材料类型、坐标系、参考温度等，如图5-75所示。




图5-75　Solid几何体分支的Details

对于刚柔特性选项，Mechanical组件中仅支持Solid Body（实体）和Surface Body（面体）被指定为刚体行为，而变形体行为则可以被指定给包括Line Body（线体）在内的任意三种体类型。刚柔特性通过Details中Definition部分的Stiffness Behavior选项来指定，如图5-76所示。运动刚体的运动取决于模型各部件对刚体的作用力的合力及合力矩，且后续施加约束时只能施加到整个体上。




图5-76　指定刚柔特性

局部坐标系选项（Coordinate System）可以被指定给几何体分支的Coordinate System属性，这一属性被用于定义各向异性材料的方向。材料属性定义的1、2、3方向将被设置为所指定局部坐标系统的x、y、z方向。此外，各几何体分支的Details中还列出了此几何体的统计信息，如：体积、质量、质心坐标位置、各方向的转动惯量。如进行了网格划分，还能显示出单元数量、节点数量、网格质量指标等。

各个几何体的材料类型属性是在Engineering Data中定义的，如果需要指定新的材料类型，可在材料属性中选择“New Material”，如图5-77所示，然后再次进入Engineering Data界面进行新材料及参数的定义。如果需要对现在的材料模型（图中为Structural Steel）参数进行修改，可选择“Edit Structural Steel”，即进入Engineering Data界面进行参数修改，修改完毕后返回Workbench界面。




图5-77　选择新材料或编辑材料参数

除了上述通用属性之外，对于在DM中没有指定厚度的面体（Surface Body），还需要在Mechanical中指定其厚度参数。对于Line Body而言，DM中指定的截面被自动导入Mechanical组件并最后导出至LS-DYNA关键字文件。

2.连接关系指定分支

（1）相关基本概念

前面已经介绍过，LS-DYNA的接触界面（interface）是由一系列三角形或四边形的片段（segment）构成，界面的一侧是从面（或contact面），另一侧为主面（或target面）。接触可以基于总体定义，也可基于特定的表面之间局部定义。

在Mechanical前处理组件中，通过Connections分支目录下的Contacts分支以及Body Interactions分支定义显式动力学分析的接触信息。在Connections分支的Details中可以看到，Auto Detection（自动探测选项）的缺省值被设置为Yes，如图5-78所示。




图5-78　Connections分支

在Mechanical组件中支持的LS-DYNA接触算法大致包含三类，即：单面接触（Single Surface Contact）、面-面接触（Surface-to-Surface Contact）以及节点-面接触。这三种类型的接触分别通过Body Interactions分支、Contact Regions分支（对称接触）以及Contact Regions分支（不对称接触）的方式进行指定。

单面接触（Single Surface Contact）用于分析一个体的外表面与自身或其他体的外表面接触的行为。这种接触由于包含了所有的外表面，因此无需指定接触对的两侧表面（contact面及target面），单面接触是ANSYSLS-DYNA中最一般的接触类型，程序在每一个时间步会自动搜索模型中所有的外表面节点来探测是否发生了穿透行为。此算法特别适合于大变形和自接触问题，以及事前无法预知接触位置的问题。

面-面接触（Surface-to-Surface Contact）用于分析一个物体的表面与另一个物体表面发生接触的情况，这种接触是完全对称的，因此contact面及target面的选择是任意的。面-面接触的位置通常事先已知，适合于物体在接触表面上有相对大滑移的情况。

节点-面接触（Nodes-to-Surface Contact）用于分析接触节点穿透目标面的情况，这是一种非对称接触算法，在Contact Regions分支的Details中必须定义接触两侧表面信息。节点-面接触算法对于接触区域预先已知且接触区域相对较小的问题十分稳健，也适合于模拟节点与刚形体的接触问题。节点-表面接触定义时，平坦的面或凸面、网格较粗的面、刚性材料的表面通常被设置为target面，凹面、网格较细的面则通常被设置为contact面。节点-表面接触算法在ASCII文件rcforc中记录接触合力。

（2）使用Body Interactions分支定义总体接触

Body Interactions分支用于定义总体接触行为。

当Geometry分支下包含多个体（部件）时，Body Interactions分支将被自动添加到Project树中。在Body Interactions分支目录的右键菜单中选择Insert>Body Interaction，可以在Body Interactions分支目录下添加一个新的Body Interaction分支。对于每一个Body Interaction分支，Scope部分Geometry选项缺省为作用于All Bodies，Definition部分Type选项缺省为Frictionless类型，如图5-79所示。Body Interaction分支的所有被作用体的表面节点与所有被作用体的表面之间将进行完全自动的接触探测。为了提高接触分析的效率，实际操作过程中可以抑制掉缺省的Body Interaction分支，然后手工建立Body Interaction分支，在Geometry选项中仅选择部分体，这样接触的探测就被限制在了一个相对的聚焦范围。




图5-79　Body Interaction分支的Details选项

对于每一个Body Interaction分支，Type选项为接触类型，可选择的选项包括Frictionless（光滑接触）、Frictional（摩擦接触），如图5-79所示，其他类型与LS-DYNA关键字导出无关。对于Body Interaction分支，Frictionless为缺省类型。无论是哪一种分支，对于Frictional接触类型，均需要指定frictioncoefficient、Dynamic Coefficient以及Decay Constant，如图5-80所示。




图5-80　Frictional接触的参数

Body Interaction分支定义的接触在后续输出到LS-DYNA关键字文件对应的接触定义关键字有以下几种不同情况。

①第1种情况

如果在Body Interaction分支的scopedbodies中不包含线体（linebody），则导出的关键字为*CONTACT_AUTOMATIC_SINGLE_SURFACE。

②第2种情况

如果在Body Interaction分支的scopedbodies中仅仅包含线体（linebody），则导出的关键字为*CONTACT_AUTOMATIC_GENERAL。

③第3种情况

如果在Body Interaction分支的scopedbodies中同时包含线体（linebody）以及实体（solidbody）或面体（surfacebody），则导出的关键字可能同时包含*CONTACT_AUTOMATIC_SINGLE_SURFACE以及*CONTACT_AUTOMATIC_GENERAL。

（3）使用Contact Regions分支定义局部接触

Contact Regions分支用于定义特定表面与表面之间的局部接触作用。缺省情况下，当模型中多于两个体存在时将自动探测面-面之间的Contact Region，用户可以通过Tools>Options菜单，在Options设置框中选择Connections，在Auto Detection区域选择打开或关闭自动探测的类型（包括Face/Face、Face/Edge、Edge/Edge）以及探测的优先级顺序（Priority），如图5-81所示。




图5-81　接触关系的自动探测选项

在Connections分支目录的右键菜单中选择Insert>Manual Contact Region，如图5-82所示，可以在Connections目录分支下添加一个新的Contacts分支目录，在此Contacts目录下包含一个新建的手工接触区域；在每一个Contacts分支目录右键菜单中选择Insert>Manual Contact Region，可以在此Contacts分支下添加一个新建的手工Contact Region分支。每一个Contact Region分支的Details中均包含Scope及Definition两部分信息，如图5-83所示。Scope部分为接触对的Contact以及Target两个表面，即接触界面两侧的表面，这些表面在选择了接触对分支时会分别以红色和蓝色显示，而那些与所选择的接触对无关的体（部件）则采用半透明的方式显示，如图5-84所示。

在每一个Contact Region分支的Details选项中，Behavior选项可选择Asymmetric（非对称）、Symmetric（对称）以及Auto Asymmetric（自动非对称）三种，如图5-85所示。Asymmetric选项所对应的LS-DYNA接触算法为Nodes-to-Surface Contact，Symmetric选项所对应的LS-DYNA接触算法为Surface-to-Surface Contact，Auto Asymmetric选项在写入LS-DYNA关键字的时候作用等同于Asymmetric选项。对于刚体和变形体之间的接触，一般选择Asymmetric选项。




图5-82　加入Manual Contact Region




图5-83　接触分支Details中的接触两侧




图5-84　接触对显示




图5-85　接触分支的Behavior选项

对于每一个Contact Region分支，Type选项为接触类型，LS-DYNA前处理系统可选择的选项包括Bonded（绑定）、Frictionless（光滑接触）、Frictional（摩擦接触），如图5-86所示，其他类型与LS-DYNA关键字导出无关。对于Contact Region分支，Bonded为缺省类型；对于Body Interaction分支，Frictionless为缺省类型。对于Frictional接触类型，还需要指定frictioncoefficient、Dynamic Coefficient以及Decay Constant，如图5-87所示。




图5-86　接触类型选项




图5-87　摩擦Contact Region的选项

对于Bonded类型接触，Maximum Offset参数用于定义绑定接触的探测范围容差，在Maximum Offset定义的距离以内的Contact Bodies和Target Bodies表面的节点被绑定在一起受力。Breakable参数用于定义绑定接触的失效选项，缺省为No，可设为基于应力的失效准则选项，即Stress Criteria，并指定法向应力极限Normal Stress Limit与剪切应力极限Shear Stress Limit，如图5-88所示。

对于Contact Region分支所指定的接触，在导出为LS-DYNA关键字文件时，不同选项对应的关键字不同，一般有如下的几种情况。

①第1种情况

对于Behavior选项为Symmetric的Frictionless/Frictional接触类型，导出的关键字为*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE。




图5-88　Breakable选项及参数

②第2种情况

对于Behavior选项为Asymmetric的Frictionless/Frictional接触类型，导出的关键字为*CONTACT_AUTOMATIC_NODES_TO_SURFACE。

③第3种情况

对于Behavior选项为Symmetric的Bonded的接触类型，Breakabl选项为No时，导出的关键字为*CONTACT_TIED_SURFACE_TO_SURFACE_OFFSET。

④第4种情况

对于Behavior选项为Asymmetric的Bonded的接触类型，Breakabl选项为No时，导出的关键字为*CONTACT_TIED_NODES_TO_SURFACE_OFFSET。

⑤第5种情况

对于Behavior选项为Symmetric的Bonded的接触类型，Breakabl选项为Stress Criteria时，导出的关键字为* CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK。

⑥第6种情况

对于Behavior选项为Asymmetric的Bonded的接触类型，当Breakabl选项为Stress Criteria时，导出的关键字为*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK。

3.网格划分分支

网格划分是通过Mesh分支完成的，下面介绍网格划分分支Mesh的总体控制、局部控制选项以及网格生成方法。

（1）Mesh总体控制选项

Mesh分支提供了全面的网格控制及网格划分方法选项，包括整体控制以及局部控制。整体控制参数主要通过Mesh分支的Details的参数设置，如图5-89所示。对于显式结构分析网格划分而言，主要的控制包括Defaults、Sizing、Advanced、Defeaturing等。

Defaults部分提供两个选项。其中Physics Preference为学科选项，对于LS-DYNA显式前处理系统而言，Explicit为缺省选项，将自动设置缺省的网格划分控制选项；Relevance为整体的网格尺寸控制参数，变化范围由-100到100，可以直接输入数值，或通过滑键拖动改变数值，越大网格越密。




图5-89　Mesh分支的Details

Sizing部分提供一系列网格整体尺寸控制选项。其中Use Advanced Size Function用于提供了更多关于Proximity和Curvature等局部几何细节的网格尺寸控制方法，缺省为Off；Relevance Center控制Relevance的中心，可选择Coarse、Medium、Fine，对Relevance值相同的情况，这三个选项对应的网格数依次加密，对于Explicit分析，Relevance Center学习的Default为Medium；Element Size选项用于指定整体模型的网格尺寸，当使用Use Advanced Size Function时Element Size不显示；Smoothing选项用于对网格进行光顺处理，选项Low、Medium和High控制Smoothing的迭代次数，对于Explicit分析，Smoothing选项的Default为High；Transition选项用于控制相邻单元的生长率，Slow产生更平滑的过渡，而Fast选项则产生更剧烈的过渡，对于Explicit分析，Transition选项的Default为Slow；Span Angle Center选项控制整体基于曲率的加密程度，在有曲率的区域网格会加密到一个单元跨过一定的角度，Coarse选项一个单元最大跨过角度90°，Medium选项一个单元最大跨过角度75°，Fine选项一个单元跨过最大角度为36°。

Advanced部分提供了一些高级划分选项。其中Shape Checking为指定形状检查方法选项，对静力分析选择Standard Mechanical即可，对大变形分析则选择Aggressive Mechanical；Element Midside Nodes为单元边中间节点选项，对显式结构分析缺省为Dropped（不保留中间节点）。对于Explicit Dynamics（LS-DYNAExport）系统，LS-DYNA的单元算法仅支持低阶Beam单元（线性单元）、低阶的Shell单元（线性单元、四边形及三角形形状）、低阶的Solid单元（线性单元、六面体形状、五面体金字塔形状以及三棱柱形状）；例外的情况是对不规则体的实体网格划分，这时建议采用高阶的Solid单元（10节点四面体单元），即保留中间节点。

Defeaturing部分提供了一些细节消除选项，其中Pinch Tolerance选项用于指定pinch控制的容差，当点点之间或边边之间距离小于此值时会创建pinch控制。Generate Pinchon Refresh选项设置为Yes且几何模型有变化的情况下，执行refresh操作会重新生成pinch控制。Automatic Mesh Based Defeaturing为细节消除选项开关，此开关打开时（on），所有尺寸小于Defeaturing Tolerance的细节特征会被自动消除。在显式分析中由于小尺寸单元会严重影响计算步长和效率，为了避免不必要的小尺寸单元，通常在DM中对几何模型中存在的小特征细节进行预先处理。

Statistics部分则给出了网格的一些统计信息，如：单元总数、节点总数、网格质量统计信息等。

（2）Mesh网格划分方法与局部控制选项

除了上述的整体控制外，可在Mesh分支上打开其右键菜单加入局部控制项目。

当鼠标停放在Mesh分支的右键菜单Insert上时会弹出下一级的子菜单，如图5-90所示。通过这些右键菜单及其子菜单，可在Mesh分支下加入各种划分方法和控制选项，对于每一个方法或选项，在其Details视图中分别进行属性的指定。




图5-90　Mesh分支右键菜单

网格划分方法通过在Mesh分支右键菜单中选择Insert>Method来指定，这时在Mesh分支下出现一个网格划分方法的分支，此分支的名称缺省为网格划分方法，划分缺省的方法是“Automatic”，即：自动网格划分。在网格划分方法分支的属性中，首先选择要指定网格划分方法的几何对象，然后在Method一栏下拉列表中选择网格划分方法，如图5-91所示。在Mechanical中提供了五种体网格划分方法以及三种表面网格划分方法，对于体的表面或面体还可以指定所谓的面映射网格（Mapped Face Meshing）。Mechanical组件中这些网格划分方法均可用于Explicit Dynamics（LS-DYNAExport）系统。




图5-91　网格划分的方法选项

下面简单介绍各种网格划分方法的特点以及主要的选项。

①Automatic方法

如果采用缺省的网格划分，或在图5-91中Method的下拉列表选择了Automatic选项，则Mechanical将会采用自动网格划分方法对模型进行网格划分。此方法划分时，对可以扫略划分的体进行扫略划分，对不能扫略划分的部件采用Patch Conforming四面体划分，这种方式可能造成尺寸分布严重不均匀的网格，在显式分析中是需要避免的，这种情况下，建议手工选择下面的Patch Independent四面体划分方法。

②Tetrahedrons方法

此方法为四面体网格划分，包括Patch Conforming（碎片相关方法，会考虑表面的细节或印记）或Patch Independent（碎片无关方法）两种划分方法。对于Patch Independent方法，提供了一系列高级网格划分选项，其意义与整体选项类似，这里不再详细展开。

在Explicit Dynamics（LS-DYNAExport）系统中，对于四面体划分，建议总是选择Patch Independent方法，避免使用Patch Conforming方法，以免形成明显的小尺寸单元对计算效率造成负面影响。

③Hex Dominant方法

此方法即六面体为主的网格划分，此方法的Details中包含一个“Free Face Mesh Type”选项，可以选“All Quad”（全四边形）或“Quad/Tri”（四边形及三角形）。此方法形成的单元大部分为六面体，因此单元个数一般较少。

④Sweep方法

此方法即扫略网格划分，选择此方法时，Src/Trg Selection方法用于选择源面以及目标面，提供的选项有：Automatic（自动选择）、Manual Source（手工选择源面）、Manual Sourceand Target（手工选择源面以及目标面）、Automatic Thin（自动薄壁扫略）、Manual Thin（手工薄壁扫略）。这些方法中凡是涉及手工操作的，必须手动选择有关的面。对于薄壁扫略，提供一个面网格类型选项，可选择Quad/Tri或All Quad；此外可选择薄壁扫略的单元类型Element Option是Solid还是Solid Shell。对于各种扫略方法，均可设置扫略方向的单元等分数Sweep Num Divs。

⑤Multi Zone方法

此方法为多区域网格划分。这种划分方法会自动切分复杂几何体成为较简单的几个部分，然后对各部分划分网格。此方法提供对映射区域以及自由区域的网格划分方法选项。其中，映射部分的划分方法Mapped Mesh Type可选择Hexa、Hexa/Prism、Prism三种；自由部分划分方法Free Mesh Type可选择Notallowed、Tetra、Hexa Dominant、Hexa Core四种。此外，还可以指定Src/Trg Selection方法为Manual Source，然后手动选择映射划分的源面。

⑥Mapped Face Meshing

此方法即表面映射网格划分方法，可通过Mesh分支的右键菜单Insert>Mapped Face Meshing加入，用于形成表面上的映射网格。通过此方法可以改善表面网格的质量，得到更加均匀的表面网格，这在显式动力学分析中是很有帮助的。图5-92为一个不规则形状实体采用Hex Dominant方法划分网格，（a）为各侧立面及圆柱体侧面采用表面映射网格，（b）为表面未加任何控制。




图5-92　表面映射网格与自由网格的对比

⑦面网格划分方法

对于面体，可选择的网格划分方法有Quad Dominant、Triangle、Multi Zone，可在Mesh分支下加入Method分支，在Method选项中指定，如图5-93所示。对于显式动力学分析，建议优先采用四边形网格进行划分。




图5-93　面网格划分方法

除了网格总体控制及划分方法控制外，Mechanical还提供了功能完善的局部网格尺寸控制选项，这些选项可通过Mesh分支邮件菜单Insert>Sizing加入。在加入的Sizing分支的Details中选择不同的几何对象类型，Sizing分支可改变名称，如：Vertex Sizing、Edge Sizing、Face Sizing、Body Sizing，对各种Sizing控制，可直接指定Element Size；也可以指定一个Sphereof Influence（影响球）及其半径，再指定Element Size，这时尺寸控制仅作用于影响球范围内。如图5-94所示为一个设置了Body Sizing为0.25的边长为10的立方体的网格，图5-95为仅仅在其一个顶点为中心的影响球范围设置了Body Sizing为0.25情况下的网格，划分方法均为Tetra。




图5-94　设置了总体Body Sizing的网格




图5-95　影响球范围内设置Sizing的网格

（3）网格生成

网格划分设置完成后，在Mesh分支右键菜单中选择“Update”或“Generate Mesh”，即可根据用户的设定形成网格。


5.5　初边值条件、加载与关键字导出

初边值条件、加载、分析设置与关键字的导出也是在Mechanical组件中进行的，相关的分支位于Explicit Dynamics分支下，如图5-96所示。




图5-96　Explicit Dynamics分支及其子分支

1.通过Initial Conditions分支定义初始条件

Explicit Dynamics分支目录下的Initial Conditions分支用于定义运动初始条件。

初始条件可以定义在一个或多个体上，初速度的方向通过坐标系选项来指定。

如果初始转动和初始平动都施加到一个体上，这个体的初始速度将是这两种初始条件的叠加。

缺省条件下，所有体的初始状态是静止、无约束以及无应力的状态。在Explicit Dynamics（LS-DYNAExport）系统中，至少一种初始条件、约束条件或荷载必须指定。否则所有体都会一直处于静止状态，也就没有必要进行计算了。

（1）初始平动速度

在Initial Condition分支右键菜单中选择Insert>Velocity，加入Velocity分支，如图5-97所示，其Details如图5-98（a）、（b）所示，其中（a）为向量形式，（b）为分量形式。




图5-97　加入Velocity分支




图5-98　Velocity分支的Details选项

（2）初始转动速度

在Initial Condition分支右键菜单中选择Insert>Velocity，加入Angular Velocity分支，如图5-97所示，其Details如图5-99（a）、（b）所示，其中（a）为向量形式，（b）为分量形式。




图5-99　Angular Velocity分支的Details选项

2.施加约束与荷载

通过Explicit Dynamics分支右键菜单中选择Insert>弹出二级右键菜单，如图5-100所示，选择其中的菜单项即可在Explicit Dynamics分支下添加显式分析的约束及荷载分支。下面介绍菜单中涉及的各类约束及荷载类型。




图5-100　施加约束及荷载

（1）Acceleration

Acceleration用于向模型的全部体上施加加速度，可以通过向量（Vector）以及分量（Components）两种方式施加，其Details选项如图5-101（a）、（b）所示。模型中任意施加的约束都会覆盖已经定义的加速度。




图5-101　加速度荷载的选项

加速度的幅值可以是常数，也可以通过右下角的表格定义为关于时间的Tabular Data，如图5-102所示。




图5-102　表格形式的加速度荷载

（2）Standard Earth Gravity

Standard Earth Gravity用于向模型的全部体上施加重力加速度，与上述的加速度荷载的区别在于，重力加速度只能设定一个方向，而不能改变幅值。重力加速度的Details选项如图5-103所示。模型中施加任意一个约束都会覆盖已经定义的重力加速度。




图5-103　重力加速度荷载的选项

（3）Pressure

Pressure用于向模型的表面施加随时间变化的荷载，Pressure荷载的Details如图5-104所示，Scope部分为作用位置选择，作用对象可以是选择的几何表面或Named Selecttion集合表面；Pressure作用方向为垂直于施加表面，Magnitude可以是常数，也可以是表格荷载形式。在计算过程中，Pressure的实际作用方向会随着所施加表面的变形而变化。




图5-104　Pressure的Details选项

（4）Force

Force用于向模型施加常量或表格形式的力。Force荷载可以施加于刚体或变形体上，对于刚形体，Force只能施加于体上；对于变形体，Force则可以施加于点、线或者面上。在选择作用对象时，可通过Scoping Method选择Geometry Selection或Named Selection方式。Force可以通过向量形式（Vector）或分量形式（Components）定义，其Details选项如图5-105（a）、（b）所示。Force的Magnitude可以是常数也可通过Tabular Data方式定义，采用Tabular Data方式定义Force时，首先要指定Analysis Settings分支的analysisendtime选项。对于分量定义方式，Coordinate System用于定义作用方向的坐标系。

（5）Fixed Support

Fixed Support用于向模型施加固定约束，可以施加到刚体或变形体上以约束全部的自由度。当施加于刚体时，只能施加到体上；施加于变形体时，则可以选择施加到点、线或者面上。Fixed Support作用对象可选择Geometry Selection或Named Selection方式，其Details选项如图5-106所示。




图5-105　Force的Details选项




图5-106　Fixed Support的Details选项

（6）Displacement

Displacement用于向模型施加常量或表格形式的位移约束，可以施加到变形体以及刚体上。当施加到变形体上时，可以施加到点、线或者面上；当施加到刚体上时，仅可以被施加到体上。对于表格形式施加的位移约束，初始值必须为0。对刚体而言，施加了线位移约束后转动自由度会被自动约束。Displacement作用对象可以通过Geometry Selection或Named Selection方式定义，其Details如图5-107所示。

对于表格形式的约束，可选择Details中各分量单元格右边的三角箭头，在弹出的右键菜单中选择Tabular，如图5-108所示。

（7）Velocity

Velocity用于向模型施加常量或表格形式的速度约束，可以被施加于变形体或刚体上。当施加于变形体上时，可以选择施加到点、线或者面上；当施加到刚体上时，仅能施加于体上。当施加到刚体上时，刚体转动自由度将被自动约束。通过Tabular形式定义速度幅值时，首先定义Analysis Settings分支的End Time选项。Velocity的施加位置可以通过Geometry Selection或Named Selection方式定义，其Details如图5-109所示，速度分量所在的坐标方向通过Coordinate System选项定义。




图5-107　Displacement的Details选项




图5-108　选择Tabular形式的约束




图5-109　Velocity的Details选项

（8）Impedance Boundary

Impedance Boundary用于定义无反射的吸收边界，仅用于消除波动的法向速度分量，施加的位置远离感兴趣的区域。吸收边界作用位置选择可通过Geometry Selection或Named Selection，其Details选项如图5-110所示。




图5-110　Impedance Boundary的Details选项

（9）Simply Supported

Simply Supported用于向模型的节点或边上施加线位移约束，作用位置选择可通过Geometry Selection或Named Selection方式，其Details选项如图5-111所示。




图5-111　Simply Supported的Details选项

（10）Fixed Rotation

Fixed Rotation用于向模型的节点或边上施加转动位移约束，作用位置选择可通过Geometry Selection或Named Selection方式，其Details选项如图5-112所示。




图5-112　Fixed Rotation的Details选项

在后续导出关键字文件时，上述Velocity或Displacement类型的边界条件所对应的关键字为*BOUNDARY_PRESCRIBED_MOTION，将会覆盖Fixed Support、Simple Support以及Fixed Rotation边界条件所对应的关键字*BOUNDARY_SPC。

3.分析设置与关键字导出

（1）分析选项设置

Project树的Analysis分支用于设置LS-DYNA的分析选项，其Details选项如图5-113所示。




图5-113　Analysis Settings分支的Details设置

在Analysis Settings分支的Details中，包含Step Controls、Solver Controls、Damping Controls、Erosion Controls、Output Controls等选项，下面分别进行介绍。

①Step Controls

Step Controls包含了用于控制显式动力分析时间步相关的选项，如图5-114所示。End Time是求解的结束时间，除了此参数没有缺省值以外，其他选项均有缺省值。Maximum Numberof Cycles为最大求解增量步数，求解步数超过此数值后会终止求解，通常是指定一个较大的数，缺省为10000000。Maximum Energy Error参数为最大能量误差百分比，当能量误差超过此参数时计算将停止。Maximum Energy Error设为0时相当于关闭了能量误差检查。Initial Time Step、Maximum Time Step为初始时间步长、最大计算稳定步长，建议采用缺省控制，Time Step Safety Factor为计算稳定时间步长安全系数，缺省值0.9在大多数情况下适用。Automatic Mass Scaling为自动质量缩放选项，此选项设置为Yes时，出现两个额外的参数，一个是Minimum CFLTime Step，时间步长低于此参数时将采用质量缩放，另一个是Maximum Part Scaling，即最大的质量缩放百分比，缺省为0.1，此数值不能过大，否则会引起模型质量的显著变化，造成计算失真。




图5-114　时间步相关的选项

②Solver Controls

Solver Controls用于设置求解单位、各种单元的算法（Beam、Solid、Shell）等，如图5-115所示，相关的选项介绍如下：

a.Unit System为求解单位系统选项。

b.Beam Solution Type为梁单元算法选项，缺省为Bending（ELFORM=1），是最为精确的算法；对于轴向单元，设置为Truss（ELFORM=3）。

c.Beam Time Step Safety Factor为梁单元积分步长安全因子，缺省为0.5。

d.Hex Integration Type为六面体单元积分类型选项，对于显式动力学分析使用1pt Gauss（单点高斯积分）算法。

e.Shell Sublayers为Shell单元厚度方向层数，缺省为3层，对于计算内力及力矩通常可以提供足够的精度。

f.Shell Shear Correction Factor为Shell单元剪切修正因子，缺省为0.8333。

g.Shell BWC Warp Correction为Shell翘曲变形修正选项，缺省为Yes，Belytschko-Wong-Chiang翘曲刚度被计算，设为No时不计算此刚度。

h.Full Shell Integration为Shell单元全积分算法选项，缺省为Yes，使用全积分算法，（ELFORM=16）；设为No时采用缩减积分算法（ELFORM=2）。

i.Tet Pressure Integration为四面体单元压力积分选项，缺省为Average Nodal，ELFORM=13，设为Constant时对应算法为ELFORM=10。




图5-115　求解器控制选项

③Damping Controls

Damping Controls用于设置阻尼选项，如图5-116所示。




图5-116　阻尼控制选项

阻尼选项包括人工黏性（Artificial Viscosity）、沙漏阻尼（Hourglass Damping）、静态阻尼（Static Damping）三类。人工黏性用于防止冲击波形成及传播过程中的不稳定现象。沙漏阻尼用于防止六面体实体单元及四边形shell单元的沙漏变形模式。静态阻尼用于通过显式动力分析方法来求解静态平衡问题。具体的阻尼选项包括：

a.Linear Artificial Viscosity为人工黏性阻尼线性项系数，缺省为0.06。

b.Quadratic Artificial Viscosity为人工黏性阻尼二次项系数，缺省为1.5。

c.Hourglass Damping为沙漏阻尼算法选项，缺省为Standard算法，也是最有效的算法；还可以选择Flanagan Belytschko算法，如图5-117所示。




图5-117　Hourglass Damping控制

d.Viscous Coefficient为沙漏黏性系数，在0.05到0.15之间，缺省为0.1。

e.Stiffness Coefficient为刚度阻尼系数，仅当Hourglass Damping选择Flanagan Belytschko算法时出现，对于此种算法，Stiffness Coefficient和Viscous Coefficient只需要指定其中之一即可，如果两个都指定为非零值，则采用Stiffness Coefficient而忽略Viscous Coefficient。与相关的LS-DYNA关键字为*CONTROL_HOURGLASS。

f.Static Damping为静态阻尼，引入与节点速度成比例的阻尼力，使得静态系统达到最低模态振荡的临界阻尼。

④Erosion Controls




图5-118　侵蚀控制选项

ErosionControls选项用于自动移除模型中高度变形的单元，缺省为No，选择Yes时打开此选项，如图5-118所示。当单元的积分时间步长乘以时间步安全因子低于Minimum Element Time Step时，单元将出现侵蚀。可用于模拟材料断裂、切割与渗透行为。

⑤Output Controls

Output Controls为输出控制选项，主要是用于控制结果文件以及重启动文件的输出间隔或频率，其Details选项如图5-119（a）、（b）所示。

a.结果文件输出选项

Save Resultson为输出控制方法选项，可选择Time或Equally Spaced Points。如果选择Time方法控制，则通过Time参数来指定输出时间间隔。如果选择Equally Spaced Time Points方法控制，则通过Numberofpoints参数来指定输出点的个数（缺省为10）。与此相关的LS-DYNA关键字为*DATABASE_BINARY_D3PLOT。

b.重启动文件输出选项

Save Restart Fileson为输出控制方法选项，可通过Cycles或Equally Spaced Points选项来指定重启动文件的输出间隔或频率。如果选择Cycles选项，则需要指定重启动文件点的间隔步数Cycles，重启动文件保存频率的缺省值为5000次。如果选择Equally Spaced Points选项，则需要指定重启动文件点的个数Numberofpoints。注意重启动文件不要写入太多，否则将占用过大的硬盘空间。




图5-119　输出控制选项

（2）添加Mechanical界面目前不支持的关键字

对于一些Mechanical界面不直接支持的求解选项，在导出关键字文件之前可通过关键字片段分支的方式插入。在Explicit Dynamics分支的右键菜单中选择Insert>Commands，即可在Explicit Dynamics目录中添加Keyword Snippet（LS-DYNA）分支，如图5-120所示。在项目树中选择添加的Keyword Snippet（LS-DYNA）分支后，Graphics视图自动切换至Commands视图，如图5-121所示。可在其中直接输入LS-DYNA关键字，这些关键字在导出关键字文件时会包含其中。注意添加的关键字不能有多余的空行，除非是按照关键字的格式有意预留的。




图5-120　添加Keyword Snippet （LS-DYNA）分支




图5-121　Commands视图

（3）LS-DYNA关键字导出

在工具栏上按下Solve按钮，程序将开始导出LS-DYNA的关键字文件，导出完成后，在Messages区域中显示“LS-DYNAkeywordfilehasbeencreated.”信息。导出的关键字文件，可根据分析需要进行必要的修改，然后再递交LS-DYNA求解器进行计算。


第6章　ANSYSLS-DYNA的求解及重启动

前面两章介绍了在传统ANSYS环境及Workbench环境中导出LS-DYNA关键字文件的方法，本章在此基础上介绍基于ANSYSLS-DYNA环境的一般求解以及三类重启动分析的具体操作方法。


6.1　一般求解的操作方法

在第2章中已经介绍了通过系统命令行的方式提交LS-DYNA程序求解的命令语法。在ANSYSLS-DYNA环境中，除直接调用ANSYS安装目录下的LS-DYNA可执行程序外，还可以通过Mechanical APDL以及Product Launcher界面实现求解作业的提交。

1.在Mechanical APDL界面中直接求解

如果待分析的问题能够通过Mechanical APDL提供的LS-DYNA前处理功能完全定义，则可以在Mechanical APDL界面中直接通过Main Menu>Solution>Solve菜单进行求解，或在求解器中通过发出对应的命令SOLVE进行求解。执行SOLVE命令时，ANSYSLS-DYNA首先将所有的模型输入信息，如节点、单元、荷载、约束、分析选项等写到关键字文件Jobname.k中，相当于执行了EDWRITE命令；然后程序的控制权由ANSYS转移到LS-DYNA，LS-DYNA求解器开始计算，并将计算结果写入结果文件。计算过程中，用户可以通过SW系列选择开关对求解进行监控。

在Mechanical APDL界面选择Main Menu>Solution>Output Controls>Output File Types菜单，打开如图6-1所示对话框，在其中选择输出结果文件的类型。选择LS-DYNA或BOTH选项时，将输出LS-DYNA结果文件（即输出D3PLOT、D3THDT等文件），这样就能够使用LS-PREPOST后处理器对计算结果进行全方位的分析。选择LS-DYNA结果文件类型也可以通过命令EDOPT（选择LS-DYNA选项），其具体格式为：

EDOPT，ADD，，LSDYNA




图6-1　输出LS-DYNA格式的计算结果文件

计算完成后，可直接退出ANSYSLS-DYNA，启动LS-PREPOST进行计算结果的后处理。

2.在Product Launcher界面中提交求解作业

如果在ANSYS前处理器写出关键字文件后需要对其进行修改，则可在修改关键字文件后，通过Product Launcher界面实现作业提交，具体操作方法如下。

首先启动Mechanical APDL Product Launcher界面，在左上方的Simulation Environment中选择LS-DYNA Solver，指定License选项为相应的授权（如：ANSYSLS-DYNA），对一般分析，在右上方的Analysis Type中选择Typical LS-DYNA Analysis，如图6-2所示。




图6-2　选择分析环境及分析类型

设置了分析环境和分析类型后，在Product Launcher界面中间的File Management标签中，设定计算项目的路径并指定关键字输入文件，如图6-3所示。在Keyword Input File一行的最右侧有一个Edit按钮，点此按钮可打开关键字文件并进行编辑。




图6-3　设置工作目录以及递交关键字文件

设置了计算路径和关键字文件后，转到Customization Preferences标签，设置计算内存、文件大小以及CPU核数。内存的单位是字（word），要注意不同的系统字长不相同，如字长为32位，则1word=4Bytes；如果软件授权支持并行计算，可通过选择CPU数进行SMP并行，如CPU核数大于1，Enableconsistencychecking选项可以选择被激活，勾选这个选项会进行一致性检查，这将会耗费更多的计算时间；Enabledoubleprecisionanalysis选项用于打开双精度求解，如图6-4所示。对于分布式并行（MPP）计算，还需转到High Performance Computing Setup标签下进行相关的设置。

上述设置完成后，单击Product Launcher界面下方的Run按钮即开始求解，这时会弹出一个LS-DYNA程序的求解信息输出窗口，在这个窗口中可通过SW选择开关进行求解监控。

3.直接调用ANSYS安装目录下的LS-DYNA求解器

以ANSYSLS-DYNA15.0版本为例，如安装在C盘，则在安装目录C：\Program Files\ANSYSInc\v150\ansys\bin\winx64中复制LSDYNA150.exe到工作目录，同时将计算模型关键字文件也复制到此目录中。可以按照如下两个方式之一进行求解。




图6-4　设置分析内存

方式1：打开系统命令提示符，在提示行中按第2章介绍的格式输入命令启动求解，命令中注意使用正确的可执行求解程序名称。

方式2：在工作目录下，双击安装目录中复制来的求解器可执行程序，打开程序执行窗口，其中有如下的操作提示行：

Pleasedefineinputfilenamesorchangedefaults：>

在此提示行右侧输入i=jobname.k↙，即可开始求解。

求解过程中同样可使用CTRL+C中断求解过程，通过SW选择开关进行监控。由于程序最初预估的剩余CPU时间不一定准确，在计算过程中可以使用CTRL+C，然后通过SW2选择开关得到剩余计算时间较准确的实时估计信息，如图6-5所示为一个分析中的SW2实时估计信息。




图6-5　SW2提供的作业实时估计

求解过程中所有的计算输出信息（如：内存使用、时间步、错误、警告、失效单元、接触问题等信息）都会被写入工作目录下的messag文件以及d3hsp文件中。如果计算过程出现问题，可根据这些文件中的信息进行故障分析和排除。


6.2　重启动分析操作方法

重启动分析是基于前次分析所输出的重启动点继续进行后续的分析。在非线性的瞬态问题模拟中，重启动分析是经常用到的一项技术。ANSYSLS-DYNA可进行三种类型的重启动分析，即：简单重启动、小型重启动以及完全重启动。可以通过系统命令行、Mechanical APDL图形界面（使用EDSTART命令选择重启动类型）或Mechanical APDLProduct Launcher三种方式之一进行重启动分析。本节介绍基于Product Launcher的重启动提交操作方法。

1.简单重启动

简单重启动用于之前的分析被SW1所终止或分析没有运行足够的时间的情况。在简单重启动分析中，用户只需指定重启动文件（d3dump），无需修改任何其他设置，即可继续求解，计算结果将附加到原有的结果文件。

通过Product Launcher界面，选择分析环境为LS-DYNASolver，选择分析类型为Simple Restart Analysis，在File Management标签下选择工作路径，指定重启动文件，如图6-6所示，随后点RUN按钮即开始简单重启动。




图6-6　简单重启动

2.小型重启动

小型重启动适用于需要延长计算时间或对模型进行细微修改的情况。小型重启动分析中允许的模型修改项目包括：刚体-变形体之间的转换、修改分析结束时间，修改重启动文件输出频率，修改计算的终止标准、修改接触设置或删除接触、修改初速度、改变ASCII输出设置、改变加载曲线、删除单元等。改变了模型之后，需要构建一个新的输入文件jobname.r，该文件中包含有模型中所有改变的LS-DYNA关键字。

通过Product Launcher界面，选择分析类型为Small Restart Analysis，在File Management标签中选择重启动的工作路径，指定重启动输入文件jobname.r以及重启动文件（d3dumpnn），如图6-7所示，点Run按钮即开始小型重启动分析。




图6-7　小型重启动

3.完全重启动

完全重启动适合于需要对模型进行大量显著修改的重启动问题，比如：增加或删除模型的部件。完全重启动需要形成全新的关键字文件jobname.k。完全重启动分析中，LS-DYNA将形成新的结果文件，这个结果文件与修改后的模型相匹配。

通过Product Launcher界面，选择分析类型为Full Restart Analysis，在File Management标签中选择工作路径、重启动输入文件jobname.k以及重启动文件（d3dumpnn），如图6-8所示，点Run按钮即开始完全重启动分析。




图6-8　完全重启动


第7章　LS-PREPOST的使用方法

LS-PREPOST是LSTC针对LS-DYNA求解器专门开发的前后处理器，起初仅包含后处理功能，后增加部分前处理功能。本章介绍LS-PREPOST前后处理器的使用方法，包括功能及界面、后处理操作、前处理操作三部分内容。


7.1　LS-PREPOST功能及操作界面简介


7.1.1　LS-PREPOST的主要功能

目前，很多商用的前后处理器可以为LS-DYNA程序提供前后处理，比如：TRUEGRID、PATRAN、eta/VPG、HYPERMESH、ANSYS、FEMAP等。LS-PREPOST则是一个由LSTC公司为LS-DYNA专门开发的前后处理器，支持全部LS-DYNA关键字，随LS-DYNA免费提供。LS-PREPOST的用户界面高效且直观，是技术先进的前后处理器，可运行于Windows、Linux及Unix等各种系统中，其主要功能包括：

1.对LS-DYNA关键字的完整支持

LS-PREPOST支持全部的LS-DYNA关键字，能进行识别和编辑。

2.LS-DYNA模型可视化

LS-PREPOST能够对LS-DYNA的模型进行可视化，并进行各种模型操纵，如平移、旋转、缩放、投影、偏移、反射等。

3.高级后处理功能

LS-Pre Post的后处理功能主要包括观察状态结果动画、绘制变量等值线图、XY历史曲线绘图及数据分析等三个方面。

4.前处理功能

LS-DYNA模型创建及编辑，可创建坐标系、对象集合、部件、质量、点焊、约束、刚性墙、铆接、初速度、加速度计、横截面、气囊折叠、假人定位、安全带安装、初始渗透检查以及生成简单网格等。

5.数据的导入与导出

LS-Pre Post还具备一系列不同格式数据的导入和导出功能。目前支持的数据类型列于表7-1中。

表7-1　LS-PREPOST支持的数据类型




续上表





7.1.2　LS-PREPOST的操作界面简介

对于ANSYS LS-DYNA用户，LS-PREPOST使用之前首先需要安装。以64位Windows系统ANSYSLS-DYNA15.0版本为例，安装文件LS-Pre Post-4.0-X64_setup.exe位于ANSYS的安装目录C：\Program Files\ANSYSInc\v150\ansys\bin\winx64下，其余版本可类推。安装后，在Windows开始菜单中选择LS-Pre Post-4.0-X64程序组中的LS-Pre Post-4.0-X64菜单项，即可启动LS-PREPOST4.0，其默认的操作界面如图7-1所示。LS-Pre Post界面包含菜单栏、右侧工具栏、底部工具栏、图形显示区、底部命令栏（底部左侧为输入，底部右侧为输出）等五个部分。




图7-1　LS-PREPOST的操作界面

通过如图7-2所示的View->Toolbar菜单可以选择是否显示右侧工具栏和底部工具栏，勾选Right Toolbar或Bottom Toolbar项则表示显示右侧工具条或底部工具条；通过选择Text（Right）、Icon（Right）或Textand Icon（Right）选项可设置右侧工具条的显示方式为只显示文字、只显示图标或同时显示文字和图标；通过选择Text（Bottom）、Icon（Bottom）或Textand Icon（Bottom）选项可设置底部工具条的显示方式为只显示文字、只显示图标或同时显示文字和图标。如图7-3所示为同时显示文字和图标的工具栏界面。




图7-2　View->Toolbar菜单




图7-3　同时显示文字和图标的工具条

按F11键，可由上述界面切换至如图7-4所示的传统LS-PREPOST界面，大多数用户可能更多偏好使用传统界面。在传统界面中右侧工具栏按钮分成多个页面列出。页面1为后处理功能，页面2包含部分后处理（上半部分）及部分前处理功能（下半部分），页面3、4为关键字编辑页面，页面5、6、7为前处理页面，页面D显示当前关键字中的信息。传统界面的底部工具栏被显示为两行仅包含文字的按钮，主要用于图形显示控制，使用这些按钮可实现模型的平移、旋转、缩放、背景色改变、图形渲染、改变视图形式等操作。

对于熟悉传统界面的用户，如果在使用新界面时对按钮功能不清楚，可通过如图7-5（a）所示的Help>Oldto New菜单，打开如图7-5（b）所示的Guideto New UI提示面板，此提示面板与LS-PREPOST传统界面的右侧按钮面板的布置完全一致，熟悉传统界面的用户可在提示面板中选择一个功能按钮，提示面板的底部即显示传统界面功能按钮所对应的新界面中的工具栏按钮图标，这项功能有助于熟悉传统界面的用户尽快熟悉新界面。




图7-4　传统界面




图7-5　Oldto New菜单及提示面板

本章在介绍具体操作时将以传统界面为主进行讲解，用户在此基础上结合Guideto New UI提示面板很容易过渡到新界面的操作方法。


7.1.3　LS-PREPOST的下拉菜单及常用快捷键

本节介绍LS-PREPOST的部分菜单及常用快捷键的使用。菜单操作介绍主要针对File菜单及Misc菜单。

1.File菜单

File菜单如图7-6所示，主要用于各种文件操作。

（1）File>Open菜单项

File>Open菜单项用于打开各种文件，可打开的文件的类型如图7-7所示，其中File>Open>LS-DYNA Keyword File用于打开LS-DYNA关键字，File>Open>LS-DYNA Binary Plot用于打开结果文件d3plot，File>Open>Time History Files用于打开d3thdt、XY数据、ASCII文件等一系列时间历程文件。




图7-6　File菜单




图7-7　File>Open菜单

（2）File>Import菜单

File>Import菜单用于导入各种文件，可导入的文件类型如图7-8所示。




图7-8　File>Import

（3）File>Save及File>Save As菜单

File>Save以及File>Save As菜单可用于保存项目文件或关键字文件。

（4）File>Print菜单

File>Print菜单用于打印图片，其To File选项可用于保存图像到文件，如图7-9所示。

（5）File>Movie菜单

File>Movie菜单可以形成各种格式的动画文件，如图7-10所示。




图7-9　打印图像到文件




图7-10　Movie输出设置框

2.Misc菜单

（1）Misc>Reflect

Misc>Reflect菜单用于对模型关于坐标面对称镜像。对于采用半个模型的对称性分析，显示结果时可以通过此菜单镜像对称，这样就能够观察整个模型的结果分布情况。

（2）Misc>View Model Info菜单

Misc>View Model Info菜单用于显示模型的各种基本信息，选择此菜单后会弹出如图7-11所示的Model Information信息框，其中列出了模型的节点、单元、坐标范围等统计信息。

（3）Misc>View LS-DYNAKeyword Info菜单

Misc>View LS-DYNAKeyword Info菜单用于显示模型包含的关键字信息字段数量，选择此菜单会弹出如图7-12所示的Keyword Info信息框，列出此模型中包含的关键字，选择其中的Expand All按钮，可显示模型中包含的所有关键字选项及其包含的关键字数量。

3.图形操作快捷键

LS-PREPOST界面支持下面的几个图形操作常用快捷键。

（1）Shift+鼠标左键：对显示的图形进行旋转操作。

（2）Shift+鼠标右键：对显示的图形进行缩放操作。

（3）Shift+鼠标中键：对显示的图形进行平移操作。




图7-11　模型信息




图7-12　关键字信息

当上述各快捷键中的Shift键改用Ctrl键时，也可实现相应的动态图形操作且只显示图形的边框线，操作速度比用Shift键更快。


7.2　LS-PREPOST的后处理操作

本节介绍最常用的三种LS-PREPOST后处理操作：结果动画观察、绘制变量等值线图以及绘制变量曲线。

1.动画观察结果

LS-DYNA是非线性动态求解器，其计算结果包含动态数据。在LS-PREPOST中打开d3plot结果文件后，在界面的底部工具栏下方出现一个动画播放控制面板，如图7-13所示，此控制面板用于对计算结果进行动画观察。




图7-13　动画播放控制面板

动画观察控制面板中包含一系列的功能按钮或文本框，下面对其进行简单说明。

（1）First/Last文本框

First/Last文本框表示用于动画显示的初始帧以及结束帧的编号。

（2）Inc文本框

Inc文本框表示初始帧以及结束帧之间的增量。

（3）Time文本框

Time文本框表示当前显示视频帧所对应的时间。

（4）State#文本框State#文本框表示当前显示的帧所对应的结果步。

（5） 
 按钮

这两个按钮的作用分别为静态显示上一步、下一步的结果。

（6） 
 按钮

这3个按钮的作用分别为向前、向后、暂停播放动画。

（7） 
 按钮

这个按钮表示移动动画进度条时，图像是否跟随变化。

（8） 


此控件为动画播放进度条，可拖动。

（9）图中显示17的竖向控件

此控件的作用是调节动画播放的速度，对应的数值越大播放速度也越快。

（10） 
 按钮

此按钮的作用是按照时间次序双向播放动画。

2.绘制变量等值线图

绘制变量的等值线图时，选择工具栏第1页的Fcomp按钮，然后在Fringe Component面板中选择要显示的变量，如图7-14所示，可显示的常用变量类型包括应力（Stress）、变形（Ndv）、应变（Strain）等。Misc选项包含了一些重要的后处理变量（如图7-15所示），比如：压力（pressure）、温度（temperature）、内能（Internal Energy）、shell厚度、厚度的减少百分比、沙漏变形能（Hourglass Energy）以及历史变量historyvar#1（密度），historyvar#2（第1种ALE材料物质在网格中的体积百分比），historyvar#3（第2种ALE材料物质在网格中的体积百分比），等。这些历史变量的等值线显示用于观察多相流动分析的物质界面情况。




图7-14　绘制变量图




图7-15　Misc选项及包含变量

如图7-16所示为圆形金属环冲击平台过程某时刻的等效应力分布等值线图。在一个标准的LS-PREPOST等值线图中所包含的要素有：结果变形显示，标题，时间，显示结果数据类型，最小、最大值及其所在位置信息，坐标系，颜色及数值对比条等。




图7-16　Mises等效应力云图（示例）

此外，工具栏按钮第1页的Splitw按钮可用于实现多窗口的图形显示，比如选择2×2显示。通过Split Window面板的Drawto Subwindow选项选择绘图窗口，如图7-17所示为提供2×2窗口显示一系列不同时刻的结构变形结果。




图7-17　2×2窗口图形显示

3.绘制变量曲线

绘制动态的时间变量曲线时，选择第1个工具页面的History按钮。在如图7-18所示的Time History Results面板中选择要绘制的变量类型，单击左下方的Plot按钮，打开Plot Window-1窗口并在其中绘制要求的曲线。

如图7-19所示的Plot Windows-1窗口显示的是某节点的速度-时间历程曲线。




图7-18　Time History Results面板




图7-19　节点Y向速度-时间历程曲线

Plot Window-1窗口底部有一排按钮，可以用于曲线绘图控制以及数据的分析，下面简单加以介绍。

（1）Title按钮用于指定曲线标题。

（2）Scale按钮设置坐标轴的缩放比例和显示范围。

（3）Attr按钮用于设置数据曲线的显示方式和特征，如线条的颜色、粗细、线型等。

（4）Filter按钮用于曲线的滤波操作。

（5）Print按钮用于打印曲线图形，“to File”选项可用于保存图片。

（6）Save按钮用于保存曲线数据到文件。

（7）Oper按钮用于对显示的曲线进行各种数值分析运算，如：计算导数、积分、快速傅里叶变换（FFT），此按钮的工作面板如图7-20所示。

图7-21所示为对上面的速度曲线进行积分后得到的位移曲线。

图7-22所示为前面的速度曲线的频谱（通过FFT）。




图7-20　对曲线进行数学操作




图7-21　速度曲线的积分




图7-22　速度曲线的FFT谱

（8）Hide按钮用于隐藏底部的按钮工具栏。

（9）Close或Quit用于关闭Plot Window-1窗口。


7.3　LS-PREPOST前处理操作简介

LS-PREPOST包含一些简单的前处理功能，可用于创建简单的分析模型。下面介绍几种实用前处理操作。

1.创建实体对象网格

在LS-PREPOST界面右侧工具栏中切换至第7页，选择Mesh按钮，出现如图7-23所示的Mesh面板。在Entity下拉列表中选择创建的实体对象网格的类型，可选类型包括Box_Solid、Box_Shell、4N-Shell、Sphere_Solid、Sphere_Shell、Cylinder_Solid、Cylinder_Shell以及Circle_Shell。

下面以一个实心球冲击平板的模型为例介绍相关的操作方法，具体操作步骤如下：

（1）创建平板单元

如图7-24所示，在Entity下拉列表中选择Entity对象类型为4N-Shell，输入P1～P4点坐标为±100，输入xy方向单元数Nx No和Ny No为10，单击Creat按钮，再单击Accept按钮完成平板单元的创建。




图7-23　Mesh面板




图7-24　创建平板单元

（2）创建实心球体单元

如图7-25所示，在Entity下拉列表中选择Entity对象类型为Sphere_Solid，输入球的半径为25、网格划分密度为5，球心位置坐标Z=26，单击Creat按钮，再单击Accept按钮完成实心球体单元的创建。单击Done按钮，退出Mesh面板。创建的模型如图7-26所示。

2.定义及分配单元属性

在LS-PREPOST中，通过右侧工具栏第3页的*MAT按钮和*SECTION按钮，在关键字编辑面板中可指定材料及SECTION属性，如图7-27及图7-28所示。通过右侧工具栏第5页的Part D按钮，可以为部件分配单元属性。




图7-25　创建实心球体单元




图7-26　实心球冲击平板的模型




图7-27　*MAT面板




图7-28　*SECTION面板

以上面的实心球冲击平板问题为例，下面为此问题指定材料、SECTION并分配这些属性给各部件。假设球为刚体材料，板为弹塑性材料。具体操作步骤如下：

（1）指定刚性材料

在第3页的* MAT面板中选择Group By：All，Sort：Type，在材料列表中选择020-RIGID，单击Edit，在打开的Keyword Input Form界面中单击New ID，输入TITLE为rigid material，输入RO=7.85e-6，E=200，PR=0.3，单击Accept按钮，再单击Done按钮，如图7-29所示。




图7-29　指定刚体材料

（2）指定弹塑性材料

在*MAT面板中选择Group By：All，Sort：Type，选择003-PLASTIC_KINEMATIC，单击Edit，在打开的Keyword Input Form界面中单击New ID，输入TITLE为plasticmaterial，输入RO=7.85e-6，E=200，PR=0.3，SIGY=0.21，ETAN=2.0，BETA=0.0，单击Accept按钮，再单击Done按钮，如图7-30所示。




图7-30　指定塑性材料

（3）定义SOLID单元Section

在右侧按钮第3页选择*SECTION按钮，在Keyword*section面板中选择solid，单击Edit按钮，在打开的Keyword Input Form中单击New ID，输入标题：ballsection，单击Accept按钮，单击Done按钮，如图7-31所示。




图7-31　指定单元算法

（4）定义SHELL单元Section

在Keyword*section面板中选择Shell，单击Edit按钮，在打开的Keyword Input Form中单击New ID，输入Title为shellsection，输入NID=5，T1=2.5，按回车以指定T2、T3、T4与T1相等，单击Accept按钮，单击Done按钮，如图7-32所示。




图7-32　指定SHELL单元的SECTION

（5）分配材料属性及截面属性

在右侧按钮第5页选择Part D按钮。在Part Data面板中选择Assi，在下面的部件列表中选择S1shell_4p，如图7-33所示。在界面最下侧的部件参数区域中点SECID，打开Link SECTIONDialog对话框，选择2shellsection，如图7-34所示，单击Done按钮；在界面最下侧部件参数区域中点MID，打开Link MATDialog对话框，选择2plasticmaterial，如图7-35所示，单击Done按钮；在界面最下侧部件参数区域中单击Apply按钮，如图7-36所示。




图7-33　指定部件属性




图7-34　选择SHELL的SECTION




图7-35　选择SHELL的材料




图7-36　确认SHELL属性

按照同样的操作，在Part Data面板中选择Assi，在下面的部件列表中选择H2spheresolid，点击SECID选择2，点击MID选择2，在界面最下侧的部件参数区域中点SECID，打开Link SECTIONDialog对话框，选择1ballsection，如图7-37所示，单击Done按钮；在界面最下侧部件参数区域中点MID，打开Link MATDialog对话框，选择1rigidmaterial，如图7-38所示，单击Done按钮；在界面最下侧部件参数区域中单击Apply按钮，如图7-39所示。




图7-37　选择SOLID的SECTION




图7-38　选择SOLID的材料




图7-39　确认SOLID属性

（6）验证材料属性及截面属性正确性

在前述Part Data面板中选择Prop选项，在部件列表中分别选择S1shell_4p以及H2spheresolid，对每个部件在界面最下方的关键字核对区域分别检查其Section以及Mat关键字的定义情况。比如选择检查平板的Section选项，如图7-40所示。




图7-40　检查平板的SECTION

平板section关键字信息显示如图7-41所示，可以看到厚度方向积分点以及板的厚度等信息定义无误。




图7-41　平板的SECTION参数

3.通过关键字编辑进行加载和分析设置

通过LS-PREPOST右侧工具栏第3页的关键字编辑以及第5页的部分按钮可以完成约束定义、接触以及各种连接（焊接、铆接等）的定义、初始条件定义、创建刚性墙、假人定位、气囊定义、加载以及分析设置等操作。

下面以球体冲击平板问题为例介绍相关操作方法，具体的操作步骤如下。

（1）板周边施加固定约束

在右侧的工具面板第5页选择Spc按钮，在SPC数据面板中选择Creat选项和Set选项，勾选X、Y、Z自由度，如图7-42所示。在界面的下侧工具按钮栏中单击Edge按钮，在底部的Edge面板中单击All Vis按钮，选择所有可见边（即平板的周边），在SPC数据面板中单击Apply按钮实现约束的施加。在下侧工具栏中单击Shad按钮，观察施加了约束的模型如图7-43所示。




图7-42　SPC面板




图7-43　施加了约束的模型

（2）指定球的初速度

在右侧的工具面板第5页选择Ini Vel按钮，在Initial Velocity Data面板中选择Create，指定Vz=-5（单位为mm/ms），如图7-44所示；在界面的下侧选择面板中选择By Part选项，如图7-44（a）所示，选择球体部件（图7-44（c）），单击Initial Velocity Data面板的Apply按钮定义初速度，如图7-44（b）所示。




图7-44　指定球的初速度

（3）定义接触关系

首先创建部件集。进入右侧工具栏的第5页，选择Set D按钮，在Set Data面板中选择Creat和*SET_PART，在图形窗口里选择球体以及平板，单击Apply。选择Show，单击None按钮。

选择AUTOMATIC_SINGLE_SURFACE，点击Edit。点击New ID，选择SSTYP=2，SSID=1，MSID=0。单击Accept按钮，单击Done按钮，如图7-45所示。




图7-45　接触关系定义

（4）设置计算时间

进入在右侧工具栏的第3页，选择*CONTROL，在Keyword*CONTROL面板中选择TERMINATION，单击Keyword面板的Edit按钮，在打开的关键字输入模板中指定ENDTIM=20，单击Accept按钮，单击Done按钮，如图7-46所示。




图7-46　指定计算时间

（5）输出选项设置

在右侧工具栏的第3页选择*Dbase按钮，在Keyword *DATABASE面板中选择BINARY_D3PLOT选项，单击Edit按钮，在打开的关键字输入模板中输入DT=1，单击Accept按钮，单击Done按钮，如图7-47所示。




图7-47　设置结果文件输出选项

在Keyword*DATABASE面板中选择ASCII_option选项，单击Edit，在打开的关键字输入模板中设置其Defaultinterval为0.1，Default Binary为1；激活GLSTAT（总体统计）、MATSUM（材料能量摘要）、SLEOUT（滑动界面能量）等3个选项，单击Accept按钮，单击Done按钮，如图7-48所示。




图7-48　设置文本输出文件选项

除了上述前处理操作之外，LS-PREPOST还可实现假人、安全带、气囊等一系列专用建模功能，具体操作方法可参考LS-PREPOST的产品手册。

通过菜单Applications>Model Checking可进行模型关键字检查，执行检查后可显示出所有的Error和Warning信息。当所有的前处理操作完成后，可以通过菜单File>Save>Save Keyword保存关键字文件。


第8章　LS-DYNA隐式分析方法与例题

本章介绍LS-DYNA求解器的隐式分析技术，重点介绍了结构模态分析的实现方法，并结合一个球面网壳结构模态计算例题进行讲解。


8.1　LS-DYNA隐式分析技术简介

LS-DYNA是一个以显式分析为主的结构非线性分析程序，其隐式分析功能是显式分析的补充，能用于处理显式程序不方便处理的静力问题、特征值问题等。

基于LS-DYNA的隐式分析通过*CONTROL_IMPLICIT关键字进行控制，常用关键字选项列于表8-1中。

表8-1　LS-DYNA隐式分析关键字




在上述各关键字中，*CONTROL_IMPLICIT_GENERAL为隐式分析所必须，可根据问题特点选择设置其他的关键字。


8.2　隐式分析例题：网壳结构的模态分析

本节以一个球面网壳结构为例，介绍基于LS-DYNA的隐式模态分析实现过程。

1.问题描述

球面网壳结构球面半径为20.0m，跨度约35m，矢跨比1:3.5，如图8-1所示。结构所有杆件均采用ф114.0×4.0的Q235圆形钢管。球面网壳结构的质量应按重力荷载代表值计算，除了结构自重由程序自动计算外，还需要包括其他永久荷载及可变荷载组合值，本例中这部分质量按水平投影面积100kg/m 2
 计算，平均分配到网壳的全部内部节点（共计91个），每个内部节点大约分配附加质量1000kg。约束情况为约束底部周边节点的线位移自由度。




图8-1　球面网壳的俯视图

2.前处理及关键字导出

在Mechanical APDL中采用直接法创建有限元模型，建模以及关键字导出的Mechanical APDL命令流如下：










执行上述命令流完成模型创建后，显示的计算模型如图8-2所示，包含此模型信息的关键字被写入关键字文件modal_DYNA.k中。




图8-2　球面网壳计算模型及周边支撑情况

3.递交求解及后处理

按如下步骤进行求解并查看计算结果。

（1）修改关键字文件

打开Modal_DYNA.k关键字文件，对照附在本节最后的关键字文件，在其中添加隐式分析与特征值分析相关的如下关键字：




（2）递交求解

关键字文件修改完成后，按如下步骤递交求解。

①打开ANSYSMechanical APDLProduct Launcher。

②在Product Launcher左上角的Simulation Environment中选择LS-DYNA Solver，License中选择相应的授权，如图8-3所示。




图8-3　选择ANSYSLS-DYNA授权

③在File Management标签下的Working Directory中设置工作路径，在Keyword Input File中通过Browse按钮浏览指向本次分析的关键字文件Modal_DYNA.k，如图8-4所示。




图8-4　选择计算路径和关键字文件

（3）计算结果后处理

①查看频率计算结果

打开计算输出的eigout文件，特征值计算结果（CYCLES列为频率）如图8-5所示，此文件中还列出了各阶模态在各方向上的模态参与系数和振型有效质量。

②观察振型结果

打开LS-Prepost，按下Ctrl+B快捷键，指向d3eigv文件并打开，按“+”号即可观察各阶振型，每一节振型可通过向前动画播放按钮动画显示和观察。各阶振型的前视图如图8-6所示。




图8-5　特征值计算结果




图　8-6




图8-6　网壳结构振型图

③与ANSYS计算结果的比较

如果采用ANSYS隐式分析，其频率计算结果列表如图8-7所示，与LS-DYNA隐式分析得到的频率数值基本一致。




图8-7　基于的模态分析结果

附：本节模态分析的关键字文件Modal_DYNA.k（单元、节点信息有删减）








第9章　ALE算法及流固耦合分析

本章介绍LS-DYNA的ALE算法以及流固耦合技术，主要内容包括ALE及流固耦合技术简介、基于ALE的液面晃动分析实例以及钢板落水过程流固耦合分析实例。


9.1　ALE算法及流固耦合分析技术简介

在计算固体力学中多用Lagrange列式方法，计算流体力学则用Euler列式方法。

Lagrange方法的优势在于变形后材料的自由表面可以自动被网格的边界所捕捉到，在网格中不存在材料的流动。纯拉格朗日方法可以很好地分析各种中等变形程度的问题，但是对于大变形问题经常由于网格的过度扭曲而导致分析精度的降低甚至数值计算的困难。尽管通过对高度变形区域网格的自适应划分可以在一定程度上提高拉格朗日方法的精度，但是网格自适应划分技术将提高分析成本，而且该方法在三维问题方面还没有得到充分开发。拉格朗日方法的另一个缺点是无法自动形成材料之间新的界面。LS-DYNA程序的空间离散主要采用Lagrange方法，其网格与结构是重合的，网格随着结构的变形而变形。但是对于分析流体、流固耦合问题以及固体结构的大变形问题，材料流动将造成有限元网格的严重畸变，引起数值计算的困难。

在Euler方法中，网格是固定不变的，而材料在网格中流动。这种方法起源于流体力学领域，可以用于分析变形程度较大的问题。在欧拉方法中，材料在流动过程中可以自动形成新的分界面。欧拉方法的最大的缺点则在于为了精确捕捉固体材料的变形响应，需要很精细的网格，这极大地提高了数值分析的成本，尤其是用于分析应变相对较小的问题时更是这样。

在解决流体-固体耦合同题时，需要一种将Lagrange方法和Euler方法的优点结合起来的算法，即Arbitrary Lagrange-Euler算法，简称为ALE算法）。ALE最早是为了解决流体动力学问题而引入的，并使用有限差分法。Donea，Belytschko等人分别将ALE法引入有限元法中，用于求解流体与结构相互作用问题。Hughes等人建立了ALE描述的运动学理论，并使用有限元法解决了黏性不可压缩流体和自由表面流动问题。ALE方法还可以克服固体大变形数值计算的难题，该方法目前已经成为分析大应变问题的重要的数值分析方法。

随着ALE技术的完善，一些专业计算软件开始加入ALE功能，LS-DYNA是目前具有较成熟的ALE算法的大型通用有限元程序，程序中最先采用简化ALE，后来发展到多物质ALE，其应用领域主要是涉及流体-固体耦合方面的计算。

ALE方法的基本实现过程如下：

（1）先执行一个或几个Lagrange时步计算，此时单元网格随材料流动而产生变形，保持变形后的物体边界条件，对内部单元进行重分网格，网格的拓扑关系保持不变，称为Smooth Step。

（2）将变形的网格中的单元变量（密度、能量、应力张量等）和节点速度矢量输运到重分后的新网格中，称为Advection Step。输运步的成本比起Lagrange步要大很多。大多数输运步的时间用于计算相邻单元之间的材料运输，只有一小部分时间耗在计算何处的网格应如何被调整，且可以用较粗糙的网格来获得较高的精确度。在计算过程中，一般每个单元解的各种变量都要进行输运，要输运的变量数量取决于材料模型。对于包含状态方程的单元，只输运密度、内能和冲击波黏性。

Euler列式则是材料在一个固定的网格中流动，其与Lagrange方法以及ALE方法可通过网格的构形变化情况加以比较，在经过一个时间增量Δt之后：

Lagrange网格仍然是和结构材料重合，但是对于固体结构大变形情况，网格形状随着材料变形而改变，可能会严重畸变，造成数值计算的困难。

对于Euler网格，网格点只是空间点，与分析的模型之间没有依附关系。程序计算的结果使得材料的物质在固定的空间网格中流动。

对于ALE网格，可以理解为两重网格开始时重叠在一起，一个是空间点网格，另一个是附着在材料上的网格并随着材料在空间网格中运动，与Euler区别在于，ALE的空间网格也可动，材料网格在Lagrange时步变形之后，通过物质输运算法映射到空间网格中。

在LS-DYNA中，采用ALE算法或Euler算法，需要通过标识相关单元的算法。这可以通过*SECTION_SOLID_ALE关键字来定义单元算法类型。对于SOLID单元，可以用的单元算法有：

5：单点ALE公式（单元内为一种材料）

6：单点Eulerian公式（单元内为一种材料）

7：单点Eulerianambient公式

11：单点Euler/ALE多物质单元（一个单元最多包含10种材料）

12：单点Euler/ALE单物质的空物质单元

与ALE算法相关的基本特性通过如下的关键字来定义：

*CONTROL_ALE

*ALE_SMOOTHING

对于多物质单元，实际上就是指这种单元划分的网格中，允许多种物质的流动，在同一个网格中，可以包含多种材料的物质，这就实现了物质在网格中的输运过程。与多物质算法定义相关的关键字有如下的一些：

*SECTION_SILID_ALE

定义多物质实体单元的算法，对于对单物质+空材料为12号算法，对于多物质耦合为11号算法。

*ALE_MULTI-MATERIAL_GROUP

这一关键字用于多物质算法的定义，至少要包含2种材料的物质。

可以根据物质间能否混合将各种材料定义在不同的材料组ID中。如果有N种材料要进行多物质算法的定义，则该关键字的输入参数就包括N行，每一行包括SID和SIDTYPE两个参数。SID表示PART或PART SET的ID号，SIDTYPE表示SID的类型，如果SIDTYPE为0，则表示SID为PARTSET（部件组合，由*SET关键字所定义）的ID号；如果SIDTYPE为1，则表示SID为PART的ID号。

例如下面的关键字将PART1，PART2和PART3包含的单元定义为多物质ALE单元：




此外，ALE网格可以实现在空间中的平移、转动以及扩张，这就需要用到如下的一些关键字段：

*ALE_REFERENCE_SYSTEM_GROUP

这一关键字用于定义ALE网格变形的参考坐标系统。可以实现ALE网格的平移以及旋转等，比如：可以定义ALE网格运动由PART质心运动来控制。这个关键字段的输入参数不再一一列举。

也可以通过结合如下的关键字来定义ALE网格的变形：

*ALE_REFERENCE_SYSTEM_CURVE

定义ALE网格系统的运动曲线。

*ALE_REFERENCE_SYSTEM_NODE

通过12个节点来定义ALE网格的平移、旋转以及扩张。

*ALE_REFERENCE_SYSTEM_SWITCH

这一关键字用于不同的ALE网格变形参考坐标系统之间的转换，即：可以通过这一关键字段实现不同时段对应不同的网格变形坐标参考系统类型。

下面简单介绍一下流固耦合算法的实现。

如果流体材料采用Euler网格，固体结构采用Lagrange单元来离散，二者之间的耦合通过下列关键字来实现：

*CONSTRAINED_LAGRANGE_IN_SOLID

这一关键字中，将Lagrange描述的固体结构的部件（部件组合）或者一些段的组合的ID编号作为从属（SLAVE），将ALE或Euler描述的流体部件作为主部件（MASTER），通过罚耦合和运动约束等算法以实现流固耦合。

这一关键字的主要输入参数包括下面两个数据行。

SLAVE，MASTER，SSTYP，MSTYP，NQUAD，CTYPE，DIREC，MCOUP

START，END，PFAC，FRIC，FRCMIN，NORM，NORMTYP，DAMP

CQ，HMIN，HMAX，ILEAK，PLEAK，LCIDPOR，NVENT，IBLOCK

其中部分参数的意义如下：

SLAVE：模型中采用Lagrange描述的实体结构部分（壳单元或体单元）的ID；

MASTER：模型中采用Euler算法或ALE算法部分的ID；

SSTYP：SLAVEID的类型，0表示PSID，1表示PID，2表示SGSID；

MSTYP：MASTERID的类型，0表示PSID，1表示PID；

NQUAD：在SLAVE段上考虑耦合的积分点个数；

CTYPE：耦合的方式，可取1（约束加速度），2（约束速度与加速度），3（约束加速度与法向速度），4（壳单元或体单元的罚函数耦合方式），5（体单元的罚函数耦合方式，可以考虑侵蚀）；

DIREC：耦合方向选项，1表示法向上的压缩与拉伸两个方向的耦合，2表示仅在法线压缩方向，3表示在所有方向；

MCOUP：耦合物质材料选项：0表示与所有材料耦合，1表示仅与密度最大材料耦合；

START：开始考虑耦合的时间；

END：耦合结束时间；

PFAC：罚因子；

FRIC：摩擦系数，仅当DIREC=2时需要；

FRCMIN：判断单元是否发生耦合时其中MASTER部分所占的最小体积百分比，缺省0.5，对高速动力问题可以减至0.1～0.3之间；

NORM：壳单元或体单元SEGMENT的法向标识，0表示采用右手法则定法向，1表示采用左手法则来确定方向，法向如果取反可能导致捕捉不到本来会发生的耦合行为。


9.2　ALE分析实例：液面晃动分析

本节以一个液面晃动问题的分析为例，介绍ALE算法的具体应用。

作匀加速运动的盛水方形容器，横截面尺寸为10cm×1cm，左右两侧液面高差2cm，左侧液面高度为11cm，右侧液面高度为9cm，如图9-1所示。当此容器加速度消失后，模拟液面的晃动过程。




图9-1　液面高差示意图（单位：cm）


9.2.1　前处理与关键字导出

建模以及关键字导出的APDL命令流如下：










执行上述命令流的过程中，几何模型、有限元模型以及PART表分别如图9-2、图9-3、图9-4所示，包含此模型信息的关键字被写入关键字文件slosh.k中。




图9-2　几何模型




图9-3　网格模型


9.2.2　递交求解

按照如下步骤递交求解。

（1）新建工作目录

新建一个工作目录作为计算工作路径。

（2）拷贝求解器程序

由ANSYS安装目录下复制LS-DYNA求解器程序LSDYNA150.exe到计算工作路径下。




图9-4　形成PART表

关于LS-DYNA求解器程序所在的安装目录，这里举例说明。比如：ANSYS15.0版本，64位Windows系统，如安装在C盘，则LS-DYNA程序的存放路径为C：\Program Files\ANSYSInc\v150\ansys\bin\winx64。对于其他版本或其他的安装路径可以以此类推。

（3）递交求解

在计算工作路径下鼠标双击拷贝过来的LS-DYNA求解可执行程序，弹出LS-DYNA程序信息输出窗口，在其命令提示行输入i=.slosh.k，如图9-5所示，敲回车键程序即开始计算。




图9-5　命令行方式运行LS-DYNA程序


9.2.3　LS-PREPOST后处理

按照如下步骤完成计算结果的后处理操作。

在Windows开始菜单的LS-Prepost-4.0程序组中选择LS-Prepost-4.0，启动LS-Prepost，按Ctrl+F11切换至传统模式。

在右侧功能区第1页按钮中选择Split W，在WindowConfiguration中选择2×2，通过Drawto Subwindow选择绘制图形的子窗口，如图9-6（a）、（b）所示。




图9-6　分窗口绘图

通过动画观察选择左侧、右侧达到振幅的最大值附近的一系列不同时刻，绘制模型的构形，如图9-7（a）、（b）、（c）所示。

下面绘制左端表面节点（如图9-8所示）的高度坐标时间历程曲线。首先在图形窗口中选择此节点，然后在后处理面板（第1页）选择History按钮，在Time History Results面板中选择Nodal和Y-Coordinate，如图9-9所示。单击Time History Results面板Plot按钮，绘制如图9-10所示的曲线。




图　9-7




图9-7　不同时刻的构形




图9-8　绘制坐标的节点位置示意图




图9-9　时间历程曲线面板




图9-10　表面端点的Y向坐标-时间曲线


9.3　流固耦合分析实例：钢板落水模拟

本节以一个钢板落水问题的分析为例，介绍流固耦合分析的具体方法。

如图9-11所示的边长60mm、厚度20mm的方形钢板以25m/s的初速度由空气落入水中，采用LS-DYNA的多物质流固耦合方法分析此过程。计算域的范围空气取400mm×400mm×150mm，水取为400mm×400mm×350mm。




图9-11　钢板落水问题前视图（前视图、侧视图相同）（单位：mm）

为减少计算时间，分析中采用半个模型，在对称面上施加法向约束。


9.3.1　前处理与关键字导出

基于如下的APDL命令流进行前处理并导出关键字。










执行上述命令流之后，得到几何模型、有限元模型以及PART表分别如图9-12、图9-13及图9-14所示。




图9-12　几何模型




图9-13　有限元模型




图9-14　PART表


9.3.2　关键字修改及递交求解

1.修改关键字

对照本节后面的关键字文件在文本编辑器中修改单元算法关键字*SECTION_SOLID，删除*BOUNDARY_NON_REFLECTING关键字，并添加以下与流固耦合控制相关的关键字：

*CONSTRAINED_LAGRANGE_IN_SOLID

*CONTROL_ALE

*ALE_MULTI-MATERIAL_GROUP

上述修改完成后保存关键字文件。

2.递交LS-DYNA求解

按照如下步骤完成求解。

（1）打开Mechanical APDLProduct Launcher。

（2）在Product Launcher左上角的Simulation Environment中选择LS-DYNASolver，License中选择相应的授权，如图9-15所示。

（3）在File Management标签下的Working Directory中设置工作路径，在Keyword Input File中通过Browse按钮浏览指向本次分析的关键字文件PLATE.k，如图9-16所示。




图9-15　选择授权模块




图9-16　指定工作路径及关键字文件

（4）切换到Customization/Preferences标签，设置Memory为100000000，设置Numberof CPUs为2，如图9-17所示。注意CPU设置不仅依赖于硬件核数，也与授权的并行计算核数有关。




图9-17　指定CPU数

（5）点Product Launcher下面的Run按钮，即递交LS-DYNA求解器开始计算。计算过程中可以在Windows任务管理器的性能页面中查看CPU及内存使用情况，如图9-18所示。




图9-18　CPU及内存使用情况


9.3.3　LS-PREPOST后处理

计算完成后，按照如下的操作步骤，在LS-PREPOST中进行计算结果的后处理。

1.打开d3plot文件

选择功能按钮Split W，在Windows Configuration中选择2×1，分水平的左右窗口视图。

在Drawto Subwindow中分别选择左右两个窗口，在其中分别使用功能面板按钮的Fcomp>Misc>volumefractionmat#1，绘制钢板刚落入水中以及钢板完全没入水中某时刻的水体积分数，即可观察到钢板落水溅起的水花，如图9-19所示。




图9-19　钢板溅起的水花

在Drawto Subwindow中分别选择左右两个窗口，在其中分别使用功能面板按钮的Fcomp>Misc>pressure，绘制钢板刚落入水中以及钢板完全没入水中某时刻的压力分布情况，如图9-20所示。




图9-20　不同时刻的压力分布情况

在功能面板中选择Find，如图9-21（a）所示，在Find面板中选择Part，Show Only，填写Part号3，点Find按钮，在图形窗口中仅显示Part3，如图9-21（b）所示。




图9-21　查找Part3

在功能区选择History，在History面板中选择Part类型及Y-Rigid Body Velocity，点Plot按钮，在Plot Window-1中绘制钢板落水前后的速度时间历程曲线，如图9-22所示。




图9-22　钢板落水前后速度变化情况

2.LS-DYNA关键字文件PLATE.K

本节钢板落水计算采用的LS-DYNA关键字文件PLATE.K如下，供练习过程对照参考，节点、单元定义部分有删减。














第10章　动态接触与冲击分析例题

本章结合实例介绍LS-DYNA的动态接触及冲击分析，包括刚性物块撞击柔性板以及钢管的冲击屈曲分析等计算实例。


10.1　刚性块与柔性挡板之间的撞击


10.1.1　问题描述

如图10-1所示的系统，向右为x轴正方向，向上为z轴正方向。左边物块尺寸（x×y×z）为20cm×10cm×5cm，右边物块尺寸为10cm×10cm×5cm，底座尺寸为300cm×10cm×15cm，右侧软挡板的尺寸为2.5cm×10cm×7.5cm。左边物块左侧面距离底座左端面0.5m，右边物块左侧面距离底座左端面2.0m，挡板右侧与底座右端面对齐。物块为合金材料，密度2700kg/m 3
 ，弹性模量70000MPa；挡板材料为塑料，密度1050kg/m 3
 ，弹性模量1000MPa；底座材料为钢，密度7850kg/m 3
 ，弹性模量200000MPa。如果左边物块沿着基座表面以恒定速度3.0m/s向右水平运动，计算开始到0.7s的系统响应。计算中基座视作刚体，物块及挡板视作变形体。




图10-1　分析系统示意图


10.1.2　前处理

前处理在ANSYSWorkbench环境中进行，主要过程包括建立分析项目和流程、材料属性定义、几何建模、分析模型前处理、加载及分析设置、输出K文件等环节。

1.建立分析项目和流程

（1）启动ANSYSWorkbench，通过File>Save As保存分析项目文件impact.wbpj，项目名称impact出现在Workbench标题栏，如图10-2所示。




图10-2　保存后显示的分析项目名称

（2）在Workbench的Toolbox中选择Explicit Dynamics（LS-DYNAExport）显式前处理系统，用鼠标左键将其拖放至Project Schematic中，如图10-3（a）、（b）所示。




图10-3　添加显式前处理系统

2.定义材料属性

在Project Schematic中双击A2Engineering Data单元格，进入Engineering Data截面定义材料及其属性。

（1）选择单位制

通过菜单Units，选择工作单位系统为Metric（tonne，mm，s，℃，mA，N，mV），选择Display Valuesin Project Units，如图10-4所示。

（2）添加材料类型

在Outline的Clickheretoaddanewmaterial单元格填写新材料名称MAT-1，如图10-5所示，按回车确认。按相同操作继续添加新材料MAT-2和MAT-3，添加完成后如图10-6所示。




图10-4　选择单位制




图10-5　添加新材料名称




图10-6　添加三种新材料

（3）添加材料属性

①为MAT-1材料添加Density属性

在Toolbox的Physical Properties中选择Density，用鼠标的左键将其拖放至ALLOY材料名称所在的单元格中，如图10-7所示，为ALLOY材料添加密度属性。




图10-7　为MAT-1添加密度属性

②为MAT-1材料添加Isotropic Elasticity属性

继续按照同样的操作方法，用鼠标左键点选Linear Elastic下的Isotropic Elasticity向MAT-1材料添加Isotropic Elasticity属性，如图10-8所示。




图10-8　为MAT-1添加Isotropic Elasticity属性

③为MAT-2及MAT-3材料添加属性

采用类似的操作方法，为MAT-2及MAT-3材料也添加Density属性和Isotropic Elasticity属性。

（4）定义材料数据

①定义MAT-1材料的数据

在MAT-1的Density中输入密度2700kg/m 3
 ，点Isotropic Elasticity前面的加号展开，在Young＇s Modulus输入弹性模量7e+10Pa，在Poisson＇sRatio输入泊松比0.33；定义完成后如图10-9所示。




图10-9　定义MAT-1的材料数据

②定义MAT-2材料的数据

在MAT-2的Density中输入密度1050kg/m 3
 ，点Isotropic Elasticity前面的加号展开，在Young＇s Modulus输入弹性模量1e+9Pa，在Poisson＇s Ratio输入泊松比0.4；定义完成后如图10-10所示。




图10-10　定义MAT-2的材料数据

③定义MAT-3材料的数据

在MAT-3的Density中输入密度7850kg/m 3
 ，点Isotropic Elasticity前面的加号展开，在Young＇s Modulus输入弹性模量2e+11Pa，在Poisson＇s Ratio输入泊松比0.3；定义完成后如图10-11所示。

（5）退出Engineering Data

以上材料属性及数据定义完成后，关闭Engineering Data，返回Workbench的Project Schematic界面下。

3.建立几何模型

在Workbench的Project Schematic中选择A3：Geometry单元格，双击此单元格启动DM几何建模界面，按如下的操作步骤完成几何建模。

（1）选择建模单位




图10-11　定义MAT-3的材料数据

通过Units菜单选择建模长度单位为cm，如图10-12所示。

（2）创建草图

在模型树中选择XYPlane，按下工具栏上的New Sketch按钮 
 三次，在XYPlane上创建三个草图Sketch1、Sketch2以及Sketch3，模型树显示如图10-13所示。




图10-12　选择建模长度单位




图10-13　创建的草图分支

下面依次绘制各个草图。

①在XY平面创建Sketch1

按如下的具体步骤进行操作。

a.按下工具栏上的 
 按钮，正视XY平面。

b.选择Tree Outline模型树中的Sketch1，按下Sketching标签切换至草图绘制状态。

c.在草绘工具箱的Draw面板中选择Rectangle按钮，在XY平面第一象限中以X轴为底边（出现C字样）绘制第一个矩形；在上面矩形的右侧，同样以X轴为底边绘制第二个矩形。操作过程如图10-14（a）、（b）所示。

d.在草绘工具箱的Dimensions面板中选择Semi-Automatic，对Sketch1进行尺寸标注，标注标识如图10-15（a）所示。

e.在Details中定义各标注的具体尺寸如图10-15（b）所示。




图10-14　绘制草图1




图10-15　草图1尺寸标注

②在XY平面创建Sketch2

按如下的步骤进行操作。

a.Sketch1绘制完成后，切换至Modeling模式。

b.选择Tree Outline模型树中的Sketch2，按下Sketching标签切换至草图绘制状态。

c.在草绘工具箱的Draw面板中选择Rectangle按钮，在XY平面第一象限中以X轴为底边（出现C字样）绘制一个矩形，如图10-16所示。




图10-16　绘制草图2

d.在草绘工具箱的Dimensions面板中选择Semi-Automatic，对Sketch2进行尺寸标注，标注标识如图10-17（a）所示。

e.在Details中定义草图2各标注的具体尺寸如图10-17（b）所示。




图10-17　草图2尺寸标注

③在XY平面创建Sketch3

按照如下步骤进行操作。

a.Sketch2绘制完成后，切换至Modeling模式。

b.选择Tree Outline模型树中的Sketch3，按下Sketching标签切换至草图绘制状态。

c.在草绘工具箱的Draw面板中选择Rectangle按钮，在XY平面第一象限中以原点为顶点（出现P字样）绘制一个矩形，如图10-18所示。

d.在草绘工具箱的Dimensions面板中选择Semi-Automatic，对Sketch3进行尺寸标注，标注标识如图10-19（a）所示。

e.在Details中定义各标注的具体尺寸如图10-19（b）所示。




图10-18　绘制草图3




图10-19　草图3尺寸标注

完成绘制及标注后的3个sketch如图10-20所示。草图绘制完成后返回至Modeling模式。




图10-20　绘制完成后的3个草图

（3）建立两个滑块

在工具栏上按下Extrude按钮，在Tree Outline中添加一个Extrude1分支，此分支的Details中，选择Geometry为Sketch1，单击Apply；Operation为Add Material；拉伸长度FD1为5cm；如图10-21所示。单击工具栏上的Generate按钮，形成两个滑块，如图10-22所示。

（4）建立挡板

在工具栏上按下Extrude按钮，在Tree Outline中添加一个Extrude2分支，此分支的Details中，选择Geometry为Sketch2，单击Apply；Operation为Add Material；拉伸长度FD1为7.5cm；如图10-23所示。单击工具栏上的Generate按钮，形成挡板，如图10-24所示。




图10-21　Extrude1分支的Details设置




图10-22　形成的滑块体




图10-23　Extrude2分支的Details设置




图10-24　形成挡板后的模型

（5）建立底座

在工具栏上按下Extrude按钮，在Tree Outline中添加一个Extrude3分支，此分支的Details中，选择Geometry为Sketch3，单击Apply；Operation为Add Frozen；Direction选择Reversed；拉伸长度FD1为15cm；如图10-25所示。单击工具栏上的Generate按钮，形成底座几何体，如图10-26所示。




图10-25　Extrude3分支的Details设置

上述建模操作完成后，关闭DM，返回Workbench界面中，此时Model单元格的状态图标变成待刷新的符号，如图10-27所示。

4.分析模型前处理

在Project Schematic中双击Model单元格，打开Mechanical界面。按照如下操作步骤进行前处理操作。




图10-26　完成后的几何模型




图10-27　几何建模完成后的系统状态

（1）Geometry分支

在Geometry分支中选择前面两个SOLID（按住Ctrl键多选），单击Details中Material Assignment右侧的三角形，在材料列表中选择MAT-1；在Stiffness Behavior中选择Rigid，如图10-28所示。




图10-28　指定滑块特性

在Geometry分支中选择第三个SOLID，在Details中选择材料为MAT-2，在Stiffness Behavior中选择Flexible，如图10-29所示。




图10-29　指定挡板特性

在Geometry分支中选择第四个SOLID，在Details中选择材料为MAT-3，在Stiffness Behavior中选择Rigid，如图10-30所示。




图10-30　指定底座特性

（2）Connections分支

通过右键菜单Suppress抑制Contact目录下的所有接触区域Contact Region分支。在Connections分支右键菜单中选择Insert>Body Interaction，加入Body Interaction分支，在其Details中，修改Type类型为Frictionless。

（3）Mesh分支

选择Mesh分支，在图形区域选择除挡板外的其他三个体，在鼠标右键菜单中选择Insert>Sizing，加入Body Sizing分支，在Body Sizing分支的Details中设置Element Size为25mm，如图10-31所示。




图10-31　Body Sizing设置

选择Mesh分支，在图形区域选择挡板体，在鼠标右键菜单中选择Insert>Sizing，加入Body Sizing2分支，在Body Sizing2分支的Details中设置Element Size为6.25mm，如图10-32所示。




图10-32　Body Sizing2设置

选择Mesh分支，在其右键菜单中选择Generate Mesh，划分形成的网格如图10-33所示。




图10-33　网格模型

5.加载以及分析选项设置

选择Analysis Settings分支，在Details中的Step Controls中指定End Time为0.7s；在Solver Controls中选择Hex Integration Type为1pt Gauss；在Output Controls中选择Save Resultson Time，且间隔为0.01s。

在图形窗口中选择基座体，鼠标右键菜单中选择Insert>Fixed Support，在项目树的Explicit Dynamics（A5）分支下插入一个Fixed Support分支。

在图形窗口中选择挡板的右侧表面，鼠标右键菜单中选择Insert>Fixed Support，在项目树的Explicit Dynamics（A5）分支下插入一个Fixed Support2分支。

选择左边的滑块体，鼠标右键菜单中选择Insert> Velocity，在项目树的Explicit Dynamics（A5）分支下插入一个Velocity分支，选择此分支，在其Details中选择Define By Components，设置XComponent为3000mm/s，如图10-34（a）所示。施加速度后模型显示如图10-34（b）所示。




图10-34　施加速度

在图形窗口中选择两个滑块的前表面，鼠标右键菜单中选择Insert>Displacement，在项目树的Explicit Dynamics（A5）分支下插入一个Displacement分支，选择此分支，在其Details中选择Define By Components，设置YComponent为0，如图10-35所示。




图10-35　施加边界条件

在项目树中选择Explicit Dynamics（A5）分支，鼠标右键菜单中选择Insert>Standard Earth Gravity，在Explicit Dynamics（A5）分支插入一个Standard Earth Gravity分支，在其Details中设置Direction为-ZDirection，如图10-36所示。

6.输出关键字文件

上述设置完成后，通过工具栏上的Solve按钮求解即可输出LS-DYNA关键字文件，将此文件以impact.k为文件名复制到一个新建的计算目录中。




图10-36　施加重力加速度


10.1.3　求解及后处理

1.求解

按照如下的步骤完成求解过程。

（1）打开Mechanical APDLProduct Launcher。

（2）在Product Launcher左上角的Simulation Environment中选择LS-DYNASolver，License中选择相应的授权，如图10-37所示。




图10-37　选择模块授权

（3）在FileManagement标签下的Working Directory中设置工作路径为新建的计算目录，在Keyword Input File中通过Browse按钮浏览指向本次分析的关键字文件impact.k，如图10-38所示。




图10-38　选择工作路径及关键字文件

（4）切换到Customization/Preferences标签，设置Memory和Numberof CPUs，注意CPU设置不仅依赖于硬件核数，也与授权的并行计算核数有关。

（5）点Product Launcher下面的Run按钮，即递交LS-DYNA求解器开始计算。

2.后处理

按照如下步骤完成计算结果的后处理操作。

在Windows开始菜单的LS-Prepost-4.0程序组中选择LS-Prepost-4.0，启动LS-Prepost，按Ctrl+F11切换至传统模式。打开计算目录下的d3plot文件，选择Left视图。各个体在一系列不同时刻的位置如图10-39所示。




图10-39　结构动态作用过程

后处理功能面板（右侧工具栏第1页）中选择History按钮，选择Nodal和x-velocity，选择小滑块右上部的顶点5510，按下Plot按钮，绘制小滑块的X方向速度时间历程曲线如图10-40所示。




图10-40　滑块X方向速度时间历程曲线

在History面板中继续选择Element和Effective Stress（v-m），选择挡板中部与滑块接触的单元3364，绘制等效应力时间历程曲线，如图10-41所示。




图10-41　挡板中心处的等效应力时间历程


10.2　钢管冲击屈曲分析


10.2.1　问题描述

悬臂合金矩形钢管柱，轴线长度为1500mm，横截面宽度、高度分别为150mm、200mm，各角点的倒角半径为20mm，截面管壁厚为5mm。截面形状如图10-42所示。

管柱材料为合金，弹性模量为70000MPa，泊松比为0.3，屈服强度为290MPa，理想塑性材料。假设此合金管柱的自由端部受到轴向冲击作用，在5ms时间内发生轴向压缩位移1000mm，分析整个管柱的冲击受力过程。




图10-42　合金管柱横截面


10.2.2　前处理

前处理在ANSYSWorkbench环境中进行，主要过程包括建立分析项目和流程、材料属性定义、几何建模、分析模型前处理、加载及分析设置、输出K文件等环节。

1.建立分析项目和流程

（1）启动ANSYSWorkbench，通过File>Save As保存分析项目文件buckling.wbpj，项目名称buckling出现在Workbench标题栏，如图10-43所示。




图10-43　保存后显示的分析项目名称

（2）在Workbench的Toolbox中选择Explicit Dynamics（LS-DYNAExport）显式前处理系统，用鼠标左键将其拖放至Project Schematic中，如图10-44（a）、（b）所示。

2.定义材料属性

（1）指定单位

通过菜单Units，选择工作单位系统为Metric（tonne,mm,s,℃,mA,N,mV）,选择Display Valuesin Project Units，如图10-45所示。




图10-44　添加显式前处理系统




图10-45　指定单位制

（2）添加新材料

在Outline的Clickheretoaddanew material单元格填写新材料名称ALLOY，按回车确认，如图10-46所示。

（3）为新材料指定参数

在Toolbox的Physical Properties中选择Density，用鼠标的左键将其拖放至ALLOY材料名称所在的单元格中，如图10-47所示，为ALLOY材料添加密度属性。




图10-46　添加新材料名称




图10-47　为材料添加密度属性

继续按照同样的操作方法，向ALLOY材料添加Isotropic Elasticity属性以及Bilinear Isotropic Hardening属性，并在各单元格中填写参数，如图10-48所示。选择Bilinear Isotropic Hardening项目后，在界面右下角的图形区显示材料的应力-应变关系曲线，如图10-49所示。




图10-48　输入材料参数

3.建立几何模型

按照如下步骤建立几何模型。

（1）启动DM并指定建模单位

用鼠标点选A2（Geometry）组件单元格，在其右键菜单中选择“New Design Modeler Geometry”，启动DM建模组件，如图10-50所示。




图10-49　合金材料的应力-应变关系曲线




图10-50　启动DM

在DM启动时弹出的对话框中或在启动后通过Units菜单（15.0以后版本）选择建模的长度单位为，如图所示。

（2）选择建模平面并创建草图

按照如下步骤进行操作。

①在XY平面新建草图

在Geometry树中单击XYPlane，选择XY平面为草图平面，接着选择草图按钮新建草图，为了便于操作，单击正视按钮，选择正视自己的工作平面。

②绘制矩形

切换到草绘模式，进入绘图工具箱，选择Rectangle（勾选Auto-Fillet）按钮画一矩形，然后在右边的图形界面上光标改变为画笔形状，单击拖动画笔绘制一个矩形，注意此矩形的四个顶点分别位于不同的象限内，以方便后续的标注，如图10-52（a）、（b）所示。




图10-51　指定建模长度单位




图10-52　绘制矩形草图

③矩形尺寸标注

选中草图工具箱的Dimensions中的Semi-Aotomatic标签，对矩形及倒圆角尺寸进行标注，如图10-53（a）、（b）、（c）所示。




图　10-53




图10-53　设置矩形尺寸

（3）创建拉伸

草绘结束后，切换至Modeling模式。在工具栏按下Extrude按钮，在Tree Outline中添加一个Extrude1分支，此分支的Details中，选择Geometry为Sketch1，单击Apply；Operation为Add Material；拉伸长度FD1为1500mm；如图10-54所示。单击工具栏上的Generate按钮，形成管柱模型，如图10-55所示。




图10-54　Extrude1的Details设置

上述建模操作完成后，关闭DM，返回Workbench界面中，此时Model单元格的状态图标变成待刷新的符号，如图10-56所示。

4.分析模型前处理

在Project Schematic中双击Model单元格，打开Mechanical界面。按照如下操作步骤进行前处理操作。

（1）Geometry分支




图10-55　几何模型




图10-56　几何创建完成后的系统状态

在Geometry分支下选择Surface Body分支，在其Details中指定Thickness为2.0mm，Material Assignment为ALLOY，如图10-57所示。




图10-57　Geometry分支

（2）Connections分支

在Project树中，选择Model分支，在其右键菜单中选择Insert>Connections，如图10-58所示。在Model分支下增加Connections分支。




图10-58　加入Connections分支

选择Connections分支，在其右键菜单中选择Insert>Body Interaction，如图10-59（a）所示，在Connections分支下出现Body Interactions分支，在Body Interactions分支下包含一个Body Interaction分支，如图10-59（b）所示。




图10-59　加入Body Interaction

在Body Interaction分支的Details中设置Friction Coefficient和Dynamic Coefficient为0.1，如图10-60所示。

（3）Mesh分支

按照如下步骤进行Mesh操作。




图10-60　设置Body Interaction分支属性

选择Model分支，在右键菜单中选择Insert>Named Selection，如图10-61所示，在Project树中新增一个Named Selections分支，此分支下包含一个Selection分支。




图10-61　加入Named Selection

选择Selection分支，在其Details中设置Scoping Method为Worksheet，则自动切换至Worksheet视图，在其中的表格区域打开右键菜单，选择AddRow，按照图10-62所示的参数进行设置，然后按Worksheet中的Generate按钮形成命名选择集合，显示如图10-63所示。




图10-62　命名集合Selection的Worksheet设置

选择Mesh分支，在其右键菜单中选择Insert>Sizing，如图10-64所示，在模型树中加入一个Sizing分支。

在Sizing分支的Details中，选择Scoping Method为Named Selection，在Named Selection中选择之前创建的集合Selection，选择Type为Numberof Divisions并设置Numberof Divisions为3，如图10-65所示。




图10-63　命名选择集合Selection




图10-64　加入Sizing分支




图10-65　Edge Sizing设置

再次选择Mesh分支，通过右键菜单Insert>Sizing加入另一个Sizing分支，在此Sizing分支的Details中选择Scoping Method为Geometry Selection，在模型中选择如图10-66所示的4个面，在Details的Geometry区域点Apply按钮，选择Type为Element Size，输入Element Size为10mm，如图10-67所示。




图10-66　选择用于设置Sizing的面




图10-67　Face Sizing设置

选择Mesh分支，在右键菜单中选择Insert>Mapped Face Meshing，如图10-68所示，在Mesh分支下加入一个Mapped Face Meshing分支。




图10-68　加入面映射网格

选择Mapped Face Meshing分支，在其Details中选择Scoping Method为Geometry Selection，在工具栏中选择Box Select，如图10-69（a）所示。在图形区域框选所有的面，然后在Mapped Face Meshing分支的Details中单击Geometry项中的Apply按钮，此时Geometry显示8Faces，如图10-69（b）所示。




图10-69　选择面映射划分的面

选择Mesh分支，在右键菜单中选择Generate Mesh，形成网格如图10-70所示。




图10-70　网格模型

5.加载以及分析选项设置

按照如下的步骤进行加载及分析选项设置。

（1）创建命名选择集合

①创建柱固定端所有线段集合

选择Named Selections分支，右键菜单中选择Insert>Named Selection，如图10-71所示，在Named Selections分支下增加一个Selection2分支，在Selection2分支的Details中选择Scoping Method为Worksheet，切换至Worksheet视图。

在Selection2的Worksheet视图中添加行，如图10-72（a）所示，按图10-72（b）所示进行设置，选择所有Z=0的边（管柱的固定端），然后单击Generate按钮，这时Selection2的Details中显示Geometry为8Edges，如图10-72（c）所示。




图10-71　加入Named Selection




图10-72　指定Selection2分支及其属性

②创建柱的自由端所有线段集合

按相同的操作，新增一个Selection3分支，按照图10-73（a）进行设置选择Z=1500mm的所有边（柱的自由端），单击Generate按钮，Selection3分支的Details中显示Geometry也是8Edges，如图10-73（b）所示。

（2）施加约束及荷载

①合金管的底部施加固定约束

在Explicit Dynamics（A5）分支右键菜单中选择Insert> Fixed Support，如图10-74所示，在项目树的Explicit Dynamics（A5）分支下插入一个Fixed Support分支。




图10-73　指定Selection3分支及其属性




图10-74　加入Fixed Support

在Fixed Support分支的Details中，选择Scope Method为Named Selection，Named Selection选择Selection2，如图10-75所示。




图10-75　Fixed Support设置

②柱自由端施加冲击位移

在Explicit Dynamics（A5）分支右键菜单中选择Insert>Displacement，如图10-76所示，在Explicit Dynamics（A5）分支下增加一个Displacement分支，在Displacement分支的Details中，Scope Method选择Named Selection，Named Selection选择Selection3；Define By选择Components；在XComponent和YComponent中直接填写0mm，如图10-77所示；选择ZComponent，点其右端的三角形按钮，在弹出的选项菜单中选择Tabular，如图10-78（a）所示，然后在界面右下方的Tabular Data中填写Z向位移数表，如图10-78（b）所示。




图10-76　加入Displacement分支




图10-77　Displacement分支的Details设置




图　10-78




图10-78　定义位移表格

（3）设置分析选项

选择Analysis Settings分支，在Details中的Step Controls中指定End Time为0.005s，指定Maximum Energy Error为10%；在Solver Controls中选择Full Shell Integration为No；在Output Controls中选择Save Resultson Equally Spaced Points，且点数为50。

6.输出关键字文件

上述设置完成后，通过工具栏上的Solve按钮求解即可输出LS-DYNA关键字文件，将此文件以buckling.k为文件名复制到一个新建的计算目录中。


10.2.3　求解及后处理

1.求解

按照如下步骤完成求解。

（1）打开Mechanical APDLProduct Launcher。

（2）在Product Launcher左上角的Simulation Environment中选择LS-DYNASolver，License中选择相应的授权。

（3）在File Management标签下的Working Directory中设置工作路径为新建的计算目录，在Keyword Input File中通过Browse按钮浏览指向本次分析的关键字文件buckling.k，如图10-79所示。




图10-79　File Management标签设置

（4）切换到Customization/Preferences标签，设置合适的Memory和Numberof CPUs。注意CPU设置不仅依赖于硬件核数，也与授权的并行计算核数有关。

（5）点Product Launcher下面的Run按钮，即递交LS-DYNA求解器开始计算。

2.后处理

计算完成后，按照如下步骤完成计算结果的后处理操作。

在Windows开始菜单的LS-Prepost-4.0程序组中选择LS-Prepost-4.0，启动LS-Prepost，按Ctrl+F11切换至传统模式，打开计算目录下的d3plot文件。

在右侧功能区第1页按钮中选择Split W，在Window Configuration中选择2×2，如图10-80所示。通过Drawto Subwindow选择绘制图形的子窗口，如图10-81所示。




图10-80　2×2分窗口视图




图10-81　子窗口绘图

通过动画观察，在不同的分窗口绘制一系列不同时刻的结构变形情况，如图10-82所示。




图10-82　结构在不同时刻的变形情况

在各分窗口中，通过Split W面板的Drawto Subwindow选择各窗口，然后选择功能面板的Fcomp>Stress>Von-Misesstress，绘制一系列时刻结构等效应力分布情况如图10-83所示。




图10-83　结构在不同时刻的等效应力分布情况


第11章　侵彻分析例题

侵彻是一类可通过LS-DYNA分析的典型非线性动力问题。本章以一个子弹击穿双层钢板的动力问题分析为例介绍侵彻分析的实现方法，内容包括问题描述、建立分析模型、第一次分析、重启动分析及后处理、分析的关键字文件等。


11.1　问题描述

一个直径15mm、长45mm的子弹以1000m/s的初速度垂直射向两层钢板，钢板尺寸均为150mm×150mm×8mm，钢板间距为55mm，如图11-1所示。

子弹击穿钢板包括两个受力阶段：第一阶段为0～6e-5s时间内击穿第一块钢板，第二阶段为在6e-5s～1.8e-4s时间内击穿第二块钢板。本例题计算过程中首先分析第一个阶段，然后以第一阶段结束的应力状态为起点，通过完全重启动分析来完成第二阶段分析。

本次分析将采用ANSYS Workbench中的显式动力学前处理系统建立分析模型并写出K文件，然后提交给LS-DYNA求解器进行求解，最后在LS-Pre Post中对分析结果进行相关后处理操作。




图11-1　子弹及钢板尺寸（单位：mm）


11.2　建立分析模型


11.2.1　创建工作系统及定义材料属性

按照如下步骤进行操作。

1.启动ANSYSWorkbench操作界面，选择File>Save，以“Bullet Penetration”作为名称保存分析项目文件。

2.创建显式前处理系统

在Workbench的工具箱中选择Component Systems中的Explicit Dynamics（LS-DYNA Export），将其拖至右侧的项目图解窗口中，如图11-2所示。

3.定义材料参数

（1）双击A2Engineering Data单元格，进入Engineering Data界面；




图11-2　显式动力学分析系统

（2）选择Engineering Data Source按钮 
 ；

（3）在Engineering Data Source表格中选中Explicit Materials；

（4）在Outlineof Explicit Materials表格中，转动滚轮定位至STEEL1006，单击其右侧的 
 ，将其添加至当前材料；

（5）再次单击Engineering Data Source按钮 
 ，可以看到此时的Engineering Data中包括STEEL1006和Structural Steel两种材料；

（6）选中STEEL1006，然后双击窗口左侧的Toolbox>Failure>Johnson Cook Failure，并在STEEL1006的材料明细表格中输入相关参数取值，D1：-0.8、D2：2.1、D3：-0.5、D4：0.0002、D5：0.61、Melting Temperature：1400、ReferenceStrainRate（/sec）：1，如图11-3所示；

（7）单击Return To Project或关闭Engineering Data，返回Workbench界面。




图11-3　STEEL1006材料属性


11.2.2　建立几何模型

按照如下步骤创建几何模型。

1.启动DM并选择建模长度单位

双击A3Geometry启动DM，选择“mm”作为建模长度单位。

2.绘制子弹草图

选中结构树中的XYPlane，单击Sketching标签打开草图绘制工具箱，然后在XY平面上绘制子弹草图，具体操作如下：

（1）单击Draw>Circle，以坐标原点为圆心绘制一个圆（鼠标放置于原点位置时会出现“P”字符）；

（2）单击Dimension>General，对圆环进行标注；

（3）在左侧Details中，输入圆直径为15mm。

3.创建子弹实体

选择工具栏中的Extrude按钮，拉伸子弹草图创建子弹体的几何模型，具体操作如下：

（1）在Details中的Geometry项中选定子弹草图Sketch1；

（2）确保Operation为Add Material，Direction为Normal，Extent Type为Fixed；

（3）输入FD1，Depth（>0）为45mm；

（4）单击工具栏中的Generate工具，完成子弹几何模型的创建，如图11-4所示。




图11-4　创建子弹几何模型

4.创建子弹尖端倒角

（1）选择Create>Chamfer菜单项目，在Tree Outline中增加一个Chamfer1分支；

（2）在Chamfer1分支的Details中，在Geometry中拾取-Z方向单端端边；

（3）更改Type为Left-Right；

（4）输入FD1，Left Length（>0）为15mm，输入FD2，Right Length（>0）为4mm；

（5）单击Generate，完成倒角的穿件，如图11-5所示。




图11-5　创建子弹尖端倒角

5.创建钢板草绘平面

单击工具栏中的创建新平面工具 
 ，创建钢板草绘平面，具体设置如下：

（1）在Base Plane一项中选择结构树中的XYPlane；

（2）更改Transform1（RMB）为Offset Z，输入FD1，Value1为-5mm；

（3）单击工具栏中的Generate工具，完成钢板草绘平面的创建，如图11-6所示。




图11-6　创建钢板草绘平面

6.创建钢板草图

选中上一步创建的Plane1，单击Sketching标签切换至草图模式并创建钢板草图，具体操作步骤如下：

（1）单击Draw>Rectangle，绘制一个矩形；

（2）单击Constraints>Symmetry，依次选择Y轴、矩形的两个竖直边，添加对称约束；

（3）单击Constraints>Symmetry，依次选择X轴、矩形的两个水平边，添加对称约束；

（4）单击Dimension>General，标注圆直径及矩形的两个边长；

（5）在左侧Details中，输入矩形横边长度、竖直边长度为150mm；如图11-7所示。




图11-7　绘制钢板草图

7.形成钢板实体

单击工具栏中的Extrude工具，拉伸钢板草图，创建钢板几何模型，具体操作如下：

（1）在Details中的Geometry项中选定钢板草图Sketch2；

（2）确保Operation为Add Material，Direction为Reversed，Extent Type为Fixed；

（3）输入FD1，Depth（>0）为8mm；

（4）单击工具栏中的Generate工具，完成钢板几何模型的创建，如图11-8所示；




图11-8　创建钢板几何模型

（5）单击Create>Body Transformation>Translate；

（6）在Details中，将Preserve Bodies更改为Yes；

（7）更改Direction Definition为Coordinates，并输入FD5，ZOffset为-63mm；

（8）单击Generate，完成第二块钢板几何模型的创建，如图11-9所示。




图11-9　创建第二块钢板的几何模型

8.创建1/2子弹及钢板几何模型

具体操作如下：

（1）单击Create>Slice；

（2）将Slice Type改为Sliceby Plane；

（3）在Base Plane中选择YZPlane；

（4）Slice Targets选择All Bodies；

（5）单击Generate，完成分割操作；

（6）在结构树中选中+Z方向的子弹及钢板模型，单击鼠标右键选择Suppress Body，然后分别重命名剩余的子弹及钢板模型为Bullet、Plate1和Plate2，如图11-10所示。




图11-10　创建1/2子弹及钢板几何模型

9.保存几何模型并退出DM

保存几何模型，关闭DM，返回Workbench界面。


11.2.3　网格划分

按照如下步骤进行网格划分操作。

1.启动Mechanical界面

在Workbench中，双击A4Model单元格，启动Mechanical界面。

2.Geometry分支

依次分别选中结构树中的Model>Geometry，按Ctrl键选中子弹及钢板模型，并在Details中将Material>Assignment改为“STEEL1006”，如图11-11所示。

3.Connections分支

选择结构树中的Connections>Body Interactions>Body Interaction，然后将Definition>Type改为Frictional，输入Friction Coefficient为0.15，Dynamic Coefficient为0.1，如图11-12所示。如果Connections分支下包含Contact Region分支，将其全部抑制。




图11-11　指派材料




图11-12　定义接触关系

4.总体Mesh设置

选中结构树中的Model>Mesh分支，在其Details中，确保Sizing下的Use Advanced Size Function为Off，Relevance Center为Medium，其他选项采用缺省设置。

5.局部Mesh尺寸设置

选中Mesh分支，在上下文工具栏中选择Mesh Control>Sizing，然后在加入的Sizing分支的Details中进行如下设置：

（1）在Scope>Geometry中选择两个钢板；

（2）确保Definition>Type为Element Size，并输入Element Size为2mm，如图11-13所示；

（3）参照上一步操作，为子弹+Z方向的半圆面添加Face Sizing为2mm。

6. Mesh方法设置

在工具栏中选择Mesh Control>Method，然后在加入的Method分支的Details中进行如下设置：

（1）在Scope>Geometry中选择子弹模型；

（2）更改Definition>Method为Multi Zone；

（3）更改Surface Mesh Method为Uniform，如图11-14所示。




图11-13　钢板尺寸控制明细设置




图11-14　Multi Zone网格控制明细设置

7.网格划分

鼠标右键单击结构树中的Mesh分支，选择Generate Mesh执行网格划分，离散后有限元模型如图11-15所示，共计包括30459个节点，23360个单元。




图11-15　子弹及钢板有限元模型

8.网格质量检测

更改Mesh分支Details下的Statics>Mesh Metric为Element Quality，可以看到当前网格全部为8节点六面体单元，如图11-16所示。




图11-16　网格质量

9.保存模型

单击File>Save Project，保存网格划分的结果。


11.3　第一次分析


11.3.1　分析设置及输出k文件

1.分析设置

选中结构树的Explicit Dynamics（A5）>Analysis Settings，在其Details中进行如下设置：

（1）在Step Controls>End Time中输入6e-5s；

（2）将Maximum Energy Error（%）改为0；

（3）在Time Step Safety Factor中输入0.6；

（4）将Damping Controls>Quadratic Artificial Viscosity改为1；

（5）在Output Controls>Numberof Points中输入200，其他选项保持缺省设置，如图11-17所示。




图11-17　求解设置

2.定义初始速度

鼠标右键单击Explicit Dynamics（A5）>Initial Conditions，然后选择Insert>Velocity，在Details中进行如下设置：

（1）在Scope>Geometry中选择子弹模型；

（2）确保Define By为Components，并输入ZComponent为-1000m/s，如图11-18所示。




图11-18　定义子弹初速度

3.施加周边固定边界条件

选中Explicit Dynamics（A5），在上下文工具栏中单击Supports>Fixed Support，在Details中的Geometry下选择两个钢板除剖分面外的6个侧面。

4.施加对称面边界条件

在上下文工具栏中单击Supports>Displacement，在Details中的Geometry下选择两个钢板及子弹的剖分面，然后更改Definition>Define By为Components，并输入XComponent为0，如图11-19所示。




图11-19　施加对称面的约束

5.抑制Plate2

因首次分析时的分析对象仅包括子弹及第一块钢板，故在结构树中选中Plate2，单击鼠标右键选择Suppress Body，将其抑制。

6.输出k文件

鼠标右键单击结构树中的Explicit Dynamics（A5），选择Solve，此时会提示“LS-DYNA keywordfilehasbeencreated”。

7.建立工作路径并复制k文件

（1）在Workbench中，确保View>Files处于勾选状态，在窗口下方的表格中右键单击名为“LSDYNAexport.k”的单元格并选择Open Containing Folder，打开其所在目录。

（2）新创建一个名为“First”的文件夹作为工作目录（路径中不包括中文字符），然后将上一步中的LSDYNAexport.k文件拷贝至该文件夹中。

8.退出Workbench

单击File>Save Project，保存分析项目，关闭Workbench。


11.3.2　 LS-DYNA求解

按照如下步骤进行求解。

1.启动Mechanical APDLProduct Launcher

通过开始菜单的ANSYS程序组，启动Mechanical APDLProduct Launcher。

2.选择分析类型

在Product Launcher中，Simulation Environment栏选择LS-DYNASolver，License选择为ANSYSLS-DYNA，Analysis Type选择Typical LS-DYNAAnalysis。

3.File Management标签

在File Management标签下，Working Directory设定为关键字文件所在的目录，Keyword Input File中指向工作目录下的LSDYNAexport.k文件，如图11-20所示。




图11-20　ANSYS启动窗口

4.开始计算

点Mechanical APDLProduct Launcher左下方的Run按钮，即可将关键字文件递交LS-DYNA求解程序并开始计算。

5.求解过程监控

在求解过程中，可以通过程序的输出窗口观察到单元失效的过程，采用SW2选择开关可以获取实时信息，图11-21为计算中单元失效时，屏幕输出窗口的显示内容：




图11-21　单元失效时的输出信息

求解完成后，屏幕输出窗口提示Normal Termination!，按任意键退出。


11.3.3　结果分析

本节将利用LS-Pre Post程序进行后处理操作。

1.启动LS-Pre Post-4.0

通过开始菜单启动LS-Pre Post-4.0程序。

2.导入结果文件

在菜单中单击File>Open>Binary Plot，打开工作目录下的二进制结果文件D3plot，将结果信息读入LS-Pre Post后处理器，在绘图区域出现计算模型。

3.观察侵彻过程的动画

通过动画播放控制台，可观察侵彻的整个动态过程。

单击菜单中的FEM>Modeland Part>Split Window，在Split Window面板的Window Configuration选项中选择2×2复选框，在Drawto Subwindow选项中，选择所需的Subwindow，在动画控制台中选择各个切分窗口中要显示的结果子步。

图11-22为子弹与钢板接触过程的一系列时间步的结果：




图11-22　子弹与钢板的侵蚀接触过程

图11-23为子弹击穿钢板前后的几个时间步的结果：




图11-23　子弹击穿钢板前后的变形情况

4.观察子弹内的等效应力分布

依次选中各个切分窗口并进行如下的操作：

（1）单击菜单中的FEM>Modeland Part>Assemblyand Select Part，在Part标签下选中1Bullet，然后单击Done；

（2）单击菜单中的FEM>Post>Fringe Component，在Fringe Component面板中，选择Stress下的Von Mises Stress，点Done按钮；利用动画播放控制台，选择所需显示的子步结果。

图11-24为一系列不同时刻子弹体内Von Mises等效应力等值线分布云图：




图11-24　Von-Mises应力分布

5.观察靶板的应力变化情况

依次选中各个切分窗口并进行如下的操作：

（1）单击菜单中的FEM>Modeland Part>Assemblyand Select Part，在Part标签下选中2Plate1，然后单击Done；

（2）单击菜单中的FEM>Post>Fringe Component，在Fringe Component面板中，选择Stress下的Von Mises Stress，点Done按钮；

（3）单击菜单中的FEM>Modeland Part>Reflect Model，选中Reflectabout YZplane后单击Done，将半个钢板镜像复制；

（4）利用动画播放控制台，选择所需显示的子步结果。

图11-25为一系列不同时刻钢板内Von Mises等效应力等值线分布云图：

6.观察子弹侵彻过程的塑性应变变化

（1）单击菜单中的FEM>Modeland Part>Assemblyand Select Part，在Part标签下选中1Bullet和2Plate1，然后单击Done；

（2）单击菜单中的FEM>Modeland Part>Reflect Model，取消模型镜像；

（3）单击菜单中的FEM>Post>Fringe Component，在Fringe Component面板中，选择Stress下的Plastic Strain，点Done按钮；

（4）利用动画播放控制台，选择所需显示的子步结果；

（5）单击菜单中的File>Movie，设定精度、保存路径及名称后单击Start按钮，将输出子弹侵彻过程塑性应变变化动画。




图11-25　钢板中的应力分布

图11-26为一系列不同时刻子弹侵彻钢板时的塑性应变分布云图：




图11-26　子弹侵彻钢板时的塑性应变分布云图

7.观察子弹体侵彻前后的速度变化历程

可以观察子弹上选定节点的速度时间历程曲线，以分析侵彻钢板前后子弹的速度变化情况。

比如：选择程序主菜单的FEM>Post>History，在History面板中，选中Nodal复选框，在绘图项目列表中选择Z-velocity，然后在图形显示窗口中拾取子弹剖面中间区域的一个节点，最后单击Plot按钮，此时弹出Plot Window-1窗口中绘出了该点的Z向速度时间历程，如图11-27所示。




图11-27　某节点的Z向速度时间历程曲线

8.观察子弹体在侵彻过程中的加速度历程

还可以观察子弹上选定节点的加速度时间历程曲线，以分析侵彻钢板前后子弹的加速度变化情况。

在History面板中的绘图项目列表中选择Z-acceleration，点面板最下面的Plot按钮，将弹出Plot Window-1窗口，该点的Z向加速度时间历程如图11-28所示。




图11-28　某节点的Z向加速度时间历程曲线

9.观察子弹侵彻过程中的能量变化

单击主菜单的FEM>Post>ASCII，在ASCII面板中选中glstat*，单击File打开工作目录中的glstat文件，在绘图列表中1-Kinetic Energy、2-Internal Energy、3-Total Energy、6-Hourglass Energy，然后单击Plot按钮，此时将弹出Plot Window-1窗口并绘出子弹侵彻钢板过程中的能量变化曲线，如图11-29所示。




图11-29　子弹侵彻过程中的能量变化曲线


11.4　重启动分析


11.4.1　分析设置及输出k文件

按照如下此步骤进行操作。

1.打开先前创建的Workbench分析项目wbpj文件。

2.启动Mechanical程序

在Workbench的Project Schematic中，双击A5Setup单元格启动Mechanical程序。

3.解除Plate2的抑制

在结构树中右键单击Model>Geometry>Plate2，选择Unsuppress Body，解除第二块钢板的抑制。

4.修改分析时间

在Explicit Dynamic（A5）> Analysis Settings>Step Controls>End Time中输入1.8e-4s，其他选项与先前设置一致。

5.导出k文件

鼠标右键单击结构树中的Explicit Dynamics（A5），选择Solve，此时会提示“LS-DYNA keywordfilehasbeencreated”。

6.建立重启动工作路径并复制文件

（1）在Workbench中，确保View>Files处于勾选状态，在窗口下方的表格中右键单击名为“LSDYNAexport.k”的单元格并选择Open Containing Folder，打开其所在目录。

（2）新创建一个名为“Restart”的文件夹作为工作目录（路径中不包括中文字符），然后将上一步中的LSDYNAexport.k文件拷贝至该文件夹中。

（3）打开第一次分析目录“First”文件夹，拷贝“d3dump01”文件至新的工作目录“Restart”文件夹下。

7.修改k文件

打开Restart文件夹下的LSDYNAexport.k文件，在文件末尾“*End”命令前添加一行命令“*STRESS_INITIALIZATION”，该命令用于初始化子弹及第一块钢板的应力状态，保存并关闭k文件。


11.4.2　执行重启动分析

按照如下步骤进行重启动分析。

1.启动Mechanical APDLProduct Launcher

通过开始菜单的ANSYS程序组，启动Mechanical APDLProduct Launcher。

2.选择分析类型及文件

（1）完全重启动类型选择

选择Simulation Environment为LS-DYNASolver，License选择为ANSYSLS-DYNA，Analysis Type选择Full Restart Analysis。

（2）File Management标签

在File Management标签下，Working Directory设定为关键字文件所在的目录，Keyword Input File中指向工作目录下的LSDYNAexport.k文件，Restart Dump File指向拷贝至工作目录的d3dump01文件，如图11-30所示。




图11-30　ANSYS启动窗口

3.重启动分析

按下Mechanical APDLProduct Launcher左下方的Run按钮，开始重启动分析。在求解过程中同样可以通过程序的输出窗口观察到单元失效的过程。采用SW2选择开关可以获取实时信息。求解完成后，屏幕输出窗口提示Normal Termination!，按任意键退出。


11.4.3　重启动分析后处理

按照如下步骤基于LS-Pre Post程序进行后处理操作。

1.启动LS-Pre Post-4.0

通过开始菜单启动LS-Pre Post-4.0程序。

2.导入结果文件

在菜单中单击File>Open>Binary Plot，打开工作目录下的二进制结果文件D3plotaa，将结果信息读入LS-Pre Post后处理器，在绘图区域出现计算模型，如图11-31所示。

3.观察侵彻的动态过程

单击菜单中的FEM > Modeland Part> Split Window，在Split Window面板的Window Configuration选项中选择2×2复选框，在Drawto Subwindow选项中，选择所需的Subwindow，在动画控制台中选择各个切分窗口中要显示的结果步。

图11-32为子弹与第二块钢板接触过程的一系列时间步的结果。




图11-31　导入LS-Pre Post的初始模型




图11-32　子弹与钢板的侵蚀接触过程

图11-33为子弹击穿钢板前后的几个时间步的结果。

4.观察子弹内的等效应力分布




图11-33　子弹击穿钢板前后的变形情况

依次选中各个切分窗口并进行如下的操作：

（1）单击菜单中的FEM>Modeland Part>Assemblyand Select Part，在Part标签下选中1Bullet，然后单击Done。

（2）单击菜单中的FEM>Post>Fringe Component，在Fringe Component面板中，选择Stress下的Von Mises Stress，点Done按钮；利用动画播放控制台，选择所需显示的子步结果。

图11-34为一系列不同时刻子弹体内Von Mises等效应力等值线分布云图。




图11-34　子弹中的等效应力分布

5.观察靶板的应力变化情况

依次选中各个切分窗口并进行如下的操作：

（1）单击菜单中的FEM>Modeland Part>Assemblyand Select Part，在Part标签下选中3Plate2，然后单击Done。

（2）单击菜单中的FEM>Post>Fringe Component，在Fringe Component面板中，选择Stress下的Von Mises Stress，点Done按钮。

（3）单击菜单中的FEM>Modeland Part>Reflect Model，选中Reflectabout YZplane后单击Done，将半个钢板镜像复制。利用动画播放控制台，选择所需显示的子步结果。图11-35为一系列不同时刻钢板内Von Mises等效应力等值线分布云图。




图11-35　钢板中的应力分布

6.观察子弹侵彻过程的塑性应变变化

（1）单击菜单中的FEM>Modeland Part>Assemblyand Select Part，在Part标签下选中1Bullet和3Plate2，然后单击Done。

（2）单击菜单中的FEM>Modeland Part>Reflect Model，取消模型镜像。

（3）单击菜单中的FEM>Post>Fringe Component，在Fringe Component面板中，选择Stress下的Plastic Strain，点Done按钮。

（4）利用动画播放控制台，选择所需显示的子步结果。

（5）单击菜单中的File>Movie，设定精度、保存路径及名称后单击Start按钮，将输出子弹侵彻过程塑性应变变化动画。图11-36为一系列不同时刻子弹侵彻钢板时的塑性应变分布云图。

7.观察子弹体侵彻前后的速度变化历程

可以观察子弹上选定节点的速度时间历程曲线，以分析侵彻钢板前后子弹的速度变化情况。比如：选择程序主菜单的FEM>Post>History，在History面板中，选中Nodal复选框，在绘图项目列表中选择Z-velocity，然后在图形显示窗口中拾取子弹剖面中间区域的一个节点，最后单击Plot按钮，此时弹出Plot Window-1窗口中绘出了该点的Z向速度时间历程，如图11-37所示。




图11-36　子弹侵彻钢板时的塑性应变分布云图




图11-37　某节点的Z向速度时间历程曲线

8.观察子弹体在侵彻过程中的加速度历程

观察子弹上选定节点的加速度时间历程曲线，可以分析侵彻钢板前后子弹的加速度变化情况。在History面板中的绘图项目列表中选择Z-acceleration，点面板最下面的Plot按钮，将弹出Plot Window-1窗口，该点的Z向加速度时间历程如图11-38所示。

9.观察子弹侵彻过程中的能量变化

单击主菜单的FEM>Post>ASCII，在ASCII面板中选中glstat*，单击File打开工作目录中的glstat文件，在绘图列表中1-Kinetic Energy、2-Internal Energy、3-Total Energy、6-Hourglass Energy，然后单击Plot按钮，此时将弹出Plot Window-1窗口并绘出子弹侵彻钢板过程中的能量变化曲线，如图11-39所示。




图11-38　某节点的Z向加速度时间历程曲线




图11-39　子弹侵彻过程中的能量变化曲线


11.5　关键字文件

本节给出两次分析的关键字文件，以便对照进行编辑和修改。


11.5.1　第一次分析的关键字文件























11.5.2　重启动分析的关键字文件




















第12章　多体动力学分析例题：凸轮机构

LS-DYNA求解器具备刚体运动及多体动力学分析能力。本章以一个凸轮机构的动力学分析为例介绍LS-DYNA的多体动力学分析实现方法，内容包括问题描述、建立分析模型、施加边界条件、分析设置、求解以及后处理。


12.1　问题描述

某凸轮简化结构如图12-1所示，该机构由凸轮、从动件和缓冲弹簧三个部件构成；凸轮以100r/min的转速逆时针旋转，从而推动从动件实现其竖直方向的往复运动；此外，从动件两侧面还受到竖直向下的力1000N。




图12-1　凸轮机构示意图

该凸轮机构的基本参数如表12-1所示。

表12-1　凸轮机构基本参数表




凸轮机构的运动过程由四个工作阶段组成，从动件运动规律遵循正弦曲线，该机构的运动过程和运动曲线如图12-1和图12-2所示。

其中，推程的运动方程式为：s=0.04 
 ，回程的运动方程式为：s=0.04 
 ，式中θ的单位为弧度。




图12-2　凸轮机构运动曲线图

本次分析中将采用Solid164单元模拟凸轮及从动件本体，Combi165单元模拟弹簧，因Solid164单元仅具有X、Y、Z三个方向的平动自由度，故引入六自由度的Shell163单元以便于凸轮转动速度及从动件竖向力的加载。

鉴于凸轮结构比较复杂，分析前将首先利用ANSYSDM通过点拟合的方式创建凸轮及从动件几何模型，然后将其导入ANSYSAPDL分析环境进行后续的建模、离散、加载及输出k文件等操作，最后提交k文件至ANSYS/LS-DYNA求解器求解，并在LS-Pre Post中完成相关的后处理操作。


12.2　建立分析模型


12.2.1　建立几何模型

本节将利用ANSYSDM模块建立凸轮及从动件的几何模型，并输出名为“tulun.x_t”的模型文件，具体操作步骤如下。

1.启动ANSYSWorkbench

通过开始菜单的ANSYS程序组启动ANSYSWorkbench。

2.创建几何组件

在Workbench窗口左侧的Toolbox>Component Systems中，拖动Geometry组件系统至右侧的项目图解窗口中，如图12-3所示。

3.启动DM并指定建模单位

双击A2Geometry单元格进入DM，选择“mm”作为建模的长度单位。




图12-3　DM组件系统

4.准备坐标文件

可以通过前一节中凸轮基本参数和推/回程方程式推导出凸轮外轮廓点的坐标值，然后每隔5°写出凸轮外轮廓点的坐标值并写入“Point.txt”文件，文件具体内容如下。










此文件基本解释如下：第1列表示曲线编号，第2列为点编号，第3～5列为相应点的X、Y、Z轴坐标值，列列之间用空格键或TAB键隔开，最后一行为0表示该曲线为闭合曲线。

5.创建凸轮轮廓3D曲线

在DM的主菜单中单击Concept>3DCurve，然后在Details中进行如下设置：

（1）更改Definition为From Coordinates File。

（2）在Coordinates File中指定名为“Point.txt”的文件（路径中不包括中文字符）。

（3）确保Coordinates Unit为Millimeter。

（4）确保Base Plane为XYPlane。

（5）单击Generate按钮，图形显示窗口中将绘出凸轮的外轮廓曲线，如图12-4所示。

6.创建轮的表面

单击主菜单中的Concept>Surfaces From Edges，然后在Details中的Edges项中选择上一步创建的曲线，单击Generate按钮创建表面。




图12-4　创建凸轮轮廓曲线

7.创建体

单击主菜单中的Create>Extrude，然后在Details中进行如下设置：

（1）Geometry项中选择上一步创建的表面。

（2）先在结构树中选中ZXPlane，然后在Direction Vector项中选择Z轴。

（3）更改Direction为Both-Symmetric。

（4）确保Extent Type为Fixed，输入FD1，Depth（>0）为15mm。

（5）单击Generate按钮，完成凸轮基本模型的创建，如图12-5所示。




图12-5　创建凸轮基本模型

8.面合并

单击主菜单中的Tools>Merge，然后在Details中将Merge Type改为Faces，并在Faces中选中凸轮被分割的两个侧面，单击Generate按钮，完成面合并操作。

9.创建开孔草绘

在结构树中选中XYPlane，单击Sketching标签，然后进行如下操作：

（1）单击Draw>Circle，以坐标原点为圆心绘制一个圆（出现“P”字符）。

（2）单击Dimensions>General，对圆进行标注并在Details中输入圆直径为40mm。

10.凸轮中心开圆孔

单击主菜单中的Create>Extrude，然后在Details中进行如下设置：

（1）在Geometry项中选择上一步创建的圆草图。

（2）更改Operation为Cut Material。

（3）更改Direction为Both-Symmetric。

（4）更改Extent Type为Through All。

（5）单击Generate按钮，创建凸轮中心圆孔，如图12-6所示。




图12-6　创建凸轮中心圆孔

11.创建平面

在结构树中选中ZXPlane，单击主菜单中的Create>New Plane，然后在Details中进行如下设置：

（1）更改Transform1（RMB）为Offset Global Y。

（2）输入FD1，Value1为80mm。

（3）单击Generate按钮，完成Plane1的创建，如图12-7所示。




图12-7　创建Plan1

12.创建从动件草图

在结构树中选中上一步创建的Plane1，单击Sketching标签，然后进行如下操作：

（1）单击Draw>Rectangle，绘制一个矩形。

（2）单击Constraints>Symmetry，首先选中Z轴作为对称轴，然后选择Z轴两侧的矩形边，建立两者相对Z轴的对称关系。

（3）单击Constraints>Symmetry，首先选中X轴作为对称轴，然后选择X轴两侧的矩形边，建立两者相对X轴的对称关系。

（4）单击Dimensions>General，标注矩形的长、宽，并在Details中输入值为180 mm、30mm。

13.创建从动件底座

单击主菜单中的Create>Extrude，然后在Details中进行如下设置：

（1）在Geometry项中选择上一步创建的草图。

（2）确保Operation为Add Material、Direction为Normal（结合图形显示窗口中的方向）。

（3）更改Extent Type为Fixed，输入FD1，Depth（>0）为20mm。

（4）单击Generate按钮，完成从动件底座的创建，如图12-8所示。




图12-8　创建从动件底座

14.创建草图

在结构树中选中Plane1，然后单击New Sketch 
 工具，创建一个新的草图，单击Sketching标签，然后进行如下操作：

（1）单击Draw>Rectangle，绘制一个矩形。

（2）单击Constraints>Symmetry，首先选中Z轴作为对称轴，然后选择Z轴两侧的矩形边，建立两者相对Z轴的对称关系。

（3）单击Constraints>Symmetry，首先选中X轴作为对称轴，然后选择X轴两侧的矩形边，建立两者相对X轴的对称关系。

（4）单击Dimensions>General，标注矩形的长、宽，并在Details中输入值为40 mm、30mm。

15.创建从动件底座上的拉伸体

单击主菜单中的Create>Extrude，然后在Details中进行如下设置：

（1）在Geometry项中选择上一步创建的草图。

（2）确保Operation为Add Material、Direction为Normal（结合图形显示窗口中的方向）。

（3）更改Extent Type为Fixed，输入FD1，Depth（>0）为100mm。

（4）单击Generate按钮，完成从动件几何模型的创建，如图12-9所示。

16.导出几何模型

展开结构树中最后一项，选中除凸轮及从动件外的其他对象，单击鼠标右键选择Suppress Body将其抑制，仅保留凸轮及从动件。选择主菜单中的File>Export，在弹出的对话框中选择保存路径，输入“tulun”作为文件名，更改保存类型为“Parasolid Text”。




图12-9　创建从动件几何模型


12.2.2　网格划分

本节包括以下几项操作内容：导入并对凸轮及从动件的几何模型进行离散，建立弹簧的有限元模型等内容。具体操作步骤如下：

1.启动Mechanical APDL

（1）由Windows程序组启动Mechanical APDLProduct Launcher。

（2）在Product Launcher中，Simulation Environment栏中选择ANSYS，License选择为ANSYSLS-DYNA。

（3）在File Management标签下，Working Directory中设定工作路径（不包括中文字符），输入Job Name为tulun，然后单击左下角的Run按钮，启动程序。

2.导入凸轮及从动件几何模型

（1）单击菜单File>Import>PARA，在弹出窗口的Directories中定位至上一节输出的“tunlun.x_t”文件所在的文件夹，然后在File Name中选中“tunlun.x_t”文件，单击OK。

（2）初次导入后模型显示为线框形式，单击菜单Plot Ctrls>Style>Solid Model Facets，在弹出的对话框中更改Style of area and volume plots为Normal Faceting。

（3）单击菜单Plot>Replot，此时窗口中绘出凸轮及从动件的几何模型，如图12-10所示。

3.模型简化

为了排除几何模型问题对后续网格划分质量的影响，此处将对模型质量进行检查并作相应的简化处理。

（1）在左侧的主菜单中依次单击Preprocessor>Numbering Ctrls>Merge Items，在弹出的对话框中将Label Type of item to be merge改为All，然后单击OK，合并重合对象。




图12-10　导入后的模型

（2）单击菜单Plot>Plot Lines显示所有边线，单击Plot Ctrls>Numbering，在绘图变化控制面板中勾选LINE Line numbers，然后单击OK，此时将绘出所有边线并以号码及颜色区分开来，如图12-11所示。




图12-11　显示模型边线编号

从图12-11可以看出，凸轮左前侧边线被分割成了两段，分别为L8和L6（小边线），后前侧边线亦被分成了L12和L10（小边线），这会影响后续的网格划分质量。

（3）在左侧的主菜单中依次单击Preprocessor>Modeling>Operate>Booleans>Add>Lines，拾取L8和L6，然后单击OK，在弹出的对话框中再次单击OK，合并这两条线。

（4）参照上一步操作，合并L12和L10。

（5）单击菜单Plot>Plot Volumes显示实体，单击Plot Ctrls>Numbering，取消勾选“LINE Line numbers”，关闭线编号显示，然后单击OK。

4.创建单元类型

（1）单击主菜单Preprocessor>Element Type>Add/Edit/Delete，在弹出的对话框中单击Add按钮，再在单元类型库左侧分类选中LS-DYNAExplicit，右侧选中Thin Shell163，输入Element type reference number为1，然后单击Apply，创建单元类型1（Shell163），如图12-12所示。

（2）依次更改Element type reference number为2～5，创建单元类型2（Shell163）、单元类型3（Solid164）、单元类型4（Solid164）、单元类型5（Combi165），最后单击OK。




图12-12　创建单元类型

5.定义实常数

（1）单击主菜单Preprocessor>Real Constants，在弹出的对话框中选择Add…，然后选中Type1SHELL163并单击OK，再次单击OK确认实常数号为1，在实常数定义窗口中的Thickness at node1T1中输入0.0001，其他选项取缺省值，单击OK，完成实常数1的定义，如图12-13所示。




图12-13　定义实常数

（2）重复上一步操作，为COMBI165单元创建编号为2的实常数，相关设置均采用缺省设置。

6.创建新材料

（1）单击主菜单Preprocessor>Material Props>Material Models，出现Define Material Model Behavior窗口，在窗口右侧的材料模型树形目录中，依次选择LS-DYNA→Rigid Material，在弹出的Rigid Propertiesfor Material Number1对话框中输入材料的密度（DENS）为7860，弹性模量（EX）为2.1e+11，泊松比（NUXY）为0.3，在下方Translational Constraint Parameter的下拉菜单中选择Alldisps，Rotational Constraint Parameter的下拉菜单中选择Xand Yrotate，点OK关闭该对话框，完成材料1的创建，如图12-14所示。

（2）在Define Material Model Behavior中选择Material>New Model，弹出Define Material ID，确认新材料编号为2，点OK按钮。重复上面操作，但在Translational Constraint Parameter的下拉菜单中选择Zand Xdisps，Rotational Constraint Parameter的下拉菜单中选择Allrotations，如图12-15所示。

（3）在Define Material Model Behavior中选择Material>New Model，弹出Define Material ID，确认新材料编号为3，点OK按钮。在窗口右侧的材料模型树形目录中，依次选择LS-DYNA→Linear→Elastic→Isotropic，在弹出的Linear Isotropicfor Material Number3对话框中输入材料的密度（DENS）为7860，弹性模量（EX）为2.1e11，泊松比（NUXY）为0.3，单击OK，如图12-16所示。

（4）在Define Material Model Behavior中选择Material>New Model，弹出Define Material ID，确认新材料编号为4，点OK按钮。在窗口右侧的材料模型树形目录中，依次选择LS-DYNA→Discrete Element Properties→Spring→Linear Elastic，在弹出的Linear Elastic Spring Material Propertiesfor Material Number4对话框中输入Spring Constant为5000，单击OK，如图12-17所示。




图12-14　定义材料1




图12-15　定义材料2




图12-16　定义材料3




图12-17　定义材料4

7.网格划分

（1）单击主菜单Preprocessor>Meshing>Mesh Tool，在打开的Mesh Tool对话框中，将Element Attributes改为Areas，然后单击Set，在窗口中拾取凸轮圆孔处的两个半圆柱面并单击OK，在弹出的Area Attributes对话框中更改MAT为1，REAL为1，Type为1SHELL163，然后单击OK，如图12-18（a）、（b）所示。




图12-18　为凸轮圆孔面指派单元属性

（2）参照上一步操作，为从动件两个侧面指派单元属性，其中MAT为2，REAL为1，TYPE为2SHELL163，如图12-19（a）、（b）所示。




图12-19　为从动件侧面指派单元属性

（3）在Mesh Tool对话框中，将Element Attributes改为Volume，然后单击Set，在窗口中拾取凸轮并单击OK，在弹出的Volume Attributes对话框中更改MAT为3，REAL为1，TYPE为3SOLID164，然后单击OK。

（4）参照上一步操作，为从动件指派单元属性，其中，MAT为3，REAL为1，TYPE为4SOLID164。

（5）在Mesh Tool对话框中，单击Size Controls：Global右侧的Set，弹出Global Element Sizes对话框，在SIZE Element edge length中输入0.01，然后单击OK。

（6）在Mesh Tool对话框中，单击Size Controls：Lines右侧的Set，弹出Element Sizeon Picked Lines对话框，在窗口中拾取凸轮圆孔处的两条直边和从动件上部沿厚度方向的四条边，然后单击OK，此时弹出Element Sizesonpicked Lines对话框，在NDIV No.ofelement divisions中输入4，然后单击OK，如图12-20所示。




图12-20　指定边线划分份数

8.建立弹簧单元

按照如下的操作步骤建立弹簧单元。

（1）单击主菜单Preprocessor>Modeling>Create>Nodes>In Active CS，弹出Create Nodesin Active Coordinate System对话框，在NODE Node number中输入10000，X，Y，Z Location in active CS输入0，0.38，0，如图12-21所示。




图12-21　创建节点

（2）单击主菜单Preprocessor>Modeling>Create>Elements>Elem Attributes，在弹出的对话框中更改TYPE为5COMBI165，MAT为4，REAL为2，然后单击OK，如图12-22所示。




图12-22　定义弹簧属性

（3）单击主菜单Preprocessor>Modeling>Create>Elements>Auto Numbered，在窗口中依次拾取节点10000和从动件顶面中间节点，然后单击OK，完成弹簧的创建，单击Plot>Plot Elements，绘制凸轮机构的有限元模型，如图12-23所示。

9.建立Part表

（1）单击主菜单Preprocessor>LS-DYNA Options>Part Options，弹出Part Data Writtenfor LS-DYNA对话框，确保Option项中的Createallparts被选中，然后单击OK，弹出建立的PART信息列表文本窗口（图12-24），将其关闭，返回图形用户界面。

（2）从图12-25基于PART显示的模型中可以看出，凸轮圆孔柱面为PART1，从动件侧面为PART2，从动件为PART3，凸轮为PART4，弹簧为PART5。




图12-23　凸轮机构的有限元模型




图12-24　Part列表




图12-25　基于PART显示的模型

10.定义接触关系

（1）单击主菜单Preprocessor>LS-DYNA Options>Contact>Define Contact，弹出Contact Parameter Definitions对话框，在Contact Type中选择Surfaceto Surf和General，即通用面-面接触算法STS。接触面之间的静、动摩擦系数均输入0.10和0.10。

（2）以上参数设置完成后，单击Contact Parameter Definitions对话框的OK按钮，弹出Contact Options对话框，接触部件和目标面部件号分别选择4和3，点OK关闭该对话框。


12.3　施加边界条件

1.定义数组

（1）单击Parameters>Array Parameters>Define/Edit…，弹出Array Parameters对话框，单击Add…按钮，弹出Add New Array Parameter对话框，输入Par Parametername为Time，确保Type Parametertype为Array，I，J，KNo.ofrows，cols，planes为2，1，1，然后单击Apply。

（2）更改Par Parametername为Force，再次单击Apply。

（3）更改Par Parametername为R-VE，再次单击Apply，至此完成了三个名称分别Time、Force和R_VE的2×1的数组，如图12-26所示。




图12-26　定义数组

（4）在图12-26所示的Array Parameter对话框中选中TIME数组，然后单击Edit…，在弹出的Array Parameter TIME对话框中输入0和0.65，然后单击File>Apply/Quite，如图12-27所示。




图12-27　定义时间数组

（5）参照上一步操作，对Force数组进行编辑，如图12-28所示。

（6）参照上一步操作，对R_VE数组进行编辑，前文中提到，凸轮转速为100r/min，约为10.47rad/s，故详细定义如图12-29所示。




图12-28　定义载荷数组




图12-29　定义转速数组

2.施加边界条件及载荷

（1）单击主菜单Preprocessor>Solution>Constraints>Apply>On Nodes，弹出Apply U，ROTon Nodes对话框，在其中输入10000，单击OK。

（2）在弹出对话框的Lab2DOFstobeconstrained中选中ALLDOF，然后单击OK。

（3）单击主菜单Preprocessor>Solution>Loading Options>Specify Loads，弹出Specify Loadsfor LS-DYNAExplicit对话框。

（4）在Load Labels中选中RBOZ，在Component name or PARTnumber的下拉菜单中选择1，在Parameter name for time values：的下拉菜单中选择Time，在Parameter name for Data Values：的下拉菜单中选择R_VE，然后单击Apply，如图12-30所示。

（5）在Load Labels中选中RBFY，在Componentnameor PARTnumber的下拉菜单中选择2，在Parameter name for timevalues：的下拉菜单中选择Time，在Parameter name for Data Values：的下拉菜单中选择FORCE，然后单击OK。




图12-30　定义凸轮转速


12.4　分析设置

1.设置能量选项

单击主菜单Preprocessor> Solution>Analysis Options>Energy Options，在弹出的Energy Options对话框中，打开所有的能量控制开关，单击OK按钮，关闭对话框，如图12-31所示。

2.设置人工体积黏性选项

单击主菜单Preprocessor> Solution>Analysis Options>Bulk Viscosity，保持缺省设置，单击OK按钮，关闭该对话框，如图12-32所示。

3.设置时间步长因子

单击主菜单Preprocessor> Solution>Time Controls>Time Step Ctrls，弹出Specify Time Step Scalingfor LS-DYNAExplicit对话框，在Time Step Scalefactor域中输入0.8，如图12-33所示，点OK按钮，关闭该对话框。




图12-31　设置能量选项




图12-32　设置人工体积黏性选项




图12-33　设置时间步长因子

4.设置求解时间

单击主菜单Preprocessor>Solution>Time Controls>Solution Time，弹出Solution Timefor LS-DYNAExplicit对话框，输入计算时间为0.61，单击OK按钮，关闭对话框，如图12-34所示。




图12-34　设置求解时间

5.设置结果文件输出步数

单击主菜单Preprocessor>Solution>Output Controls>File Output Freq>Numberof Steps，弹出Specify File Output Frequency对话框，在[EDRST]一栏中输入结果文件的输出步数200，在[EDHTIME]一栏中输入1000，点OK按钮关闭该对话框，如图12-35所示。




图12-35　设置结果文件输出步数

6.设置结果文件输出类型

单击主菜单Preprocessor>Solution>Output Controls>Output File Types，在Specify Output File Typefor LS-DYNA对话框中，选择Add，LS-DYNA，即在计算时输出用于LS-PREPOST后处理的结果文件，点OK按钮关闭该对话框，如图12-36所示。




图12-36　定义结果文件输出类型

7.输出关键字文件tulun.k

上述选项设置完成后，单击主菜单Preprocessor>Solution>Write Jobname.k，在弹出的对话框中更改Writeresultsfilesfor…为LS-DYNA，然后单击OK，关闭对话框，如图12-37所示，输出关键字文件将自动保存在工作目录下。




图12-37　输出关键字文件

如果本节的前面所述操作采用批处理操作，则相应的命令流如下：














12.5　求解及后处理


12.5.1　求解

按照如下步骤进行求解。

1.启动Mechanical APDLProduct Launcher

通过开始菜单的ANSYS程序组，启动Mechanical APDLProduct Launcher。

2.设置分析类型及文件

在Product Launcher中，Simulation Environment栏选择LS-DYNASolver，License选择ANSYSLS-DYNA，Analysis Type选择Typical LS-DYNA Analysis。在File Management标签下，Working Directory设定为关键字文件所在目录，Keyword Input File中指向工作目录下的tulun.k文件。

3.求解

按下Product Launcher窗口左下方的Run按钮，开始求解计算，计算过程中可在输出窗口中利用SW2开关获取计算实时信息，计算过程可能较长。求解完成后，屏幕输出窗口提示Normal Termination，按任意键退出。


12.5.2　后处理

本节将利用LS-Pre Post程序进行后处理操作。

1.启动LS-Pre Post-4.0

通过开始菜单启动LS-Pre Post-4.0程序。

2.导入结果文件

在菜单中单击File>Open>Binary Plot，打开工作目录下的二进制结果文件D3plot，将结果信息读入LS-Pre Post后处理器，在绘图区域绘出凸轮机构模型。

3.观察运动过程

通过动画播放控制台，可观察凸轮机构的动态运动过程，图12-38绘出了不同时刻凸轮机构的运动状态。

4.观察应力变化

（1）单击菜单中的FEM>Post>Fringe Component，在Fringe Component面板中，选择Stress下的Von Mises Stress，点Done按钮。

（2）单击菜单中的FEM>Post>Fringe Range，在Fringe Range面板中，在Level的下拉菜单中选择20，点Done按钮。




图　12-38




图12-38　不同时刻凸轮机构运动状态

（3）利用动画播放控制台，选择所需显示的子步结果。

图12-39为一系列不同时刻凸轮机构Von Mises等效应力等值线分布云图。

（4）单击菜单中的File>Movie，设定精度、保存路径及名称后单击Start按钮，将输出凸轮机构中的等效应力分布随运动过程变化的动画。

5.观察从动件运动过程中的位移变化

单击主菜单的FEM>Post>History，在History面板中，选中Part复选框，在绘图项目列表中选择Y-Rigid Body Displacement，然后在图形显示窗口中拾取从动件Part，最后单击Plot按钮，此时弹出Plot Window-1窗口中绘出了从动件Y向位移变化曲线，如图12-40所示。




图　12-39




图12-39　凸轮机构等效应力分布云图




图12-40　从动件的Y向位移变化曲线

6.观察从动件运动过程中的速度变化

单击主菜单的FEM>Post>History，在History面板中，选中Part复选框，在绘图项目列表中选择Y-Rigid Body Velocity，然后在图形显示窗口中拾取从动件Part，最后单击Plot按钮，此时弹出Plot Window-1窗口中绘出了从动件Y向速度变化曲线，如图12-41所示。




图12-41　从动件的Y向速度变化曲线

7.观察从动件运动过程中的加速度变化

单击主菜单的FEM>Post>History，在History面板中，选中Part复选框，在绘图项目列表中选择Y-Rigid Body Acceleration，然后在图形显示窗口中拾取从动件Part，最后单击Plot按钮，此时弹出Plot Window-1窗口中绘出了从动件Y向加速度变化曲线，如图12-42所示。




图12-42　从动件的Y向加速度变化曲线

8.观察凸轮机构运动过程中的能量变化

单击主菜单的FEM>Post>History，在History面板中，选中Global复选框，在绘图项目列表中选择Kinetic Energy、Internal Energy和Total Energy，单击Plot按钮，此时弹出Plot Window-1窗口中绘出了凸轮机构运动过程中的能量变化曲线，如图12-43所示。




图12-43　凸轮机构运动过程中的能量变化曲线


12.6　凸轮分析的关键字文件

下面给出本章分析案例的关键字文件tulun.k。

















附录A　LS-DYNA的计算单位问题

LS-DYNA程序的计算单位必须协调统一，检查单位是否正确的通常作法是：确定长度、质量、时间三个基本量的单位后，基于基本量的单位导出其他量的单位。下面以cm-g-μs作为基本单位的单位系统为例，介绍常用物理量的协调单位导出方法。

1.加速度单位

加速度单位按照下式导出：

[加速度单位]=[长度单位]/[时间单位] 2
 　　　　　（A-1）

对于cm-g-μs单位系统，将长度的基本单位和时间基本单位代入上述算式，即：cm/（μs） 2
 =10 10
 m/s 2
 。因此加速度的协调单位为10 10
 m/s 2
 。

2.集中力的单位

力的单位按照下式导出：

[集中力单位]=[质量单位]×[加速度单位]　　　　　（A-2）

对于cm-g-μs单位系统，将质量的基本单位和上面计算的加速度单位代入上述算式，即：g×10 10
 m/s 2
 =10 7
 N，因此力的协调单位为107N。

3.压力的单位

压力的单位按照下式导出：

[压强的单位]=[集中力的单位]/[长度单位] 2
 　　　　　（A-3）

对于cm-g-μs单位系统，将上面计算的集中力单位和长度的基本单位代入上述算式，即：10 7
 N/（cm） 2
 =10 11
 Pa，因此压力的协调单位为10 11
 Pa。

其他相关物理量的协调单位也可按照类似的方法导出，在指定模型数据时应统一按照导出的各物理量的协调单位填写各自的数值。比如，钢的弹性模量为2.1×10 11
 Pa，在cm-g-μs单位系统则中应填写2.1，因弹性模量与压强的协调单位是同一个单位，即10 11
 Pa。

表A-1给出三种不同单位系统下一些量的协调单位和赋值。

表A-1　常用物理量的导出单位及赋值示例





附录B LS-DYNA材料模型关键字

LS-DYNA材料模型众多，不同的材料模型适用的单元类型也有所不同。单元类型通过如下的数字或字符表示：

0-Solids

1H-Hughes-Liu beam

1B-Belytschko resultant beam

1I-Belytschko integrated solid and tubular beams

1T-Truss

1D-Discretebeam

1SW-Spotweld beam

2-Shells

3a-Thick shell formulation 1

3b-Thick shell formulation 2

3c-Thick shell formulation 3

3d-Thick shell formulation 5

4-Special airbag element

5-SPH element

6-Acoustic solid

7-Cohesive solid

8A-Multi-material ALEsolid（validated）

8B-Multi-material ALEsolid

表B-1为LS-DYNA材料模型关键字汇总信息，每一种材料模型都提供数字形式和文字描述形式的关键字，并列出其适用的单元类型和附加变量数。

表B-1　LS-DYNA材料模型关键字




续上表




续上表




续上表




续上表




续上表




续上表




续上表




续上表




注：1.*MAT_ALE_01-05分别与材料类型*MAT_140、*MAT_148、*MAT_009、*MAT_149、*MAT_160相同。

2.*MAT_066-071、*MAT_074、*MAT_093-095、*MAT_119、*MAT_121、*MAT_146、*MAT_196-197、*MAT_208用于discretebeam单元类型，用于模拟复杂阻尼器及多维弹簧-阻尼组合作用。


附录C　ANSYS前处理支持的材料模型

ANSYS前处理支持的LS-DYNA材料模型列于表C-1中，此表的各列依次为ANSYS前处理中的材料模型名称、相对应于LS-DYNA的材料模型关键字以及此材料类型在LS-DYNA材料库中的编号。

表C-1　ANSYS前处理支持的材料类型及与LS-DYNA材料模型对应关系




续上表





附录D　ANSYSED系列命令与对应的关键字

表D-1中列出了ANSYS的显式动力分析ED系列命令、功能以及与之相对应的LS-DYNA关键字。

表D-1　ED系列命令及对应关键字




续上表




续上表





附录E　ANSYSLS-DYNA单元简介

ANSYSLS-DYNA提供了160～168这9种针对LS-DYNA求解器的显式单元类型，本附录对这些显式单元的选项、实常数以及使用注意事项进行简单介绍。

1.LINK160单元

LINK160单元是3D的等截面轴力直杆单元，仅能承受轴向力，其单元形状如图E-1所示。




图E-1　INK160单元的形状

LINK160单元通过三个节点I、J、K定义，其中节点K为截面的定位节点。LINK160单元每个节点具有三个自由度。

LINK160单元没有KEYOPT选项，仅有一个实常数，即：横截面积。

2.BEAM161单元

BEAM161单元是3D的梁单元，其单元形状如图E-2所示。BEAM161单元通过节点I、J、K定义，节点K为辅助节点，用于横截面定位。

BEAM161单元的KEYOPT（1）选项用于选择单元算法，不同的KEYOPT（1）及对应算法见表E-1中。

表E-1　BEAM161单元的KEYOPT（1）选项




BEAM161单元的KEYOPT（2）选项用于选择积分规则，不同的KEYOPT（1）及对应的积分规则列于表E-2中。KEYOPT（2）仅当矩形单元的KEYOPT（1）=0、1、4算法时使用。

表E-2　BEAM161单元的KEYOPT（2）选项




BEAM161单元的KEYOPT（4）选项用于选择截面积分规则，KEYOPT（4）=0时表示标准积分，KEYOPT（4）>0（1～9999）时表示用户定义积分规则。

BEAM161单元的KEYOPT（5）选项为梁截面类型选项，KEYOPT（5）=0表示矩形截面，KEYOPT（5）=1表示圆形截面，KEYOPT（5）=2表示任意截面（使用用户定义积分规则）或标准截面（使用用户定义积分规则）。




图E-2　BEAM161单元的形状

对应于BEAM161单元KEYOPT的不同组合，所需定义的BEAM161单元实常数也有所不同，这里仅介绍如下两种情况的实常数。

（1）矩形截面情况

当KEYOPT（1）=0、1或4且KEYOPT（5）=0时，需要定义的实常数为SHRF、TS1、TS2、TT1、TT2、NSLOC、NTLOC，这些参数的意义列于表E-3中。

（2）圆形截面情况

当KEYOPT（1）=0、1或5，KEYOPT（4）=0且KEYOPT（5）=1时，需要定义的实常数为SHRF、DS1、DS2、DT1、DT2、NSLOC、NTLOC，这些参数的意义列于表E-3中。

表E-3　矩形、圆形截面单元的实常数




3.PLANE162单元

PLANE162单元是2D的连续单元，其单元形状如图E-3所示。PLANE162单元适合于进行两维问题或轴对称分析。对于轴对称分析，对称轴必须为Y轴，所有的模型必须建立在X轴的正向范围内。




图E-3　PLANE162单元的形状

一个PLANE162单元通过I、J、K、L四个节点定义，可以退化为三角形单元，退化单元通过同一个节点重复两次来定义，但是一般不推荐使用退化形式。

在PLANE162单元表面施加面荷载的面号已经标在图中，即面①、面②、面③以及面④，在向单元施加PRESSURE时，要特别注意加载的面号。

PLANE162单元包含三个单元选项。

KEYOPT（3）选项为单元的行为选项，KEYOPT（3）=0，1，2分别表示平面应力、轴对称以及平面应变单元。

当KEYOPT（3）=1（即轴对称行为）时，KEYOPT（2）用来表示加权选项，KEYOPT（2）=0，1分别表示面积加权和体积加权的轴对称单元。

KEYOPT（5）选项为单元算法选项。KEYOPT（5）=0表示Lagrangian单元算法（缺省选项）；

PLANE162单元不需要定义实常数。

4.SHELL163单元

SHELL163单元是3D的壳（或薄膜）单元，其单元形状如图E-4所示。




图E-4　SHELL163单元的形状

SHELL163单元一般通过I、J、K、L四个节点定义，可以退化为三角形单元，退化单元通过同一个节点重复两次来定义，但是一般不推荐使用退化形式。

SHELL163单元包含四个KEYOPT选项。

SHELL163单元的KEYOPT（1）选项用于选择单元的算法，不同的KEYOPT（1）选项及其对应的算法见表E-4中。

表E-4　SHELL163单元的KEYOPT（1）选项




SHELL163单元的KEYOPT（2）选项用于指定积分规则（用于标准积分规则，KEYOPT（4）=0），KEYOPT（2）=0表示采用Gauss积分规则（最多允许5个积分点）；KEYOPT（2）=1表示采用梯形积分规则（最多允许100个积分点）。

SHELL163单元的KEYOPT（3）选项为层状复合材料模式标识，KEYOPT（3）=0表示非复合材料模式；KEYOPT（3）=1表示复合材料模式，复合材料模式下厚度方向每一个积分点需要指定一个材料角。

SHELL163单元的KEYOPT（4）选项为积分规则的ID，KEYOPT（4）=0表示采用标准积分选项；KEYOPT（4）>0（1～9999）表示采用用户定义的积分规则。

SHELL163单元的实常数随KEYOPT选项的不同而有很大区别，对缺省情况，需要定义的实常数列于表E-5中。

表E-5　SHELL163的实常数




5.SOLID164单元

SOLID164单元是3D的连续单元，其单元形状如图E-5所示。通常情况下，SOLID164单元通过I、J、K、L、M、N、O、P共8个节点来定义，是六面体形状的单元，SOLID164也支持三棱柱、四面体、金字塔等形状的退化单元，退化单元可以通过相同的节点重复出现多次的形式来定义，但在显式分析中一般不建议使用。




图E-5　SOLID164单元的形状

SOLID164单元表面加载的面号已经在图中标出：其各面的编号由节点决定，依次为：面①（J—I—L—K），面②（I—J—N—M），面③（J—K—O—N），面④（K—L—P—O），面⑤（L—I—M—P），面⑥（M—N—O—P）；在向单元表面施加压力时要注意面号的问题。通过EDFPLOT命令可以打开显式动力荷载的显示开关，观察面荷载是否施加到了正确的单元表面。

SOLID164单元包含两个单元选项。KEYOPT（1）用于选择单元算法，KEYOPT（1）=0或1时，表示单元算法为常应力实体单元算法（缺省选项）；KEYOPT（1）=2时表示采用全积分选择缩减实体单元算法。KEYOPT（5）选项用于指定单元类型，KEYOPT（5）=0为Lagrangian单元，KEYOPT（5）=1为ALE（Arbitrary Lagrangian-Eulerian）单元。

SOLID164单元不需要指定实常数。

6.COMBI165单元

COMBI165单元是3D的弹簧/阻尼器单元，此单元通过两个节点定义，其单元形状如图E-6所示。




图E-6　COMBI165单元示意图

对于同一个COMBI165单元，不能同时定义弹簧以及阻尼特性，但是可以分别定义共节点的弹簧和阻尼器。COMBI165单元定义需要的力（力矩）与位移（转角）之间的关系或力（力矩）与速度（角速度）之间的关系数据，通过材料定义的方式实现。

COMBI165单元仅包含一个单元选项KEYOPT（1），此选项为0时表示单元为平动弹簧/阻尼器类型；此选项为1时表示单元为扭转弹簧/阻尼器类型。

COMBI165单元的实常数列于表E-6中。

表E-6　SHELL163的实常数




7. MASS166单元

MASS166单元是3D的集中质量/转动惯性单元，MASS166单元仅包含1个节点，其单元形状如图E-7所示。

MASS166单元具有一个单元选项KEYOPT（1），KEYOPT（1）=0为缺省选项，表示单元为无转动惯性的集中质量单元；KEYOPT（1）=1表示单元为3-D转动惯性单元（无质量）。

对于集中质量选项，MASS166单元仅需要指定一个实常数，即：质量。

对于转动惯性单元选项，MASS166单元需指定的实常数包括6个转动惯量：IXX、IXY、IXZ、IYY、IYZ、IZZ，其中IXX、IYY、IZZ必须为正值。

MASS单元不需要指定材料属性。

8.LINK167单元

LINK167单元是3-D的索单元，仅能承受拉伸作用。LINK167单元由I、J、K三个节点，其中的K为横截面定位节点，其单元形状如图E-8所示。




图E-7　MASS166单元示意图




图E-8　LINK167单元的形状

Link167单元适合于模拟柔性的索和缆，需要为此单元定义索的材料模型，通过MP命令定义密度和弹性模量，通过EDMP，CABLE命令可指定索的应力-应变关系曲线ID号。若采用了应力应变关系，则MP指定的弹性模量将被忽略。

Link167单元没有KEYOPT选项，需指定的实参数有两个，即：截面积AREA以及偏移量OFFSET。对于松弛单元OFFSET为负，对于初始张拉单元OFFSET为正，单元长度的变化量由下式给出：

ΔL=当前长度-（初始长度-OFFSET）

该单元的力（仅受拉）由下式给出：

F=K×max{ΔL，0}

其中K为线刚度，由下式给出：

K=E×AREA/（初始长度-OFFSET）

9.SOLID168单元

SOLID168单元是高阶的3-D四面体实体单元，SOLID168单元通过I、J、K、L、M、N、O、P、Q、R共10个节点来指定，其单元形状如图E-9所示。




图E-9　SOLID168单元的形状

SOLID168单元包含一个单元选项，KEYOPT（1）用于选择单元类型。KEYOPT（1）=0，1时表示为二次插值的连续体单元；KEYOPT（1）=2时表示单元为复合材料单元（线性四面体形状的组合）。SOLID168单元不需要指定实常数。

SOLID168单元表面加载的面号已经在图中标出，各面的编号由节点决定，依次为：面①（J—I—K），面②（I—J—L），面③（J—K—L）及面④（K—I—L）；向单元表面施加压力时要注意面号的问题。通过EDFPLOT命令可显示LS-DYNA荷载，观察面荷载是否施加到了正确的单元表面。
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$ 1A 20

0 le+011
0. 06 le4011
0.6 le+011
* DEFINE_CURVE
S 1LCID 2SIDR 3SFA 4SFO S5OFFA 60FFO 7DATTYP
2
$ 1A 20
0 0
0. 06 0
0.6 0
$
$
S8 8585 58855855 585505555855855885558555555555555555555555555555555558555555$
$ CONTACT DEFINITIONS S
S8 5808505585558558885585558558555855555555555555555555555555855585588555858$
$
* CONTACT_AUTOMATIC_SINGLE_SURFACE
S 1SSID 2MSID 3SSTYP AMSTYP 5SBOXID 6MBOXID 7SPR 8MPR
0 0 5 0 1 1
$ 1FS 2FD 3DC 1VC 5VDC 6PENCHK 7BT 8DT
0.15 0.1 0 0 10
S ISFS 2SFM 3SST IMST 5SFST 6SFMT 7FSF 8VSF
$ ISOFT  2SOFSCL  3LCIDAB  4MAXPAR 5SBOPT 6DEPTH 7BSORT
8FRCFRQ
2 3 5
$
$
S50 5885585558555858885585558558855555585555555555555555555555855585558555558$
S CONTROL OPTIONS $
S50 0855585885558 88855555 8885558555555 55855558555555555555555585555558855558
$

* CONTROL_TERMINATION
$ 1ENDTIM 2ENDCYC  3DTMIN 4ENDENG S5SENDMAS
0. 06 10000000 0.01 0 0
* CONTROL_TIMESTEP
$ IDTINIT 2TSSFAC 3ISDO  ATSLIMT  5DT2MS  6LCTM  7ERODE  8MSIST
0 0.6 0 0 0 1 1 0
* CONTROL_HOURGLASS
$ 11HQ 2QH
1 0.1
* CONTROL_BULK_VISCOSITY
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S 1Q1 2Q2 3TYPE
1 0. 06 —2

* CONTROL_CONTACT

$ ISLSFAC 2RWPNAL 3ISLCHK 4SHLTHK S5PENOPT 6THKCHG 70ORIEN S8ENMASS
0 0 1 1 1 0 2 0

$ 1USRSTRC 2USRFRC 3NSBCS 4INTERM 5XPENE 6SSTHK 7ECDT S8TIEDPR]

$ 1SFRIC 2DFRIC 3EDC 4VFC 5TH 6TH_SF 7PEN_SF

$ 1IGNORE 2FRCENG 3SKIPRWG 4OUTSEG 5SPOTSTP 6SPOTDEL 7SPOTTHIN
2 0 0 1 0 1 0.5

* CONTROL_SOLID

$ 1ESORT 2FMATRX 3NIPTETS 4SWLOCL
1

* DAMPING_GLOBAL

$ 1LCID  2VALDMP 3STX 1STY 5STZ 6SRX 7SRY 8SRZ
0 0
* CONTROL_ENERGY
$ IHGEN ~ 2RWEN 3SLNTEN  4RYLEN
2 1 2 2
* CONTROL_ACCURACY
$ 108U 2INN  3PIDOSU
1 4

$
S
§88855555555588555555555855555555555555555555555555555555555555555555585855555888
$ TIME HISTORY $
$8855588555558855555555555555555555555558555555555555555555555555555555555565588
$
* DATABASE_GLSTAT
$ IDT 2BINARY  3LCUR  4IOOPT  5DTHFF  6BINHF

0. 0003
* DATABASE. MATSUM
s IDT 2BINARY  3LCUR  4IOOPT  5DTHFF  6BINHF

0.0003
* DATABASE_NODOUT
$ IDT 2BINARY  3LCUR  4I0OPT  5DTHFF  6BINHF

0. 0003
* DATABASE_ELOUT
$ IDT 2BINARY  3LCUR  4I00PT  5DTHFF  6BINHF

0. 0003

* DATABASE_BINARY_D3PLOT
S 1DT 2LCDT 3BEAM 4NPLTC
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* DATABASE_FORMAT
$ 1IFORM 2IBINARY
0
S5 55058550555858585858555858585858555855585855855555555555555555555555858588

$ NODE DEFINITIONS $
§585555555555555555555555555555555555555555555555555555555555555555555555585555%
$
* NODE
$ INID 2X 3Y 1Z  5TC  6RC
1 —1.97368 =14 =g
2 —1.97368 = -9

15639 —3.75 —6.49519 45
$
S8 58855558555555555555555955555555555555555595555955955556555555555595595565655%
$ ELEMENT DEFINITIONS $
§585585555555855555555555555555555555555555555555555555555855555558555555585585%
$
* ELEMENT_SOLID
$ 1EID  2PID N1 N2 N3 N4 N5 N6 N7 N8

11401 1 14821 14822 14824 14823 14825 14826 14828 14827

11400 2 8214 14302 14072 13917 13690 13765 13916 13915
$
$
5858555555555555555555555555555555555555555555555555955555559559555595565555545%
$ SECTION DEFINITIONS $
S8 858858558 588595585585555855555555555595595555955955555559559555595595555955%
$
* SECTION_SOLID
$ 1ISECID 2ELFORM 3AET

1 1
* SECTION_SOLID

$ 1ISECID 2ELFORM 3AET

2 1
$
$
$5 85 5555850885058585858555858555858555855555555855555555555555555555555555588
$ MATERIAL DEFINITIONS $
S8 585555585555855558855555555555555555555555555555555555555555555555555555858%
$

* MAT_JOHNSON_COOK
& IMID 2RO 3G 4E 5PR 6DTF 7VP  S8RATEOP
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1 7.896 8. 18e+007 0 0

$ 1A 2B 3N 4c 5M 6TM 7TR  8EPSO
350000 275000 0.36  0.022 1 1673.15 15 1
$ 1CP 2PC 3SPALL 4T 5D1 6D2 7D3 8Dt
152 0 2.0 0 —0.8 21 —0.5  0.0002
$ 1D5  2C2/P
0. 61 1
$
$
$588 5505855855555 55555555555555555555555555555555555555555555555555555558585555%
$ EOS DEFINITIONS $
S90S 8 58 58585085858585855555555855555555555555555555555555555555555585655555585%
$
* EOS_GRUNEISEN
$  1EOSID 2C 381 482 583 6GAMAO 7A 8E0
1 4569 1. 49 0 0 2.7 0 0
&) 1vo
0
$
$
5888 5085885585585855555855855855555555555555555555555555555555555955555855858%
$ PARTS DEFINITIONS $
S0 858085050558585850505555858555555555555555555555559555555555555656565
$
* PART
$  HEADING
BUIET
$ IPID  2SECID 3MID  4EOSID  5HGID ~ 6GRAV 7ADPORT  8TMID
1 1 1 1 0
* PART
$  HEADING
PLATE1
$ IPID  2SECID 3MID  4EOSID  5HGID ~ 6GRAV 7ADPORT  8TMID
2 9 1 1 0
$
$
S8 8 0808 58585555555555555555555555555555555555555555565556555555556555658585585%
$ LOAD DEFINITIONS $
§888585855555555555555585555555555555555555555555555585555555555555555565655585$
$

* DEFINE_CURVE
s 1LCID 2SIDR 3SFA 4SFO 50FFA 60FFO 7DATTYP
1
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LS-DYNA user input
Time = 0.088799 Fringe Levels
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Time = 0.10318 Fringe Levels
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$ Created with ANSYS Workbench v15. 0
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$
50858558055 555558558555558555855555558555555555555555555555555555555558555855$

$ LIST SETS $
S8 8558555505585555855855555855555555555555555555555555555555555555556556558$5
$
* SET_NODE_LIST
$ 1SID 2DA1 3DA2 4DA3 5DA4
1

$ INIDI ~ 2NID2  3NID3  4NID4  5NID5  6NID6  7NID7  8NIDS8

13765 13766 13767 13768 13769 13770 13771 13772

30156 30157 30158 30159 30160 30161 30162 30163
* SET_NODE_LIST
$ 1SID 2DA1 3DA2 4DA3 5DA4

2

$ INIDI ~ 2NID2  3NID3  4NID4  5NID5  6NID6  7NID7  8NID8

13691 13692 13693 13694 13695 13696 13697 13698

30455 30456 30457 30458 30459
$
S50 55555850555555855555555585585555555555555555555555555555555555555565565
$ BOUNDARY CONDITIONS $
$5 88500558555 555585555555555555855558555555555555555555555555555555555555556585$8
$

* BOUNDARY_PRESCRIBED_MOTION_SET_ID
$ 1KeylD 2HEADING

1Displacement

S 11D 2DOF 3VAD 4LCID 68F 6VID 7DEATH 8BIRTH
2 1 2 2 1. 000 0 0 0
* BOUNDARY_SPC_SET
S 1INSID 2CID 3DOFX 4DOFY 5DOFZ 6DOFRX 7TDOFRY §DOFRZ

1 0 1 1 1 1 1 1
* STRESS_INITIALIZATION
* END
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1Displacement

S 11D 2DOF 3VAD 4LCID 5SF 6VID 7DEATH 8BIRTH
2 1 2 2 1. 000 0 0 0

* BOUNDARY_SPC_SET

S INSID 2CID 3DOFX 4DOFY 5DOFZ 6DOFRX 7DOFRY 8DOFRZ
| 0 1 1 1 1 1 1

* END
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* KEYWORD
* TITLE

$ Created with ANSYS Workbench v15. 0
$

$ Units:mm,mg,ms,mN,K

$

* DATABASE_FORMAT

$ 1IFORM 2IBINARY

0
$
$
S8 00885555 0085558508555 5585555858555555555555555555555555555555555555588%
S NODE DEFINITIONS $
S50 85558 550855585855558588855555585555585555555555555555555555555555585588%
$
* NODE
$ INID 2X 3Y 4Z 5TC 6RC
1 —1.97368 —73 =
2 —1.97368 —173 =g
30459 0 —73 —68

$
$
S50 085 5555088555858855585088855588555558555555555555555555555555555555888%
$ ELEMENT DEFINITIONS S
S S50 0885555585555 050855555588555550885555555555555555555555555555555555588%
$
* ELEMENT_SOLID
$ 1EID 2PID N1 N2 N3 N4 NG5 N6 N7 N8

11401 1 14821 14822 14824 14823 14825 14826 14828 14827

23360 3 23853 29941 29711 29556 29329 29404 29555 29554





OEBPS/Image00591.jpg
0. 0003
* DATABASE_BINARY_RUNRSF

- 1DT 2NR
5000
$
$
$5858555555555555555555585855555558555855555555585555555558555858585858585858588
$ INITIAL VELOCITY DEFINITIONS $
S8 5508 00808858588 5555855858555555555585555555555555555558555555585555585
$
* INITIAL_VELOCITY_GENERATION
$ 11D 2STYP 30OMEGA 4VX 5VY 6VZ TIVATN
1 2 0 0 0 —1000 0
$ 1XC 2YC 3ZC ANX SNY 6NZ
0 0 0 0 0 0
$
$
5588085 5558555555555885555555558555555555555555555555555555555556556585555585
5 LIST SETS $

$985555555555555555555555555555555555555555555555555555555555555558595555555555%
* SET_NODE_LIST
$ 1SID 2DA1 3DA2 4DA3 5DA4
1
$ INIDI  2NIDZ  3NID3  4NID4  5NID5  6NID6  7NID7  8NID8
13765 13766 13767 13768 13769 13770 13771 13772

14517 14518 14519 14520 14521 14522
* SET_NODE_LIST
$ 1SID 2DA1 3DA2 IDA3 5DA4

2

S INIDI1 2NID2 3NID3 4NIDA 5NID5 6NID6 TNID7 8NID8

13691 13692 13693 13694 13695 13696 13697 13698

15603 15604 15605 15614 15618 15622 15636

15637
$
$
$955555555555555555555555555555555555855558555555585555555855559858555555555588%
$ BOUNDARY CONDITIONS $
$955555558555555555555555555555555555555555555555955555555555555558555555655555%
$

* BOUNDARY_PRESCRIBED_MOTION_SET_ID
$  1KeylD 2HEADING
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$
* CONTACT_AUTOMATIC_SINGLE_SURFACE

$ ISSID  2MSID  3SSTYP  4MSTYP 5SBOXID 6MBOXID 7SPR 8MPR
0 0 5 0 1 1
$ 1FS 2FD 3DC 4VC 5VDC  6PENCHK 7BT 8DT
0.15 0.1 0 0 10
$ ISFS 2SFM 3SST 4AMST  5SFST  6SFMT 7FSF 8VSF
$ ISOFT  2SOFSCL  3LCIDAB  4MAXPAR 5SBOPT 6DEPTH 7BSORT
8FRCFRQ
2 3 5
$
$
S8 858555555585555555555555555555555555555555555559555555555555555555565555585%
$ CONTROL OPTIONS $
S8 88 858505 5855558585855558555585555555555555555555555555555555555555556585585%
$

* CONTROL_TERMINATION
$ 1ENDTIM 2ENDCYC 3DTMIN 4ENDENG S5ENDMAS
0.18 10000000 0.01 0 0
* CONTROL_TIMESTEP
$ IDTINIT 2TSSFAC 3ISDO  4TSLIMT 5DT2MS 6LCTM 7TERODE 8MSIST

0 0.6 0 0 0 1 1 0
* CONTROL_HOURGLASS
$ 1THQ 2QH
1 0.1
* CONTROL_BULK_VISCOSITY
$ 1Q1 2Q2 3TYPE
1 0. 06 —3

* CONTROL_CONTACT

$ ISLSFAC 2RWPNAL 3ISLCHK 4SHLTHK GSPENOPT 6THKCHG 7ORIEN 8ENMASS
0 0 1 1 1 0 2 0

$ I1USRSTRC 2USRFRC 3NSBCS 4INTERM S5XPENE 6SSTHK 7ECDT S8TIEDPR]

$  1SFRIC 2DFRIC 3EDC AVFC 5TH 6TH_SF 7PEN_SF

$ 1IGNORE 2FRCENG 3SKIPRWG 40OUTSEG 5SPOTSTP 6SPOTDEL 7SPOTTHIN
2 0 0 1 0 1 0.5

* CONTROL_SOLID

$ 1ESORT 2FMATRX 3NIPTETS 4SWLOCL
1

* DAMPING_GLOBAL

$ 1LCID 2VALDMP 3STX 4STY 6STZ 6SRX 7SRY 8SRZ
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0 0
* CONTROL_ENERGY
5 ITHGEN 2RWEN 3SLNTEN 4RYLEN

2 1 2 2
* CONTROL_ACCURACY
$ 108U 2INN  3PIDOSU
1 4
$
$
S5 058555855555555555555585555555555555555555555555855555555555555555585855855%
$ TIME HISTORY $
$588885855855555555855555555555555555555555555555585555558555555555558585555858%
$
* DATABASE_GLSTAT
$ IDT 2BINARY  3LCUR  4100PT  5DTHFF  6BINHF
0. 0009
* DATABASE_MATSUM
$ IDT 2BINARY  3LCUR  4I00OPT  5DTHFF  6BINHF
0. 0009
* DATABASE_NODOUT
$ IDT 2BINARY  3LCUR  4I0OOPT  5DTHFF  GBINHF
0. 0009
* DATABASE_ELOUT
$ IDT 2BINARY ~ 3LCUR  4I0OPT  5DTHFF  6BINHF
0. 0009
* DATABASE_BINARY_D3PLOT
$ IDT  2LCDT  3BEAM  4NPLTC
0. 0009
* DATABASE_BINARY_RUNRSF
$ IDT 2NR
5000
$
$
$8 8585 055855558555855558558555555855555555555555555555555555555555556556565855%
$ INITIAL VELOCITY DEFINITIONS $
$8 585880858555 58585555555558555555855555555555555555555555555555555558555565855%
$
* INITIAL_VELOCITY_GENERATION
$ 11D 2STYP  30MEGA 4VX 5VY 6VZ  7IVATN
1 2 0 0 0 —1000 0
$ 1XC 2YC 37C INX 5NY 6NZ

0 0 0 0 0 0
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$
§ 85885885085 885885555585585855855855555555555555555555555555855555555555855858858

3 SECTION DEFINITIONS s
§ 888 5558555858585555558555558555555555555555555555555555555585855858555555555588%
$
* SECTION_SOLID
$ ISECID 2ELFORM 3AET
1 1
*» SECTION_SOLID
$ ISECID 2ELFORM 3AET
2 1
* SECTION_SOLID
$ ISECID 2ELFORM 3AET
3 1
$
$
§ S SSSS8 80858088 880858855885585885555855858555555555555555555555555558885588
S MATERIAL DEFINITIONS S

§ 858588585885 85585585585555585885585555555555855555555555555555555555855858858
$
* MAT_JOHNSON_COOK

$ IMID 2RO 3G IE 5PR 6DTF 7VP  8RATEOP
1 7.896 8. 18e+007 0 0
$ 1A 2B 3N 1C 5M 6TM 7TR  8EPSO
350000 275000 0. 36 0.022 1 1673.15 15 1
$ 1CP 2PC  3SPALL AT 5D1 6D2 7D3 8D1
452 0 2.0 0 —0.8 2.1 —0.5  0.0002
§ 1IDs  2C2/P
0.61 1
$
$
§ 858585 88588585585585588885585885585555555585585555555555855855555555855858858
$ EOS DEFINITIONS $
S50 8855558S88558558S585588588585585555555555555555555555555555555555555558S
$
* EOS_GRUNEISEN
$  1EOSID 2¢ 381 4S2 583 6GAMAO 7A 8E0
1 1569 1.49 0 0 2.17 0 0
S 1Vo
0
)
$

§ 8588505855 58585555555588555585555555555555555555555555555555555555855855858858
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$ PARTS DEFINITIONS S
$5 88585855 85885558585555855858588555555555555555555555555855555555555555855558%

$
* PART
$  HEADING
BUIET
$ IPID  2SECID 3MID  4EOSID  5HGID  6GRAV 7ADPORT  8TMID
1 1 1 1 0
* PART
$  HEADING
PLATEIL
$ IPID  2SECID 3MID  4EOSID  5HGID  6GRAV 7ADPORT  8TMID
g 2 1 1 0
* PART
$  HEADING
PLATE2
$ IPID  2SECID 3MID {EOSID  S5HGID  6GRAV 7ADPORT  8TMID
3 3 1 1 0
$
$
$ 8885885555585 55555555555555555855555555555585555585555555555555555555555555858%
$ LOAD DEFINITIONS $
§ 855888555 8588558885555885555855555888855585555585555555555555555555555555888$
$
* DEFINE_CURVE
$ 1ILCID  2SIDR 3SFA 4SFO  50FFA  60FFO 7DATTYP
1
3 1A 20
0 le+011
0.18 le4011
1.8 lef011
* DEFINE_CURVE
$ 1ILCID  2SIDR 3SFA 4SFO  50FFA  60FFO 7DATTYP
2
$ 1A 20
0 0
0.18 0
1.8 0
$
S
§ 8 5588085558585555855555555555555555588555555555555555555555555555555555555$5$
$ CONTACT DEFINITIONS $

S5 5808858 88555588558 58585858885555855555855555555555555555558555558855558888
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